Supported Devices:
M16C Family / M16C/50 Series
M16C/5M,5L,56,5LD and 56D Groups

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corporation without notice. Please review the latest information published by Renesas Electronics Corporation through various means, including the Renesas Electronics Corporation website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software, and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your products and systems. Renesas Electronics hereby disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sale, use, reproduction, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You may not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depend on the product’s quality grade, as indicated below.

   “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.

   “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Ren2) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Ren3) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks
Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

Contact information
For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit: www.renesas.com/contact.

© 2021 Renesas Electronics Corporation. All rights reserved.
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
   Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
Preface

The R0E535M00MCU00 is a full-spec emulator for MCUs of the M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups. This user's manual mainly describes specifications of the R0E535M00MCU00 and how to setup it.

All components of the R0E535M00MCU00 are listed under “1.1 Package Components” (page 17). If you have any questions about the R0E535M00MCU00, contact your local distributor.

The manuals relevant to usage of the R0E535M00MCU00 are listed below. You can download the latest manuals from the Renesas Tools homepage (https://www.renesas.com/tools).

Related manuals

<table>
<thead>
<tr>
<th>Item</th>
<th>Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessory</td>
<td>R0E0100TNPFK00 User’s Manual</td>
</tr>
<tr>
<td></td>
<td>R0E535M00CFK30 User’s Manual</td>
</tr>
<tr>
<td></td>
<td>R0E535M00CFK40 User’s Manual</td>
</tr>
<tr>
<td>C compiler</td>
<td>C/C++ Compiler Package for M16C Series, R8C Family</td>
</tr>
<tr>
<td></td>
<td>C/C++ Compiler User’s Manual</td>
</tr>
<tr>
<td>Assembler</td>
<td>C/ C++ Compiler Package for M16C Series, R8C Family</td>
</tr>
<tr>
<td></td>
<td>Assembler User’s Manual</td>
</tr>
</tbody>
</table>
Important

Before using this product, be sure to read this user’s manual carefully.
Keep this user’s manual, and refer to it when you have questions about this product.

Emulator:

"Emulator" in this document collectively refers to the following products manufactured by Renesas Electronics Corporation.
(1) E100 emulator main unit
(2) MCU unit
(3) Pitch converter board for connecting the user system

"Emulator" herein encompasses neither the customer's user system nor the host machine.

Purpose of use of the emulator:

This emulator is a device to support the development of systems that use the M16C Family M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups of Renesas 16-bit single-chip MCUs. It provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this emulator other than for its intended purpose of use.

For those who use this emulator:

This emulator can only be used by those who have carefully read the user’s manual and know how to use it.

Use of this emulator requires basic knowledge of electric circuits, logical circuits, and MCUs.

When using the emulator:

(1) This product is a development-support unit for use in your program development and evaluation stages. When a program you have finished developing is to be incorporated in a mass-produced product, the judgment as to whether it can be put to practical use is entirely your own responsibility, and should be based on evaluation of the device on which it is installed and other experiments.
(2) In no event shall Renesas Electronics Corporation be liable for any consequence arising from the use of this product.
(3) Renesas Electronics Corporation strives to provide workarounds for and correct trouble with products malfunctions, with some free and some incurring charges. However, this does not necessarily mean that Renesas Electronics Corporation guarantees the provision of a workaround or correction under any circumstances.
(4) The product covered by this document has been developed on the assumption that it will be used for program development and evaluation in laboratories. Therefore, it does not fall within the scope of applicability of the Electrical Appliance and Material Safety Law and protection against electromagnetic interference when used in Japan.
(5) Renesas Electronics Corporation cannot predict all possible situations and possible cases of misuse that carry a potential for danger. Therefore, the warnings in this user's manual and the warning labels attached to the emulator do not necessarily cover all such possible situations and cases. The customer is responsible for correctly and safely using this emulator.
(6) The product covered by this document has not been through the process of checking conformance with UL or other safety standards and IEC or other industry standards. This fact must be taken into account when the product is taken from Japan to some other country.
(7) Renesas Electronics Corporation will not assume responsibility of direct or indirect damage caused by an accidental failure or malfunction in this product.

When disposing of the emulator:

Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.
Usage restrictions:
The emulator has been developed as a means of supporting system development by users. Therefore, do not use it as an embedded device in other equipment. Also, do not use it to develop systems or equipment for use in the following fields.

(1) Transportation and vehicular
(2) Medical (equipment that has an involvement in human life)
(3) Aerospace
(4) Nuclear power control
(5) Undersea repeaters

If you are considering the use of the emulator for one of the above purposes, please be sure to consult your local distributor.

About product changes:
We are constantly making efforts to improve the design and performance of this emulator. Therefore, the specification or design of this emulator, or this user's manual, may be changed without prior notice.

About rights:
(1) We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of any information, products or circuits presented in this user’s manual.
(2) The information or data in this user’s manual does not implicitly or otherwise grant a license to patent rights or any other rights belonging to Renesas or to a third party.
(3) This user’s manual and this emulator are copyrighted, with all rights reserved by Renesas. This user’s manual may not be copied, duplicated or reproduced, in whole or part, without prior written consent from Renesas.

About diagrams:
Some diagrams in this user’s manual may differ from the objects they represent.
Precautions for Safety

This chapter describes the precautions which should be taken in order to use this product safely and properly. Be sure to read and understand this chapter before using this product.

Contact us if you have any questions about the precautions described here.

This chapter describes the precautions which should be taken in order to use this product safely and properly. Be sure to read this chapter before using this product.

⚠️ WARNING

WARNING indicates a potentially dangerous situation that will cause death or heavy wound unless it is avoided.

⚠️ CAUTION

CAUTION indicates a potentially dangerous situation that will cause a slight injury or a medium-degree injury or property damage unless it is avoided.

In addition to the two above, the following are also used as appropriate.

⚠️ means WARNING or CAUTION.

Example:

⚠️ CAUTION AGAINST AN ELECTRIC SHOCK

🚫 means PROHIBITION.

Example:

🚫 DISASSEMBLY PROHIBITED

❗️ means A FORCIBLE ACTION.

Example:

❗️ UNPLUG THE POWER CABLE FROM THE RECEPTACLE.
<table>
<thead>
<tr>
<th><strong>WARNING</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warnings for AC Power Supply:</strong></td>
</tr>
<tr>
<td>If the attached AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it forcibly. Failure to comply may cause electric shock and/or fire.</td>
</tr>
<tr>
<td>Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.</td>
</tr>
<tr>
<td>This product is connected signal ground with frame ground. If yours developing product is transform-less (not having isolation transformer of AC power), this may cause electric shock. Also, this may give an un-repairable damage to this product and yours developing product. While developing, connect AC power of the product to commercial power through isolation transformer in order to avoid these dangers.</td>
</tr>
<tr>
<td>If other equipment is connected to the same branch circuit, care should be taken not to overload the circuit.</td>
</tr>
<tr>
<td>When installing this equipment, insure that a reliable ground connection is maintained.</td>
</tr>
<tr>
<td>If you smell a strange odor, hear an unusual sound, or see smoke coming from this product, then disconnect power immediately by unplugging the AC power cable from the outlet. Do not use this as it is because of the danger of electric shock and/or fire. In this case, contact your local distributor.</td>
</tr>
<tr>
<td>Before setting up this product and connecting it to other devices, turn off power or remove a power cable to prevent injury or product damage.</td>
</tr>
<tr>
<td><strong>Warnings to Be Taken for Handling:</strong></td>
</tr>
<tr>
<td>Do not modify this product. Personal injury due to electric shock may occur if this product is modified. Modifying the product will void your warranty.</td>
</tr>
<tr>
<td>Make sure nothing falls into the cooling fan on the top panel, especially liquids, metal objects, or anything combustible.</td>
</tr>
<tr>
<td><strong>Warning for Installation:</strong></td>
</tr>
<tr>
<td>Do not set this product in water or areas of high humidity. Make sure that the product does not get wet. Spilling water or some other liquid into the product may cause un-repairable damage.</td>
</tr>
<tr>
<td><strong>Warning for Use temperature:</strong></td>
</tr>
<tr>
<td>This equipment is to be used in an environment with a maximum ambient temperature of 35°C. Care should be taken that this temperature is not exceeded.</td>
</tr>
<tr>
<td><strong>Caution for AC Adapter:</strong></td>
</tr>
<tr>
<td>The DC plug of the AC adapter has the polarity shown below.</td>
</tr>
<tr>
<td>Use an AC adapter which complies with the safety standards of the country where it is to be used.</td>
</tr>
</tbody>
</table>
### CAUTION

**Cautions to Be Taken for the AC Adapter:**
- Use only the AC adapter included in this product.
- Do not use the AC adapter for other equipment.

**Cautions to Be Taken for Turning On the Power:**
- Turn ON/OFF the power of the emulator and the user system as simultaneously as possible.
- If you cannot turn on the powers simultaneously, turn on the emulator first and then the user system.

When turning on the power again after shutting off the power, wait about 10 seconds.

**Cautions to Be Taken for Handling This Product:**
- Use caution when handling the product. Be careful not to apply a mechanical shock.

  - Do not touch the connector pins of the emulator and the target MCU connector pins directly. Static electricity may damage the internal circuits.

  - When attaching and removing the cable, hold the plug of the cable and do not touch the cable. Do not pull the emulator by the communications interface cable or the flexible cable. And, excessive flexing or force may break conductors.

  - Do not flex the flexible cable excessively. The cable may cause a break.

  - Do not use inch-size screws for this equipment. The screws used in this equipment are all ISO (meter-size) type screws. When replacing screws, use same type screws as equipped before.

  - Do not tape the flexible cable or apply adhesives to secure the cable. The shielding material on the surface of the cable may come off.

**Note on Transporting the Product:**
- When sending your product for repair, use the packing box and cushioning material supplied with the product when it was delivered to you and specify caution in handling (handling as precision equipment). If packing of your product is not complete, it may be damaged during transportation.

  - When you pack your product in a bag, make sure to use the conductive plastic bag supplied with the product (usually a blue bag). If you use a different bag, it may lead to further trouble with your product due to static electricity.

**Caution to Be Taken for System Malfunctions:**
- If the emulator malfunctions because of interference like external noise, do the following to remedy the trouble.

  1. Exit the emulator debugger, and shut OFF the emulator and the user system.
  2. After a lapse of 10 seconds, turn ON the power of the emulator and the user system again, then launch the emulator debugger.

**Caution to Be Taken for Disposal:**
- Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

**European Union regulatory notices:**
- The WEEE (Waste Electrical and Electronic Equipment) regulations put responsibilities on producers for the collection and recycling or disposal of electrical and electronic waste. Return of WEEE under these regulations is applicable in the European Union only. This equipment (including all accessories) is not intended for household use. After use the equipment cannot be disposed of as household waste, and the WEEE must be treated, recycled and disposed of in an environmentally sound manner.

  - Renesas Electronics Europe GmbH can take back end of life equipment, register for this service at "http://www.renesas.eu/weee".
Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>4</td>
</tr>
<tr>
<td>Important</td>
<td>5</td>
</tr>
<tr>
<td>Precautions for Safety</td>
<td>7</td>
</tr>
<tr>
<td>User Registration</td>
<td>10</td>
</tr>
<tr>
<td>Terminology</td>
<td>15</td>
</tr>
<tr>
<td>1. Outline</td>
<td>16</td>
</tr>
<tr>
<td>1.1 Package Components</td>
<td>17</td>
</tr>
<tr>
<td>1.2 Other Tool Products Required for Development</td>
<td>17</td>
</tr>
<tr>
<td>1.3 System Configuration</td>
<td>18</td>
</tr>
<tr>
<td>1.3.1 System Configuration</td>
<td>18</td>
</tr>
<tr>
<td>1.3.2 Names and Functions of each part of the emulator</td>
<td>19</td>
</tr>
<tr>
<td>1.4 Specifications</td>
<td>21</td>
</tr>
<tr>
<td>1.4.1 Product Specifications</td>
<td>21</td>
</tr>
<tr>
<td>1.4.2 Regulatory Compliance Notices</td>
<td>22</td>
</tr>
<tr>
<td>1.4.3 Operating Environment</td>
<td>23</td>
</tr>
<tr>
<td>1.4.4 Specifications of the AC Adapter</td>
<td>24</td>
</tr>
<tr>
<td>2. Setup</td>
<td>25</td>
</tr>
<tr>
<td>2.1 Flowchart of Starting Up the Emulator</td>
<td>25</td>
</tr>
<tr>
<td>2.2 Installing the Included Software</td>
<td>27</td>
</tr>
<tr>
<td>2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit</td>
<td>28</td>
</tr>
<tr>
<td>2.4 Connecting the Host Machine</td>
<td>29</td>
</tr>
<tr>
<td>2.5 Connecting the Emulator Power Supply</td>
<td>30</td>
</tr>
<tr>
<td>2.6 Turning ON the Power</td>
<td>31</td>
</tr>
<tr>
<td>2.6.1 Checking the Connections of the Emulator System</td>
<td>31</td>
</tr>
<tr>
<td>2.6.2 Turning the Power ON and OFF</td>
<td>31</td>
</tr>
<tr>
<td>2.7 Self-checking</td>
<td>32</td>
</tr>
<tr>
<td>2.8 Selecting the Clock Supply</td>
<td>33</td>
</tr>
<tr>
<td>2.8.1 Clock Source</td>
<td>33</td>
</tr>
<tr>
<td>2.8.2 Using an Internal Oscillator Circuit Board</td>
<td>34</td>
</tr>
<tr>
<td>2.8.3 Using the Oscillator Circuit on the User System</td>
<td>35</td>
</tr>
<tr>
<td>2.8.4 Using the Internal Generator Circuit</td>
<td>35</td>
</tr>
<tr>
<td>2.9 Connecting the User System</td>
<td>36</td>
</tr>
<tr>
<td>2.9.1 Connecting to a 100-pin 0.5mm Pitch Foot Pattern</td>
<td>37</td>
</tr>
<tr>
<td>2.9.2 Connecting to an 80-pin 0.5mm Pitch Foot Pattern</td>
<td>38</td>
</tr>
<tr>
<td>2.9.3 Connecting to a 64-pin 0.5mm Pitch Foot Pattern</td>
<td>39</td>
</tr>
<tr>
<td>3. Tutorial</td>
<td>40</td>
</tr>
<tr>
<td>3.1 Introduction</td>
<td>40</td>
</tr>
<tr>
<td>3.2 Starting the High-performance Embedded Workshop</td>
<td>41</td>
</tr>
<tr>
<td>3.3 Connecting the Emulator</td>
<td>41</td>
</tr>
<tr>
<td>3.4 Downloading the Tutorial Program</td>
<td>42</td>
</tr>
<tr>
<td>3.4.1 Downloading the Tutorial Program</td>
<td>42</td>
</tr>
<tr>
<td>3.4.2 Displaying the Source Program</td>
<td>43</td>
</tr>
<tr>
<td>3.5 Setting Software Breakpoints</td>
<td>44</td>
</tr>
<tr>
<td>3.6 Executing the Program</td>
<td>45</td>
</tr>
<tr>
<td>3.6.1 Resetting the CPU</td>
<td>45</td>
</tr>
<tr>
<td>3.6.2 Executing the Program</td>
<td>45</td>
</tr>
<tr>
<td>3.7 Checking Breakpoints</td>
<td>46</td>
</tr>
<tr>
<td>3.7.1 Checking Breakpoints</td>
<td>46</td>
</tr>
<tr>
<td>3.8 Altering Register Contents</td>
<td>47</td>
</tr>
<tr>
<td>3.9 Referencing Symbols</td>
<td>48</td>
</tr>
<tr>
<td>3.10 Checking Memory Contents</td>
<td>49</td>
</tr>
<tr>
<td>3.11 Referencing Variables</td>
<td>50</td>
</tr>
<tr>
<td>3.12 Showing Local Variables</td>
<td>52</td>
</tr>
<tr>
<td>3.13 Single-Stepping a Program</td>
<td>52</td>
</tr>
<tr>
<td>3.13.1 Executing Step In Command</td>
<td>53</td>
</tr>
<tr>
<td>3.13.2 Executing the Step Out Command</td>
<td>54</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>55</td>
<td>3.13.3 Executing the Step Over Command</td>
</tr>
<tr>
<td>56</td>
<td>3.14 Forcibly Breaking a Program</td>
</tr>
<tr>
<td>57</td>
<td>3.15 Hardware Break Facility</td>
</tr>
<tr>
<td>57</td>
<td>3.15.1 Stopping a Program when It Executes a Specified Address</td>
</tr>
<tr>
<td>58</td>
<td>3.16 Stopping a Program when It Accesses Memory</td>
</tr>
<tr>
<td>59</td>
<td>3.17 Trace Facility</td>
</tr>
<tr>
<td>60</td>
<td>3.17.1 Showing the Trace Information Acquired by Fill Until Stop</td>
</tr>
<tr>
<td>63</td>
<td>3.17.2 Showing the Trace Information Acquired by Fill around TP</td>
</tr>
<tr>
<td>65</td>
<td>3.17.3 Showing a Function Execution History</td>
</tr>
<tr>
<td>67</td>
<td>3.17.4 Filter Facility</td>
</tr>
<tr>
<td>69</td>
<td>3.18 Stack Trace Facility</td>
</tr>
<tr>
<td>70</td>
<td>3.19 What Next?</td>
</tr>
<tr>
<td>71</td>
<td>4. Preparing to Debug</td>
</tr>
<tr>
<td>71</td>
<td>4.1 Starting the High-performance Embedded Workshop</td>
</tr>
<tr>
<td>72</td>
<td>4.2 Creating a New Workspace (Toolchain Unused)</td>
</tr>
<tr>
<td>74</td>
<td>4.3 Creating a New Workspace (Toolchain Used)</td>
</tr>
<tr>
<td>77</td>
<td>4.4 Opening an Existing Workspace</td>
</tr>
<tr>
<td>78</td>
<td>4.5 Connecting the Emulator</td>
</tr>
<tr>
<td>78</td>
<td>4.5.1 Connecting the Emulator</td>
</tr>
<tr>
<td>78</td>
<td>4.5.2 Reconnecting the Emulator</td>
</tr>
<tr>
<td>79</td>
<td>4.6 Disconnecting the Emulator</td>
</tr>
<tr>
<td>79</td>
<td>4.6.1 Disconnecting the Emulator</td>
</tr>
<tr>
<td>80</td>
<td>4.7 Quitting the High-performance Embedded Workshop</td>
</tr>
<tr>
<td>80</td>
<td>4.8 Setting Up the Debug</td>
</tr>
<tr>
<td>80</td>
<td>4.8.1 Specifying a Download Module</td>
</tr>
<tr>
<td>81</td>
<td>4.8.2 Setting Up Automatic Execution of Command Line Batch Files</td>
</tr>
<tr>
<td>82</td>
<td>5. Debugging Functions</td>
</tr>
<tr>
<td>83</td>
<td>5.1 Setting Up the Emulation Environment</td>
</tr>
<tr>
<td>83</td>
<td>5.1.1 Setting Up the Emulator at Startup</td>
</tr>
<tr>
<td>84</td>
<td>5.1.2 Setting Up the Target MCU</td>
</tr>
<tr>
<td>86</td>
<td>5.1.3 Setting Up the System</td>
</tr>
<tr>
<td>88</td>
<td>5.1.4 Setting Up Flash ROM Overwrite</td>
</tr>
<tr>
<td>89</td>
<td>5.1.5 Setting the Warning of Exceptional Events</td>
</tr>
<tr>
<td>90</td>
<td>5.1.6 Showing Progress in Boot-up Processing</td>
</tr>
<tr>
<td>92</td>
<td>5.2 Downloading a Program</td>
</tr>
<tr>
<td>92</td>
<td>5.2.1 Downloading a Program</td>
</tr>
<tr>
<td>92</td>
<td>5.2.2 Showing the Source Code</td>
</tr>
<tr>
<td>94</td>
<td>5.2.3 Turning columns in all source files off</td>
</tr>
<tr>
<td>94</td>
<td>5.2.4 Turning columns in one source file off</td>
</tr>
<tr>
<td>94</td>
<td>5.2.5 Showing Assembly Language Code</td>
</tr>
<tr>
<td>95</td>
<td>5.2.6 Correcting Assembly Language Codes</td>
</tr>
<tr>
<td>97</td>
<td>5.3 Displaying Memory Contents in Real Time</td>
</tr>
<tr>
<td>97</td>
<td>5.3.1 Displaying Memory Contents in Real Time</td>
</tr>
<tr>
<td>98</td>
<td>5.3.2 Setting RAM Monitor Update Intervals</td>
</tr>
<tr>
<td>98</td>
<td>5.3.3 Clearing RAM Monitor Access History</td>
</tr>
<tr>
<td>98</td>
<td>5.3.4 Clearing RAM Monitor Error Detection Data</td>
</tr>
<tr>
<td>99</td>
<td>5.4 Showing the Current Status</td>
</tr>
<tr>
<td>99</td>
<td>5.4.1 Showing the Emulator Status</td>
</tr>
<tr>
<td>100</td>
<td>5.4.2 Showing the Emulator Status in the Status Bar</td>
</tr>
<tr>
<td>101</td>
<td>5.5 Periodically Reading Out and Showing the Emulator Status</td>
</tr>
<tr>
<td>101</td>
<td>5.5.1 Periodically Reading Out and Showing the Emulator Information</td>
</tr>
<tr>
<td>102</td>
<td>5.5.2 Selecting the Items to Be Displayed</td>
</tr>
<tr>
<td>103</td>
<td>5.6 Using Software Breakpoints</td>
</tr>
<tr>
<td>103</td>
<td>5.6.1 Using Software Breakpoints</td>
</tr>
<tr>
<td>104</td>
<td>5.6.2 Adding/Removing Software Breakpoints</td>
</tr>
<tr>
<td>105</td>
<td>5.6.3 Enabling/Disabling Software Breakpoints</td>
</tr>
<tr>
<td>107</td>
<td>5.7 Using Events</td>
</tr>
<tr>
<td>107</td>
<td>5.7.1 Using Events</td>
</tr>
<tr>
<td>108</td>
<td>5.7.2 Adding Events</td>
</tr>
<tr>
<td>113</td>
<td>5.7.3 Removing Events</td>
</tr>
<tr>
<td>115</td>
<td>5.7.4 Registering Events</td>
</tr>
<tr>
<td>117</td>
<td>5.7.5 Entering Events Each Time or Reusing Events</td>
</tr>
</tbody>
</table>
Contents

5.7.6 Applying Events ............................................................................................................. 118
5.8 Setting Hardware Break Conditions ............................................................................... 119
  5.8.1 Setting Hardware Break Conditions .......................................................................... 119
  5.8.2 Setting Hardware Breakpoints ......................................................................................... 119
  5.8.3 Saving/Loading the Set Contents of Hardware Breaks .................................................. 122
5.9 Looking at Trace Information ......................................................................................... 123
  5.9.1 Looking at Trace Information ......................................................................................... 123
  5.9.2 Acquiring Trace Information ......................................................................................... 123
  5.9.3 Setting Trace Information Acquisition Conditions ..................................................... 125
  5.9.4 Setting Trace Modes ..................................................................................................... 128
  5.9.5 Setting Trace Points ...................................................................................................... 130
  5.9.6 Setting Capture/Do not Capture Conditions ................................................................. 134
  5.9.7 Selecting the Content of Trace Acquisition ................................................................. 136
  5.9.8 Showing Trace Results ................................................................................................. 137
  5.9.9 Filtering Trace Information ........................................................................................... 139
  5.9.10 Searching for Trace Records ...................................................................................... 140
  5.9.11 Saving Trace Information to Files .............................................................................. 141
  5.9.12 Loading Trace Information from Files ....................................................................... 142
  5.9.13 Temporarily Stopping Trace Information Acquisition .............................................. 142
  5.9.14 Restarting Trace Information Acquisition .................................................................. 142
  5.9.15 Switching Timestamp Display .................................................................................... 142
  5.9.16 Showing the History of Function Execution ............................................................... 143
  5.9.17 Showing the History of Task Execution ..................................................................... 144
5.10 Measuring Performance ............................................................................................... 145
  5.10.1 Measuring Performance ............................................................................................. 145
  5.10.2 Showing the Result of Performance Measurement .................................................... 145
  5.10.3 Setting Performance Measurement Conditions ....................................................... 146
  5.10.4 Starting Performance Measurement ......................................................................... 148
  5.10.5 Clearing Performance Measurement Conditions ...................................................... 149
  5.10.6 Clearing the Performance Measurement Result ......................................................... 149
  5.10.7 About the Maximum Measurement Time of Performance ....................................... 149
5.11 Acquiring Code Coverage ............................................................................................ 150
  5.11.1 Acquiring Code Coverage .......................................................................................... 150
  5.11.2 Opening the Code Coverage Window ....................................................................... 150
  5.11.3 Allocating Code Coverage Memory (Hardware Resource) ...................................... 151
  5.11.4 Code Coverage in an Address Range ....................................................................... 153
  5.11.5 Adding Address Ranges ............................................................................................ 154
  5.11.6 Changing Address Ranges ........................................................................................ 155
  5.11.7 Removing Address Ranges ....................................................................................... 156
  5.11.8 Code Coverage in a Source File ............................................................................... 158
  5.11.9 Adding Source Files .................................................................................................. 159
  5.11.10 Removing Source Files ............................................................................................ 160
  5.11.11 Showing Percentages and Graphs .......................................................................... 162
  5.11.12 Using the Sort Function .......................................................................................... 163
  5.11.13 Searching for Unexecuted Lines ............................................................................. 164
  5.11.14 Clearing Code Coverage Information ..................................................................... 165
  5.11.15 Updating Coverage Information ............................................................................... 165
  5.11.16 Preventing Update of Coverage Information ............................................................ 165
  5.11.17 Saving the Code Coverage Information to a File ..................................................... 166
  5.11.18 Loading Code Coverage Information from a File .................................................... 166
  5.11.19 Coverage Information File Load Modes .................................................................... 167
  5.11.20 Displaying Code Coverage Information in the Editor Window ............................... 169
5.12 Acquiring Data Coverage ............................................................................................ 170
  5.12.1 Acquiring Data Coverage .......................................................................................... 170
  5.12.2 Opening the Data Coverage Window ....................................................................... 170
  5.12.3 Allocating Data Coverage Memory (Hardware Resource) ...................................... 171
  5.12.4 Data Coverage in an Address Range ....................................................................... 173
  5.12.5 Adding Address Ranges ............................................................................................ 174
  5.12.6 Changing Address Ranges ........................................................................................ 175
  5.12.7 Removing Address Ranges ....................................................................................... 176
  5.12.8 Data Coverage in a Section ....................................................................................... 177
  5.12.9 Adding Sections ........................................................................................................ 178

R0E535M00MCU00 User's Manual

R20UT0432EJ0602 Rev.6.02 Page 12 of 235
Sep.01.21
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8. Maintenance and Warranty</td>
<td>231</td>
</tr>
<tr>
<td>8.1 User Registration</td>
<td>231</td>
</tr>
<tr>
<td>8.2 Maintenance</td>
<td>231</td>
</tr>
<tr>
<td>8.3 Warranty</td>
<td>231</td>
</tr>
<tr>
<td>8.4 Repair Provisions</td>
<td>232</td>
</tr>
<tr>
<td>8.5 How to Make Request for Repair</td>
<td>232</td>
</tr>
<tr>
<td>Revision History</td>
<td>1</td>
</tr>
</tbody>
</table>
User Registration

When you install debugger software, a text file for user registration is created on your PC. Fill it in and email it to your local distributor. If you have replaced an emulator main unit or emulation probe, rewrite an emulator name and serial number in the text file you filled in earlier to register your new hardware products.

Your registered information is used for only after-sale services, and not for any other purposes. Without user registration, you will not be able to receive maintenance services such as a notification of field changes or trouble information. So be sure to carry out the user registration.

For more information about user registration, please contact your local distributor.
Terminology
Some specific words used in this user’s manual are defined below.

**MCU unit (R0E535M00MCU00)**
This means the E100 emulator for the M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups.

**Emulator system**
This means an emulator system built around the MCU unit (R0E535M00MCU00). The emulator system is configured with an emulator main unit (R0E001000EMU00), MCU unit (R0E535M00MCU00), emulator power supply, USB cable, emulator debugger and host machine.

**Integrated development environment: High-performance Embedded Workshop**
This tool provides powerful support for the development of embedded applications for Renesas microcomputers. It has an emulator debugger function allowing the emulator to be controlled from the host machine via an interface. Furthermore, it permits a range of operations from editing a project to building and debugging it to be performed within the same application. In addition, it supports version management.

**Emulator debugger**
This means a software tool that is started up from the High-performance Embedded Workshop, and controls the MCU unit and enables debugging.

**Firmware**
This means a control program stored in the emulator. This analyzes the contents of communications with the emulator debugger and controls the emulator hardware. To upgrade the firmware, download the program from the emulator debugger.

**Host machine**
This means a personal computer used to control the emulator.

**Target MCU**
This means the MCU to be debugged.

**User system**
This means a user’s application system in which the MCU to be debugged is used.

**User program**
This means the program to be debugged.

**Evaluation MCU**
This means the MCU mounted on the emulator which is operated in a dedicated mode for use with tools.

#
This symbol indicates that a signal is active-low (e.g. RESET#).
1. Outline

This chapter describes the package components, the system configuration, and the specifications of the emulator functions and operating environment.

1.1 Package Components

The R0E535M00MCU00 package consists of the following items. After you have unpacked the box, check if your R0E535M00MCU00 contains all of these items.

Table 1.1 Package components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>R0E535M00MCU00</td>
<td>MCU board</td>
<td>1</td>
</tr>
<tr>
<td>Oscillator module (20MHz)</td>
<td>Mounted on the IC17 socket</td>
<td>1</td>
</tr>
<tr>
<td>R0E001000FLX10</td>
<td>Flexible cable</td>
<td>2</td>
</tr>
<tr>
<td>R0E535M00MCU00 Release Notes</td>
<td>English</td>
<td>1</td>
</tr>
<tr>
<td>R0E535M00MCU00 Release Notes</td>
<td>Japanese</td>
<td>1</td>
</tr>
<tr>
<td>Repair Request Sheet</td>
<td>English</td>
<td>1</td>
</tr>
<tr>
<td>Repair Request Sheet</td>
<td>Japanese</td>
<td>1</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>- M16C R8C E100 Emulator Software (M16C R8C E100 Emulator Debugger Included) - User’s Manual</td>
<td>1</td>
</tr>
</tbody>
</table>

* Please keep the R0E535M00MCU00’s packing box and cushioning materials at hand for later reuse in sending the product for repairs or for other purposes. Always use the original packing box and cushioning material when transporting the MCU unit.

* If you have any questions or are in doubt about any point regarding the packaged product, contact your local distributor.

1.2 Other Tool Products Required for Development

To proceed with the development of a program for M16C/50 Series M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups MCUs, the products listed below are necessary in addition to those contained in the package and listed above. Procure them separately.

Table 1.2 Other tool products required for development

<table>
<thead>
<tr>
<th>Product</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emulator main unit E100</td>
<td>R0E001000EMU00</td>
</tr>
<tr>
<td>100-pin 0.5mm pitch LQFP (PLQP0100KB-A Previous code: 100P6Q-A)</td>
<td>R0E0100TNPFK00</td>
</tr>
<tr>
<td>80-pin 0.5mm pitch LQFP (PLQP0080KB-A Previous code: 80P6Q-A)</td>
<td>R0E535M00CFK30</td>
</tr>
<tr>
<td>64-pin 0.5mm pitch LQFP (PLQP0064KB-A Previous code: 64P6Q-A)</td>
<td>R0E535M00CFK40</td>
</tr>
</tbody>
</table>

* To purchase the product, contact your local distributor.
1.3 System Configuration

1.3.1 System Configuration

Figure 1.1 shows the configuration of the emulator system.

Figure 1.1 System configuration

(1) MCU Unit R0E535M00MCU00 (this product)
   This is an MCU board for the M16C/50 Series M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups
   MCUs with 284 KB ROM and contains an evaluation MCU.
(2) Flexible cable R0E001000FLX10 (included)
(3) E100 Emulator main unit R0E001000EMU00
   This is the E100 emulator main unit.
(4) USB interface cable
   This is an interface cable for the host machine and emulator.
(5) AC adapter supply for the emulator
(6) Host machine
   A personal computer to control the emulator.
(7) Pitch converter board for connecting to the user system R0E0100TNP0K00, etc.
(8) User system and user system power supply
   User system is your application system. This emulator can be used without the user system.
   The user system power supply is power supply for the user system. This emulator cannot supply power to the user system.
   Get a power supply separately.
1.3.2 Names and Functions of each part of the emulator

Figure 1.2 shows the names of each part of the emulator.

1) Power switch
This is a switch to turn the emulator ON and OFF.

2) USB cable connector
This is a connector for connecting the USB cable of the emulator.

3) Power connector
This is a connector for connecting the DC cable of the AC power adapter of the emulator.

4) External trigger connector
This is a connector to connect the external trigger cable of the emulator.
(5) System Status LEDs
The system status LEDs indicate the emulator E100's power supply, operating state of firmware, etc. Table 1.3 lists the definitions of each system status LED.

Table 1.3 Definitions of the system status LEDs

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>ON</td>
<td>Emulator system power is turned ON.</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Emulator system power is turned OFF.</td>
</tr>
<tr>
<td>SAFE</td>
<td>ON</td>
<td>Emulator system is operating normally.</td>
</tr>
<tr>
<td></td>
<td>Flashing</td>
<td>Emulator system cannot communicate with the host machine.</td>
</tr>
<tr>
<td></td>
<td>(every 2 seconds)</td>
<td>The self-checking is in progress.</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Emulator system is not operating normally (system status error).</td>
</tr>
</tbody>
</table>

(6) Target Status LEDs
The target status LEDs indicate operating state of the target MCU and power supply of the user system. Table 1.4 lists the definition of each target status LED.

Table 1.4 Definitions of the target status LEDs

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>ON</td>
<td>Power is being supplied to the user system.</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Power is not being supplied to the user system.</td>
</tr>
<tr>
<td>RESET</td>
<td>ON</td>
<td>Target MCU is being reset, or reset signal of the user system is held low.</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Target MCU is not being reset.</td>
</tr>
<tr>
<td>RUN</td>
<td>ON</td>
<td>User program is being executed.</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>User program has been halted.</td>
</tr>
</tbody>
</table>

Note on the Target Status POWER LED:
- If your MCU has two or more Vcc pins, the LED does not light up unless power is supplied to all the pins.
1. Specifications

1.4.1 Product Specifications

Table 1.5 lists the specifications of the R0E535M00MCU00.

<table>
<thead>
<tr>
<th>Table 1.5 Specifications of the R0E535M00MCU00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable MCU</td>
</tr>
<tr>
<td>Applicable MCU mode</td>
</tr>
<tr>
<td>Maximum ROM/RAM capacity</td>
</tr>
<tr>
<td>Maximum operating frequency</td>
</tr>
<tr>
<td>Software break</td>
</tr>
<tr>
<td>Hardware break</td>
</tr>
<tr>
<td>Combination, pass count</td>
</tr>
<tr>
<td>Detection of exceptional events</td>
</tr>
<tr>
<td>Real-time tracing</td>
</tr>
<tr>
<td>Trace modes</td>
</tr>
<tr>
<td>Extraction/deletion of trace data</td>
</tr>
<tr>
<td>Real-time RAM monitor</td>
</tr>
<tr>
<td>Time measurement</td>
</tr>
<tr>
<td>Coverage measurement</td>
</tr>
<tr>
<td>Profile</td>
</tr>
<tr>
<td>Connection to user system</td>
</tr>
<tr>
<td>Emulator power supply</td>
</tr>
</tbody>
</table>
1.4.2 Regulatory Compliance Notices

● European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European Union.)

CE Certifications:
- Electromagnetic Compatibility (EMC) Directive 2014/30/EU
  EN 55032 Class A

**WARNING:** This is a Class A product. This equipment can cause radio frequency noise when used in the residential area. In such cases, the user/operator of the equipment may be required to take appropriate countermeasures under his responsibility.

EN 55024

- Information for traceability
  - Authorised representative
    Name: Renesas Electronics Corporation
    Address: Toyosu Foresia, 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
  - Person responsible for placing on the market
    Name: Renesas Electronics Europe GmbH
    Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
  - Trademark and Type name
    Trademark: Renesas
    Product name: E100 Emulator MCU Unit
    Type name: R0E535M00MCU00

Environmental Compliance and Certifications:
- Waste Electrical and Electronic Equipment (WEEE) Directive 2012/19/EU

● United States Regulatory notices

This product complies with the following EMC regulation. (This is only valid in the United States.)

FCC Certifications:
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

**CAUTION:** Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.
1.4.3 Operating Environment

Make sure to use this emulator in the operating environments listed in Tables 1.6 to 1.8.

Table 1.6 Operating environmental conditions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>5 to 35°C (no condensation)</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-10 to 60°C (no condensation)</td>
</tr>
</tbody>
</table>

Table 1.7 Operating environment of the host machine (Windows® XP)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host machine</td>
<td>IBM PC/AT compatible</td>
</tr>
<tr>
<td>OS</td>
<td>Windows® XP 32-bit edition [*1] [*3]</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium 4 running at 1.6 GHz or more recommended</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 / USB 1.1 [*2]</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GByte or larger (more than 10 times the file size of the load module) recommended</td>
</tr>
<tr>
<td>Pointing device such as mouse</td>
<td>Mouse or any other pointing device usable with the above OS that can be connected to the host machine</td>
</tr>
<tr>
<td>CD drive</td>
<td>Needed to install the emulator debugger or refer to the user’s manual</td>
</tr>
</tbody>
</table>

Table 1.8 Operating environment of the host machine (Windows Vista® or Windows® 7)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host machine</td>
<td>IBM PC/AT compatible</td>
</tr>
<tr>
<td></td>
<td>Windows® 7 32-bit edition / 64-bit edition [*1]</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium 4 running at 3GHz or Core 2 Duo running at 1GHz or more recommended</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 / USB 1.1 [*2]</td>
</tr>
<tr>
<td>Memory</td>
<td>2 GByte or larger (more than 10 times the file size of the load module) recommended (32-bit edition)</td>
</tr>
<tr>
<td></td>
<td>3 GByte or larger (more than 10 times the file size of the load module) recommended (64-bit edition)</td>
</tr>
<tr>
<td>Pointing device such as mouse</td>
<td>Mouse or any other pointing device usable with the above OS that can be connected to the host machine</td>
</tr>
<tr>
<td>CD drive</td>
<td>Needed to install the emulator debugger or refer to the user’s manual</td>
</tr>
</tbody>
</table>

Notes:
*1: Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other company or product names are the property of their respective owners.
*2: Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.
*3: The 64-bit edition of Windows® XP is not supported.
*4: The 64-bit edition of Windows Vista® is not supported.
1.4.4 Specifications of the AC Adapter

The user must prepare an AC adapter and a power cable. Use an AC adapter which complies with the safety standards of the country where it is to be used. Table 1.9 lists the recommended specifications of the AC adapter.

Table 1.9 Recommended Specifications of the AC Adapter

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC input voltage range</td>
<td>AC 100 to 240 V, 50/60Hz single phase</td>
</tr>
<tr>
<td>Output power</td>
<td>36 W</td>
</tr>
<tr>
<td>DC output voltage, current</td>
<td>12.0 V, 3.0 A</td>
</tr>
<tr>
<td>DC output polarity</td>
<td>EIAJ TYPE IV, inner-side positive/outer-side negative</td>
</tr>
</tbody>
</table>
2. Setup

This chapter describes the preparation for using the MCU unit, the procedure for starting up the emulator and how to change settings.

2.1 Flowchart of Starting Up the Emulator

The procedure for starting up the emulator is shown in Figures 2.1 and 2.2. For details, refer to each section hereafter. If the emulator does not start up normally, refer to “6. Troubleshooting (Action in Case of an Error)”.

![Flowchart of starting up the emulator](image-url)

Figure 2.1 Flowchart of starting up the emulator (for the first time)
2. Setup

Change the settings.

Connect the user system.

Turn on the power supply.

Check the LEDs on the emulator.

Start up the emulator debugger from the High-performance Embedded Workshop.

Set up the operating environment of the emulator debugger.

Debug a program with various functions of the emulator debugger.

Change the settings of the power supply to MCUs or clock supply, according to the conditions on use.

Connect the user system as occasion demands.

Turn ON the power to the emulator and the user system as simultaneously as possible.

Check that system status LEDs, and POWER and RESET of the target status LED are lighting. When the user system is not connected, the POWER LED does not light up.

Start up the High-performance Embedded Workshop to launch the emulator debugger.

Check the contents set in the step 12 in Figure 2.1. Do not select the “Start booting up on successful completion of self-checking” checkbox.

Refer to the High-performance Embedded Workshop and “5. Debugging Functions” (page 82).

Figure 2.2 Flowchart of starting up the emulator (after the self-checking)
2.2 Installing the Included Software
If you have Windows® 7, Windows Vista® or Windows® XP on the host machine, this installation must be executed by a user with administrator rights. Note that users without administrator rights cannot complete the installation.

Place the CD-ROM in the CD-ROM drive and follow the instructions to install the software.
2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit

Figure 2.3 shows the procedure for connecting the MCU Unit to the E100 Emulator Main Unit.

Connecting

Insert the MCU unit following the inside rails of the main unit.

Push the MCU unit down to check it is attached properly.

Disconnecting

Pull the MCU unit up.

Figure 2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit

⚠️ CAUTION

Note on Connecting the MCU Unit to the E100 Emulator Main Unit:

- Always shut OFF power when connecting the MCU unit to the E100 emulator main unit. Otherwise, internal circuits may be damaged.
2.4 Connecting the Host Machine
USB interface is used for connecting the emulator to the host machine. The USB cable is connected to the USB cable connector of the emulator and the USB port of the host machine.

![Connecting the host machine](image)

Figure 2.4 Connecting the host machine
2.5 Connecting the Emulator Power Supply

Power is supplied from an AC adapter to the emulator. The following shows how to connect the AC adapter.

1. Turn OFF the power of the emulator.
2. Connect the DC cable of the AC adapter to the emulator.
3. Connect the AC power cable to the AC adapter.
4. Connect the AC power cable to the outlet.

![Connecting the emulator power supply](image)

**CAUTION**

Cautions for AC Power Cable:
- If the AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it forcibly. Failure to comply may cause electric shock and/or fire.
- Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.

Cautions for AC Adapter:
- The DC plug of the AC adapter has the polarity shown below.

![Polarity Diagram](image)

Use an AC adapter which complies with the safety standards of the country where it is to be used.
2.6 Turning ON the Power

2.6.1 Checking the Connections of the Emulator System
Before turning the power ON, check the connection of the interface cable with the host machine, emulator, and user system.

2.6.2 Turning the Power ON and OFF
- Turn ON/OFF the power of the emulator and user system as simultaneously as possible.
- When the SAFE LED of the system LEDs is flashing, check that the USB cable is connected to the host machine. When each of the target status LEDs is flashing, check that the MCU unit is connected.
- When turning ON the power again after shutting OFF the power, wait for about 10 seconds.

Notes on Power Supply:
- The emulator pin Vcc is connected to the user system in order to monitor user system voltage. For this reason, the emulator cannot supply power to the user system. Supply power to the user system separately.

  The voltage of the user system should be as follows.
  
  \[ 2.7 \, \text{V} \leq \text{Vcc} \leq 5.5 \, \text{V} \]

- When you start the emulator without the user system, do not attach a converter board. When starting with a converter board, the MCU will be in a reset status.
- When you start the emulator without the user system, take care that any metallic pieces are not touched to the connector at the head of the flexible cable.
- Do not leave either the emulator or user system powered on. The internal circuits may be damaged due to leakage current.
2.7 Self-checking

Self-checking is to check if the emulator functions operate properly. To run the self-check function of the emulator, follow the procedure below. While the self-checking is in progress, the states of the LEDs will change as shown in Figure 2.6. In case of ERROR, because the states of the target status LEDs will change depending on the types of errors, check the system status LEDs.

1. If the user system is connected, disconnect the converter board and the user system.
2. Turn on the emulator.
3. Launch the emulator debugger, and select the “Start booting up on successful completion of self-checking” checkbox in the Device Setting dialog box.
4. When you click OK, self-checking will start. If the normal result is displayed in about 60 seconds, self-checking has ended.

![Figure 2.6 LED displays during the self-checking](image-url)
2.8 Selecting the Clock Supply

2.8.1 Clock Source

You can choose the clock source supplied to the evaluation MCU in the Configuration properties dialog box of the emulator debugger. Table 2.1 shows the clock sources and their default settings.

Table 2.1 Clock supply to the MCU

<table>
<thead>
<tr>
<th>Clock</th>
<th>Clock selection in the emulator debugger</th>
<th>Description</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main (XIN-XOUT)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emulator</td>
<td>IC17 mounting oscillator module</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Oscillator circuit on the user system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate</td>
<td>Internal generator circuit</td>
<td>(1.0 to 20.0 MHz)</td>
<td></td>
</tr>
<tr>
<td>Sub (Xcin-Xcout)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emulator</td>
<td>Internal oscillator circuit</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>User</td>
<td>Oscillator circuit on the user system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note on Changing the Clock Supply:

- The clock supply can be set by the Configuration properties dialog box when starting up the emulator debugger or by an input of the emulator_clock command on the Command Line window.
2.8.2 Using an Internal Oscillator Circuit Board

Kinds of Oscillator Circuit Boards

An oscillator module (20MHz) is mounted on the IC17 at factory setting. If you change the frequency, replace the oscillator module.

(1) Replacing the Oscillator module

Remove the MCU unit from the E100 emulator main unit, and replace the oscillator module of the IC17 (see Figure 2.7).

![Diagram of oscillator module replacement](image)

**Figure 2.7 Replacing the oscillator module**

---

### CAUTION

Notes on Replacing the Oscillator Module and Oscillator Circuit Board:

- Always shut OFF power when replacing the oscillator module. Otherwise, internal circuits may be damaged.
- When replacing the oscillator module, remove it with a tool such as an IC extractor so as not to damage the board. If the board is damaged, the pattern on the board may be cut and the emulator may not be able to operate.
2.8.3 Using the Oscillator Circuit on the User System

To operate this product with an external clock, construct the oscillator circuit as shown in Figure 2.8 in the user system and input the oscillator output at 50% duty (within the operating range of the evaluation MCU) into pin X_IN. And pin X_OUT should be open. Choose "User" in the emulator debugger to use this clock.

![Figure 2.8 External oscillator circuit](image)

Make note that in the oscillator circuit shown in Figure 2.9 where an oscillator is connected between pins X_IN and X_OUT, oscillation does not occur because a converter board and other devices are used between the evaluation MCU and the user system. It is the same for sub-clock oscillator circuits (X_CIN and X_COUT).

![Figure 2.9 Circuit in which oscillation does not occur](image)

2.8.4 Using the Internal Generator Circuit

The dedicated circuit in the E100 can generate any arbitrary frequency specified by the emulator debugger, and it can be supplied as a main clock. It does not depend on either the oscillator circuit board in the MCU unit or the oscillator circuit on the user system. If you want to debug programs without the user system or change a frequency temporarily, you can check its operation before purchasing an oscillator. If you want to use the internal generator circuit in the E100 as a main clock, choose "Generate" in the emulator debugger and specify a frequency you like to use this clock.

Although you can change a frequency between 1.0 and 99.9 MHz by 0.1 MHz for the E100, do not specify a value exceeding the maximum input frequency 20 MHz of the X_IN of the MCU.

Notes on Using the Internal Generator Circuit:

- The internal generator circuit is equipped for temporary debugging purposes. Temperature characteristics of frequencies are not guaranteed.
- Be sure to evaluate your system with an oscillator whose frequency is the same as that of the oscillator module or oscillator circuit (emulator) for final evaluation purposes.
2.9 Connecting the User System

Figure 2.10 shows how to connect this product to your user system.

![Diagram of connecting the user system](image)

**CAUTION**

**Note on Connecting the User System:**

⚠️ Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and user system.
2.9.1 Connecting to a 100-pin 0.5mm Pitch Foot Pattern

The following is a procedure of connecting to a 100-pin 0.5mm pitch foot pattern on the user system using the R0E0100TNPFK00 (not included). For details on the R0E0100TNPFK00 (not included), refer to its user's manual.

1. Attach the NQPACK100SD-ND included with the R0E0100TNPFK00 to the user system.
2. Attach the YQPACK100SD included with the R0E0100TNPFK00 to the NQPACK100SD-ND and secure it with the YQ-GUIDEs.
3. Attach the R0E0100TNPFK00 to the YQPACK100SD.
4. Attach the CN2 side of the R0E0100TNPFK00 to the CN2 side of the flexible cable.
5. Attach the CN1 side of the R0E0100TNPFK00 to the CN1 side of the flexible cable.

Figure 2.11 Connecting to a 100-pin 0.5mm pitch foot pattern

### CAUTION

Notes on Connecting the User System:

- Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and user system.
- The connectors of the R0E0100TNPFK00 are guaranteed for only 50 insertion/removal iterations.
- For purchasing the HQPACK100SD, contact the following:

  Tokyo Eletech Corporation  [http://www.tetc.co.jp/e_index.htm](http://www.tetc.co.jp/e_index.htm)
2.9.2 Connecting to an 80-pin 0.5mm Pitch Foot Pattern

The following is a procedure of connecting to an 80-pin 0.5mm pitch foot pattern on the user system using the R0E535M00CFK30 (not included). For details on the R0E535M00CFK30 (not included), refer to its user's manual.

1. Attach the NQPACK080SD-ND included with the R0E535M00CFK30 to the user system.
2. Attach the YQPACK080SD included with the R0E535M00CFK30 to the NQPACK080SD-ND and secure it with the YQ-GUIDEs.
3. Attach the R0E535M00CFK30 to the YQPACK080SD.
4. Attach the CN2 side of the R0E535M00CFK30 to the CN2 side of the flexible cable.
5. Attach the CN1 side of the R0E535M00CFK30 to the CN1 side of the flexible cable.

Figure 2.12 Connecting to an 80-pin 0.5mm pitch foot pattern

CAUTION

Notes on Connecting the User System:

- Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and user system.
- The connectors of the R0E535M00CFK30 are guaranteed for only 50 insertion/removal iterations.
- For purchasing the HQPACK080SD, contact the following:
  Tokyo Eletech Corporation  http://www.tetc.co.jp/e_index.htm
2.9.3 Connecting to a 64-pin 0.5mm Pitch Foot Pattern

The following is a procedure of connecting to a 64-pin 0.5mm pitch foot pattern on the user system using the R0E535M00CFK40 (not included). For details on the R0E535M00CFK40 (not included), refer to its user's manual.

(1) Attach the NQPACK064SD-ND included with the R0E535M00CFK40 to the user system.
(2) Attach the YQPACK064SD included with the R0E535M00CFK40 to the NQPACK064SD-ND and secure it with the YQ-GUIDEs.
(3) Attach the R0E535M00CFK40 to the YQPACK064SD.
(4) Attach the CN2 side of the R0E535M00CFK40 to the CN2 side of the flexible cable.
(5) Attach the CN1 side of the R0E535M00CFK40 to the CN1 side of the flexible cable.

![Diagram of connecting to a 64-pin 0.5mm pitch foot pattern](image)

Figure 2.13 Connecting to a 64-pin 0.5mm pitch foot pattern

---

**CAUTION**

Notes on Connecting the User System:

- Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and user system.
- The connectors of the R0E535M00CFK40 are guaranteed for only 50 insertion/removal iterations.
- For purchasing the HQPACK64SD, contact the following:
  - Tokyo Eletech Corporation
  - [http://www.tetc.co.jp/e_index.htm](http://www.tetc.co.jp/e_index.htm)
3. Tutorial

3.1 Introduction

The E100 emulator has a tutorial program available. This program is provided as a means for presenting to you the main features of the emulator, as will be explained in this document.

This tutorial program is written in C language, and is created to sort 10 pieces of random data in ascending/descending orders. The following outlines the processing performed by the tutorial program.

The main function calls the tutorial function repeatedly in order to execute a sort process repeatedly. The tutorial function generates the random data to be sorted and calls the sort and the change functions in that order. The sort function inputs an array that contains the random data generated by the tutorial function and sorts the input data in ascending order. The change function inputs an array that was sorted in ascending order by the sort function and sorts the input data in descending order.

The tutorial program is a program designed to help users to understand how to use the functions of the emulator and the emulator debugger. When developing user systems and user programs, refer to the user’s manuals of the target MCUs.

CAUTION
If the tutorial program is recompiled, the addresses in a recompiled program may not be the same as those described in this chapter.
3.2 Starting the High-performance Embedded Workshop

Open a workspace following the procedure described in Section 4.4, “Opening an Existing Workspace”.

For the directory, specify the one that is given below.
OS installed drive\Workspace\Tutorial\E100M16C\Tutorial

For the file, specify the one that is shown below.

![Open Workspace dialog box](image)

Figure 3.1 Open Workspace dialog box

3.3 Connecting the Emulator

When the debugger is connected to the emulator, a dialog box for setting up the debugger is displayed. In this dialog box, make initial settings of the debugger.

When you have finished setting up the debugger, you are ready to debug.
3.4 Downloading the Tutorial Program

3.4.1 Downloading the Tutorial Program

Download the object program you want to debug. Note, however, that the program to be downloaded and the address in the microcomputer to which downloaded differ with each microcomputer used. Read the strings, etc. on the screen as suitable for the microcomputer you are using.

Choose Download from Tutorial.x30 of Download modules.

Figure 3.2 Download display of the tutorial program
3.4.2 Displaying the Source Program

In the High-performance Embedded Workshop you can debug a program at the source level. Double-click Tutorial.c of C source file.

If necessary, you can change the font and font size to make text more easily readable. For details on how to change, refer to the High-performance Embedded Workshop User's Manual.

The Editor window initially shows the beginning of a program. Using the scroll bar, you can look at another part of a program.
3.5 Setting Software Breakpoints

Software breakpoints are one of simple debug facilities. The Editor window permits you to set software breakpoints easily. For example, you can set a software breakpoint at a place where the sort function is called.

Double-click a row in the S/W Breakpoints column corresponding to the source line that includes a sort function call.

![Editor window (setting a software breakpoint)](image)

The source line that includes the sort function will be marked with a red circle, indicating that a software breakpoint has been set there.
3.6 Executing the Program
The following describes how to run the program.

3.6.1 Resetting the CPU
To reset the CPU, choose Reset CPU from the Debug menu or click the Reset CPU button in the toolbar.

3.6.2 Executing the Program
To execute the program, choose Go from the Debug menu or click the Go button in the toolbar.
The program will be executed continuously until a breakpoint is reached. An arrow will be displayed in the S/W Breakpoints column to indicate the position at which the program has stopped.

```
23 long a[10];
24 long j;
25 int i;
26 struct Sample far *p_sam;
27 p_sam = malloc(sizeof(struct Sample));
28 init(p_sam);
29 for ( i=0; i<10; i++ ){
30     j = rand();
31     if (j < 0){
32         j = -j;
33     }
34     a[i] = j;
35 }
36 sort(a);
37 change(a);
38 p_sam->s0=a[0];
39 p_sam->s1=a[1];
40 p_sam->s2=a[2];
41 p_sam->s3=a[3];
42 p_sam->s4=a[4];
43 p_sam->s5=a[5];
44 p_sam->s6=a[6];
45 p_sam->s7=a[7];
46 p_sam->s8=a[8];
47 p_sam->s9=a[9];
48 free(p_sam);
49 p_sam = NULL;
```

Figure 3.5 Editor window (program at a break)
The Status window permits you to check the cause of the break that last occurred. Choose CPU → Status from the View menu or click the View Status toolbar button. When the Status window is displayed, open the Target sheet in it and check.

<table>
<thead>
<tr>
<th>Item</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCU status</td>
<td>Ready</td>
</tr>
<tr>
<td></td>
<td>PC: P8344</td>
</tr>
<tr>
<td>Violation of access protection</td>
<td>TaskID: -</td>
</tr>
<tr>
<td>Read from uninitialized memory</td>
<td>-</td>
</tr>
<tr>
<td>Stack access violation</td>
<td>-</td>
</tr>
<tr>
<td>Performance overflow</td>
<td>-</td>
</tr>
<tr>
<td>Realtime profile overflow</td>
<td>-</td>
</tr>
<tr>
<td>Trace memory overflow</td>
<td>-</td>
</tr>
<tr>
<td>Task stack access violation</td>
<td>-</td>
</tr>
<tr>
<td>OS dispatch</td>
<td>-</td>
</tr>
<tr>
<td>Run time count</td>
<td>00:00:00.001.396.700</td>
</tr>
<tr>
<td>Cause of last break</td>
<td>Software break</td>
</tr>
</tbody>
</table>

Figure 3.6 Status window

CAUTION
The contents displayed in this window differ with each product. For details about the displayed contents of each product, refer to Chapter 3, “Debugging,” or online help.

3.7 Checking Breakpoints

Use the Breakpoints dialog box to check all software breakpoints set.

3.7.1 Checking Breakpoints

Press the keys Ctrl + B on the keyboard of your PC. The Breakpoints dialog box shown below will be displayed.

Figure 3.7 Breakpoints dialog box

Use this dialog box to remove a breakpoint or enable or disable a breakpoint.
3.8 Altering Register Contents

Choose CPU -> Registers from the View menu or click the Registers toolbar button. The Register window shown below will be displayed.

![Register window](image)

Figure 3.8 Register window

The content of any register can be altered. Double-click the line for the register you want to alter. The dialog box shown below will be displayed, so enter a new value with which you want to alter the register.

![Set Value dialog box (PC)](image)

Figure 3.9 Set Value dialog box (PC)
3.9 Referencing Symbols

The Label window permits you to display the symbol information included in a module.

Choose Symbols -> Label from the View menu or click the Label toolbar button \( \text{Label} \). The Label window shown below will be displayed. Use this window to look at the symbol information included in a module.

![Label Window](image)

Figure 3.10 Label window
3.10 Checking Memory Contents

Specifying a label name, you can check in the Memory window the content of memory where the label is registered. For example, you can check the content of memory corresponding to _main in byte unit, as shown below.

Choose CPU → Memory from the View menu or click the Memory toolbar button to display the Display Address dialog box.

Enter “_main” in the edit box of the Display Address dialog box.

Click the OK button. The Memory window will be displayed, showing a specified memory area.
3.11 Referencing Variables

When single-stepping a program, you can see how the values of the variables used in the program will change as you step through source lines or instructions. For example, following the procedure described below, you can look at the long-type array ‘a’ that is declared at the beginning of a program.

Click the left-hand side of the array ‘a’ displayed in the Editor window and place the cursor there. Select Instant Watch with the right mouse button. The dialog box shown below will be displayed.

![Instant Watch dialog box](image)

Figure 3.13 Instant Watch dialog box

Click the Add button to add a variable to the Watch window.

![Watch window (array display)](image)

Figure 3.14 Watch window (array display)

Or you can specify a variable name to add a variable to the Watch window. Click the right mouse button in the Watch window and choose Add Watch from the pop-up menu. The dialog box shown below will be displayed.

![Add Watch dialog box](image)

Figure 3.15 Add Watch dialog box
Enter a variable ‘i’ in the Variable or Expression edit box and click the OK button.
An int-type variable ‘i’ will be displayed in the Watch window.

![Watch window (showing a variable)](image)

Figure 3.16 Watch window (showing a variable)

Clicking the “+” mark shown to the left of the array ‘a’ in the Watch window, you can look at each element of the array ‘a.’

![Watch window (showing array elements)](image)

Figure 3.17 Watch window (showing array elements)
3.12 Showing Local Variables

Using the Locals window you can display the local variables included in a function. As an example, let’s check the local variables of the tutorial function. This function declares four local variables ‘a,’ ‘j,’ ‘i’ and ‘p_sam.’

Choose Symbols -> Locals from the View menu or click the Locals toolbar button to display the Locals window.

The Locals window shows the local variables and the values of the function indicated by the current program counter (PC). If no variables exist in the function, no information is displayed in the Locals window.

![Locals Window](image)

Click the “+” mark shown to the left of the array ‘a’ in the Locals window to display the elements comprising the array ‘a’.

Look at the elements of the array ‘a’ before and after the sort function is executed to confirm that random data is sorted in descending order.

3.13 Single-Stepping a Program

The High-performance Embedded Workshop provides various step commands that will prove useful in debugging a program.

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Step In</td>
<td>Executes a program one statement at a time (including statements in a function).</td>
</tr>
<tr>
<td>2</td>
<td>Step Over</td>
<td>Executes a program one statement at a time by stepping over a function call if any.</td>
</tr>
<tr>
<td>3</td>
<td>Step Out</td>
<td>After exiting a function, stops at the next statement of a program that called the function.</td>
</tr>
<tr>
<td>4</td>
<td>Step...</td>
<td>Single-step a program a specified number of times at a specified speed.</td>
</tr>
</tbody>
</table>
3.13.1 Executing Step In Command

The Step In command ‘steps in’ a called function and stops at the first statement of the called function.

To enter the sort function, choose Step In from the Debug menu or click the Step In button in the toolbar.

Figure 3.19 Step In button

Figure 3.20 Editor window (Step In)

The highlighting in the Editor window moves to the first statement of the sort function.
3.13.2 Executing the Step Out Command

The Step Out command exits a called function by executing it quickly and stops at the next statement of a program from which the function was called.

To exit the sort function, choose Step Out from the Debug menu or click the Step Out button in the toolbar.

![Figure 3.21 Step Out button](image)

The data of the variable ‘a’ displayed in the Watch window will be sorted in ascending order.

![Figure 3.22 Editor window (Step Out)](image)
3.13.3 Executing the Step Over Command

The Step Over command executes the whole of a function call as one step and then stops at the next statement of the main program.

To execute all statements in the change function at a time, choose Step Over from the Debug menu or click the Step Over button in the toolbar.

![Figure 3.23 Step Over button](image)

![Figure 3.24 Editor window (Step Over)](image)

The data of the variable ‘a’ displayed in the Watch window will be sorted in descending order.
3.14 Forcibly Breaking a Program

The High-performance Embedded Workshop permits you to forcibly break a program.

Clear all breakpoints.

To execute the rest of the tutorial function, choose Go from the Debug menu or click the Go button in the toolbar.

![Go button](image)

Figure 3.25 Go button

Since the program is executing an infinite loop process, choose Stop Program from the Debug menu or click the Stop button in the toolbar.

![Stop button](image)

Figure 3.26 Stop button
3.15 Hardware Break Facility

Hardware breaks cause the program to stop when it executes a specified address (instruction fetch) or reads or writes to a specified memory location (data access).

3.15.1 Stopping a Program when It Executes a Specified Address

The Editor window permits you to set an instruction fetch event easily. For example, you can set an instruction fetch event at a place where the sort function is called.

Double-click a row in the Event column corresponding to the source line that includes a sort function call.

![Figure 3.27 Editor window (setting a hardware breakpoint)](image)

The source line that includes the sort function will be marked with **H**, indicating that a hardware breakpoint that will cause a program to stop when it fetches an instruction has been set there.
3.16 Stopping a Program when It Accesses Memory
To stop a program when it reads or writes a value to a global variable, set up a hardware break as described below.
Choose Event -> Hardware Break from the View menu to display the Hardware Break dialog box.
Open the OR page of the Hardware Break dialog box. In the Editor window, select a global variable that you want to be the object of a hardware break so that a program is made to stop when it reads or writes a value to the variable, and drag-and-drop the selected variable into the OR page.
Then click the Apply button.
When you run a program, it will stop running when a value is read or written to the global variable you have set.

![Hardware Break dialog box](image)

**Figure 3.28 Hardware Break dialog box**

Notes:
1. Only the global variables that are 1 byte or 2 bytes in size can be set.
2. Local variables cannot be set.
3.17 Trace Facility

The trace facility of the E100 emulator has a special memory known as “trace memory” that can hold an execution record of up to 4M bus cycles, which is always updated during program execution. The content of trace memory is displayed in the Trace window.

Choose Code → Trace from the View menu or click the Trace toolbar button \[ \text{button} \].

The Trace window shown below will be displayed.

![Figure 3.29 Trace window](image)

The following outlines the trace facility and describes how to set.
3.17.1 Showing the Trace Information Acquired by Fill Until Stop

The free trace facility acquires trace information successively from when the user program starts running till when it breaks.

(1) Clear all break conditions. Click the right mouse button anywhere in the Trace window and choose Acquisition from the pop-up menu that is displayed. The Trace conditions dialog box shown below will be displayed. Check to see that the selected trace mode is Fill until stop. Click the Close button.

![Trace conditions dialog box (free trace)](image)

Figure 3.30 Trace conditions dialog box (free trace)

(2) Set a software break in a line of the tutorial function where `p_sam->s0=a[0];` is written.
(3) Choose Reset Go from the Debug menu. Processing will be halted by a break, and the trace information from start to break will be displayed in the Trace window.

Figure 3.31 Trace window (free trace)

(4) A mixed display of bus, disassemble and/or source display is possible. Choosing Display Mode → DIS from the pop-up menu, you can display trace information in a bus and disassemble mixed mode.

Figure 3.32 Trace window (bus and disassemble mixed display)
(5) Furthermore, choosing Display Mode \(\rightarrow\) SRC from the pop-up menu, you can display trace information in a bus, disassemble and source mixed mode.

![Trace window (bus, disassemble and source mixed display)](image_url)

Figure 3.33 Trace window (bus, disassemble and source mixed display)
3.17.2 Showing the Trace Information Acquired by Fill around TP

The point & delay facility stops acquiring trace information a specified number of cycles after a trace point is encountered. This facility allows you to keep track of program flow from trace information without having to break the user program.

1) If any break conditions are set, clear all of them.

2) Choose Fill around TP for trace mode in the Trace conditions dialog box. In the Delay Value (Cycles) column, specify 4M. (Up to 4M cycles of trace information from where a trace point is encountered will be acquired.)

![Trace conditions dialog box (Fill around TP)](image)

Figure 3.34 Trace conditions dialog box (Fill around TP)
(3) Next, set a trace point at which the debugger starts acquiring trace information. Open the OR page of the Trace conditions dialog box. Select the main function in the Editor window and drag-and-drop it into the OR page. Click the Apply button and then the Close button.

Thus, the debugger will start acquiring trace information from when the main function is executed.

Figure 3.35 Trace conditions dialog box (OR page)

(4) Choose Reset Go from the Debug menu. A short time after a trace point is reached, the trace content shown below will be displayed in the Trace window.

Figure 3.36 Trace window (Fill around TP)
3.17.3 Showing a Function Execution History

A function execution history can be displayed from the acquired trace information.

1. Clear all break conditions. Click the right mouse button anywhere in the Trace window and choose Acquisition from the pop-up menu that is displayed. The Trace conditions dialog box will be displayed. Switch the trace mode to Fill until stop and click the Apply button. Then click the Close button.

2. Set a software break in a line of the tutorial function where `p_sam->s0=a[0];` is written.

3. Choose Reset Go from the Debug menu. Processing will be halted by a break, and the trace information from start to break will be displayed in the Trace window.

4. Click the right mouse button anywhere in the Trace window and choose Function Execution History -> Function Execution History from the pop-up menu that is displayed.

Figure 3.37 Trace window (function execution history–before analysis)
(5) Click the right mouse button anywhere in the displayed function execution history window and choose Analyze Execution History from the pop-up menu. A function execution history will be displayed in the upper pane of the Trace window.

![Figure 3.38 Trace window (function execution history –after analysis)](image)

(6) Double-click any function in the displayed function execution history, and the trace information corresponding to that function will be displayed in the lower pane of the Trace window.

![Figure 3.39 Trace window (function execution history)](image)
3.17.4 Filter Facility

Use the filter facility to extract only the necessary cycles from the acquired trace information. The filter facility does this by filtering the trace information in software that was acquired by hardware. Unlike the “Capture/Do not Capture conditions” where you set acquisition conditions before getting trace information, this facility allows you to change filter settings for the acquired trace information any number of times without having to reexecute. Therefore, the necessary information can be extracted easily.

1. Clear all break conditions. Click the right mouse button anywhere in the Trace window and choose Acquisition from the pop-up menu that is displayed. The Trace conditions dialog box will be displayed. Check to see that the selected trace mode is Fill until stop. Click the Close button.

2. Set a software break in a line of the tutorial function where p-sam->s0=a[0]; is written.

3. Choose Reset Go from the Debug menu. Processing will be halted by a break, and the trace information from start to break will be displayed in the Trace window.

4. Choose Auto Filter from the pop-up menu of the Trace window. The columns for which filtering can be applied will be marked by a \( \checkmark \) button.

![Figure 3.40 Trace window (Auto Filter)](image-url)
(5) Click the button in the R/W column and choose R from the pop-up menu.

Figure 3.41 Trace window (Auto Filter)

(6) That way, the trace information for only R in the R/W column can be displayed.

Figure 3.42 Trace window (Auto Filter)

Notes:
(1) The filter function does not affect the trace memory, so that its content remains intact.
(2) The filter can be used when the selected trace mode is Fill until stop, Fill until full or Fill around TP.
3.18 Stack Trace Facility

Using stack information, it is possible to show which function is the caller to the function where the current PC exists.

Set a software breakpoint in any line of the sort function by double-clicking at its corresponding row in the S/W Breakpoints column.

```c
sort(long *a)
{
    long t,
    int l, k, gap;
    gap = 5;
    while( gap > 0 ){
        for( k=0; k<gap; k++)
        {
            for( i=k+gap; i<10; i=i+gap )
            {
                for( j=i-gap; j>k; j=j-gap)
                {
                    if(a[j]>a[j+gap])
                    {
                        t = a[j];
                        a[j] = a[j+gap];
                        a[j+gap] = t;
                    }
                    else
                        break;
                }
            }
            gap = gap/2;
        }
        g_CharBuf = (char)g_IntBuf & Ox0FFF;
    }
    change(long *a)
    {
        long tmp[10];
        int i;
        for(i=0; i<10; i++)
        {
            tmp[i] = a[i];
        }
        for(i=0; i<10; i++)
        {
            a[i] = tmp[9-i];
        }
    }
}
```

Figure 3.43 Editor window (setting a software breakpoint)

Choose Reset Go from the Debug menu.
After a break, choose Code -> Stack Trace from the View menu to open the Stack Trace window.

![Stack Trace Window](image)

Figure 3.44 Stack Trace window

You will see that the current PC exists within the sort() function, and that the sort() function is called from the tutorial() function.

Clear the software breakpoint that you have set in a line of the sort function by double-clicking at its corresponding row in the S/W Breakpoints column again.

### 3.19 What Next?

In this tutorial, we have introduced to you several features of the E100 emulator and how to use the High-performance Embedded Workshop.

The emulation facility that the E100 emulator provides allows you to perform advanced debugging. Once the conditions that cause hardware or software problems to occur are exactly separated and identified by that debugging, you can examine those problems effectively.
4. Preparing to Debug

4.1 Starting the High-performance Embedded Workshop

Follow the procedure described below to start the High-performance Embedded Workshop.

(1) Connect the host machine and the E100 Emulator and user system. Then turn on the power to the E100 Emulator and user system.

(2) From Programs on the Start menu, choose Renesas -> High-performance Embedded Workshop -> High-performance Embedded Workshop.

The Welcome! dialog box shown below will appear.

![Welcome! dialog box](image)

Select a startup method from the following.

- Create a new project workspace
- Open a recently used project workspace
  Select this option when you use an existing workspace.
  A history of the workspace you open will be displayed.
- Browse another project workspace
  Select this option when you use an existing workspace.
  This is the option available to choose when the workspace you opened has no history recorded.
4.2 Creating a New Workspace (Toolchain Unused)
The procedure for creating a new project workspace differs depending on whether you use a toolchain or not.
The E100 Emulator has no toolchains included in it. You can use a toolchain in an environment in which the C/C++ compiler package is installed.
Follow the procedure described below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click the OK button.

Figure 4.2 Welcome! dialog box

(2) Project Generator will start.

Figure 4.3 New Project Workspace dialog box

<table>
<thead>
<tr>
<th>Workspace Name:</th>
<th>Enter a workspace name here.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name:</td>
<td>Enter a project name here. If the same name as a workspace name is good, you do not need to enter it.</td>
</tr>
<tr>
<td>Directory:</td>
<td>Enter a directory in which you want a workspace to be created. Or you can click the Browse button and select a workspace directory from the ensuing list.</td>
</tr>
<tr>
<td>CPU family:</td>
<td>Select the CPU family of the MCU you are using.</td>
</tr>
</tbody>
</table>
The other list boxes are used for setting up a toolchain. If no toolchains are installed, the information specific to the CPU family is displayed here. Click the OK button.

(3) Select the debugger target.

![Setting the Target System for Debugging dialog box](image)

Select the target platform you use by placing a check mark in its check box and click the Next button.

(4) Set a configuration name. Configuration refers to the file in which the High-performance Embedded Workshop status other than the emulator is saved.

![Setting the Debugger Options dialog box](image)

If you have selected two or more target platforms, click the Next button and then set a configuration name for each target platform selected.
When you have finished setting configuration names, emulator-related settings are completed. Click the Finish button, and the Summary dialog box will be displayed. Clicking the OK button in it starts the High-performance Embedded Workshop.

(5) After starting the High-performance Embedded Workshop, connect the E100 Emulator.

### 4.3 Creating a New Workspace (Toolchain Used)

Follow the procedure described below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click the OK button.

![Figure 4.6 Welcome! dialog box](image)

(2) Project Generator will start.

![Figure 4.7 New Project Workspace dialog box](image)
Workspace Name: Enter a workspace name here.
Project Name: Enter a project name here. If the same name as a workspace name is good, you do not need to enter it.
Directory: Enter a directory in which you want a workspace to be created. Or you can click the Browse button and select a workspace directory from the ensuing list.
CPU family: Select the CPU family of the MCU you are using.
Toolchain: To use a toolchain, select the appropriate toolchain here. If you do not use, select None.

The other list boxes are used for setting up a toolchain. If no toolchains are installed, the information specific to the CPU family is displayed here. Click the OK button.

(3) Set the CPU and options for the toolchain and make other necessary settings.

(4) Select the debugger target.

![Figure 4.8 Setting the Target System for Debugging dialog box](image)

Select the target platform you use by placing a check mark in its check box and click the Next button.
(5) Set a configuration name.

![Setting the Debugger Options dialog box](image)

Figure 4.9 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click the Next button and then set a configuration name for each target platform selected. When you have finished setting configuration names, emulator-related settings are completed. Click the Finish button, and the Summary dialog box will be displayed. Clicking the OK button in it starts the High-performance Embedded Workshop.

(6) After starting the High-performance Embedded Workshop, connect the E100 Emulator.
4.4 Opening an Existing Workspace

Follow the procedure described below to open an existing workspace.

(1) In the Welcome! dialog box, select the radio button titled “Browse to another project workspace” and click the OK button.

![Welcome! dialog box](image)

Figure 4.10 Welcome! dialog box

(2) The Open Workspace dialog box shown below will appear.

![Open Workspace dialog box](image)

Figure 4.11 Open Workspace dialog box

Specify the directory in which workspaces are created, select a workspace file (extension “.hws”) and click the Select button.

(3) The High-performance Embedded Workshop will start, and the state of the selected workspace in which it was saved will be restored. If the saved state of the selected workspace is one in which it was connected to the emulator, the workspace is automatically connected to the emulator. If the saved state of the selected workspace is one in which it was not connected to the emulator and you want to connect it, refer to “4.5.1 Connecting the Emulator”.

4.5 Connecting the Emulator

4.5.1 Connecting the Emulator
There are following methods for connecting the emulator.

(1) Setting up the emulator at startup before connecting
Choose Debug Settings from the Debug menu to open the Debug Settings dialog box. In this dialog box, you can register download modules and the command chain to be automatically executed. When you are finished filling in the Debug Settings dialog box, the emulator will be connected.

(2) Loading a session file
Switching to the session file that has emulator usage settings preregistered in it helps you connect the emulator easily.

4.5.2 Reconnecting the Emulator
While the emulator is disconnected, you can reconnect it following one of the procedures described below.

(1) Choose Connect from the Debug menu.

(2) Click the Connect tool button "Connect".

(3) Enter the connect command in the Command Line window.
4.6 Disconnecting the Emulator

4.6.1 Disconnecting the Emulator
To disconnect the emulator while it is active, follow one of the procedures described below.

(1) Choose Disconnect from the Debug menu.

(2) Click the Disconnect tool button [ ].

(3) Enter the disconnect command in the Command Line window.

4.7 Quitting the High-performance Embedded Workshop
Choosing Exit from the File menu lets you close the High-performance Embedded Workshop itself.
Before it closes, a message box will be displayed asking you whether you want to save the session. To save the session, click the Yes button.
4.8 Setting Up the Debug
Register download modules, set up automatic execution of command line batch files and set download options, etc.

4.8.1 Specifying a Download Module
Choose Debug Settings from the Debug menu to open the Debug Settings dialog box.

![Debug Settings dialog box](image)

In the Target drop-down list box, select the product name you want to connect.
In the Default debug format drop-down list box, select the format of the load module you want to download. Then register the load module corresponding to the selected format in the Download modules list box.

**CAUTION**
At this point in time, no programs are downloaded yet.
For details on how to download, refer to “5.2.1 Downloading a Program”.
4.8.2 Setting Up Automatic Execution of Command Line Batch Files
Click the Options tab of the dialog box.

![Debug Settings dialog box](image)

Here, register a command chain that is automatically executed with specified timing.
Select your desired timing from the following four choices:

- When the emulator is connected
- Immediately before download
- Immediately after download
- Immediately after reset

In the Command batch file load timing drop-down list box, select the timing with which you want a command chain to be executed.
## 5. Debugging Functions

The E100 emulator supports the functions listed in the table below.

### Table 5.1 List of Debug Functions

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>4,096 points</td>
</tr>
<tr>
<td>1</td>
<td>Software break number of event points</td>
<td>Maximum number of effective points: 16</td>
</tr>
<tr>
<td></td>
<td>Event</td>
<td>Executed address detection</td>
</tr>
<tr>
<td></td>
<td>Content of event</td>
<td>Data access detection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Interrupt generation/exit detection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>External trigger detection</td>
</tr>
<tr>
<td></td>
<td>Task ID</td>
<td>Can be set separately for each event</td>
</tr>
<tr>
<td></td>
<td>Number of times an event occurred</td>
<td>Maximum 255 times</td>
</tr>
<tr>
<td>2</td>
<td>Event</td>
<td>Violation of access protection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Read from uninitialized memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stack access violation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Performance overflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Realtime profile overflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Trace memory overflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task stack access violation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS dispatch</td>
</tr>
<tr>
<td>3</td>
<td>Exception detection</td>
<td>OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and state transition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See item No. 3</td>
</tr>
<tr>
<td></td>
<td>Event combination</td>
<td>OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and state transition</td>
</tr>
<tr>
<td></td>
<td>Trace size</td>
<td>Maximum 4M cycles</td>
</tr>
<tr>
<td></td>
<td>Trace mode</td>
<td>Fill until stop</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continues collecting until program stops running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fill until full</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops collecting traces when trace memory is full</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fill around TP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops collecting traces after retarded for delay cycles from when trace point is reached</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Repeat fill until stop</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Collects a total of 512 cycles before and after trace point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Repeat fill until full</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Collects a total of 512 cycles before and after trace point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and state transition</td>
</tr>
<tr>
<td></td>
<td>Trace point</td>
<td>See item No. 3</td>
</tr>
<tr>
<td></td>
<td>Event combination</td>
<td>OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and state transition</td>
</tr>
<tr>
<td></td>
<td>Exception detection</td>
<td>OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and state transition</td>
</tr>
<tr>
<td></td>
<td>Delay</td>
<td>Maximum 65,535 bus cycles</td>
</tr>
<tr>
<td></td>
<td>Trace Capture/Do not Capture</td>
<td>Capture/Do not Capture by event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Between two events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Duration of an event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Duration of an event occurring in a subroutine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data access instruction extraction</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Performance</td>
<td>Measures maximum, minimum and average execution time in up to 8 sections and pass counts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Timeout detection</td>
</tr>
<tr>
<td></td>
<td>Resolution</td>
<td>10 ns to 1.6µs</td>
</tr>
<tr>
<td></td>
<td>Measurement mode</td>
<td>Between two events, Event period and Interrupt-disabled range between two events</td>
</tr>
<tr>
<td></td>
<td>Event combination</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C0 level code coverage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>256 Kbytes × 8 blocks (2-Mbyte space)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C0+C1 level code coverage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>128 Kbytes × 8 blocks (1-Mbyte space)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Address range and source file specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data coverage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 Kbytes × 8 blocks (512-Kbyte space)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Address range, section specification and task stack</td>
</tr>
</tbody>
</table>
5.1 Setting Up the Emulation Environment
When the emulator is connected, the Device setting and the Configuration properties dialog boxes are displayed. Here, select the general options associated with the emulator. Note that the target MCU to be debugged, etc. can be set only once at startup.

5.1.1 Setting Up the Emulator at Startup
When the emulator starts, the following three dialog boxes are displayed.

(1) Device setting dialog box
Use this dialog box to select the target MCU and establish communication.
This dialog box can be redisplayed by selecting Emulator -> Device setting from the Setup menu after starting the emulator. In this case, however, be aware that changes of the settings after starting the emulator are not reflected immediately and will be set as the initial value when reconnecting the emulator.

(2) Configuration properties dialog box
This dialog box is displayed after the Device setting dialog box. Use this dialog box to make settings related to the emulator and debug functions.
This dialog box can be re-opened by selecting Emulator -> System from the Setup menu after the emulator has been booted up. Some options in this dialog box can have their settings changed after startup. The changeable options are displayed as in active use, while the unchangeable options are inactive (grayed out), with their set contents only displayed.

(3) Connecting dialog box
This dialog box shows the progress of boot-up processing.
5.1.2 Setting Up the Target MCU

(1) Selecting the target MCU

On the Device page of the Device setting dialog box, specify the target MCU to be emulated. For details, refer to the hardware manual supplied with each product.

![Device setting dialog box (Device page)](image)

The target MCU you have set here cannot be changed after the emulator is connected. To change the target MCU, you need to disconnect the emulator and connect it again.

(2) Selecting an operation mode

The operation mode is fixed to the following option:

Single-Chip mode

**CAUTION**

Options are different depending on the target MCU that you select.

(3) Using PM10 (b0 of 0x000005) as set to 1

To expand the internal reserved area, specify the PM10 (zeroth bit of processor mode register 1) setting. When using the user program with PM10 set to 1, select this check box.

(4) Using E2FCON07 (b7 of 0x000090) as set to 1

To enable or disable ECC for E2 data flash, specify the E2FCON07 (seventh bit of E2FLASH register) setting. When using the user program with E2FCON07 set to 1, select this check box.
(5) Setting up communication

You can select another target emulator connected via USB.
The ‘USB Serial No.’ list box shows unique identity information on the emulator connected via USB. Clicking on the Refresh button updates the information.

(6) Performing self-checking

If you click on the OK button with the ‘Start booting up on successful completion of self-checking.’ checkbox selected, hardware self-checking proceeds after connection to the emulator has been made according to the communication condition you have set.
The results are shown on completion of self-checking.
If the results are normal, boot-up processing continues. If an error is found, boot-up processing stops.
5.1.3 Setting Up the System

On the System page of the Configuration Properties dialog box, set up the entire emulator system. This dialog box is displayed following the Device setting dialog box at startup. Although this dialog box can be redisplayed after startup, you cannot change some settings in it. These settings can only be changed at startup.

![Configuration properties dialog box (System page)](image)

Figure 5.2 Configuration properties dialog box (System page)

(1) Selecting the operating clock

In the Clock section on the System page, select the clocking sources supplied to the main clock and sub-clock. The main clock can be selected from three choices: Emulator, User and Generate. (By default, Emulator is selected.)

Select Emulator when the main clock is supplied from an internal source or User when the main clock is supplied from an external source. To use a user-defined clock, select Generate and set the clock frequency to be used in the frequency input text box. The clock frequency can be set in the range 1.0 to 99.9 MHz in 0.1 MHz increments. The clock frequency for Generate can be set only once at startup.

Selection of the sub-clock is displayed only when sub-clocks are supported. It can be selected from Emulator or User. (By default, Emulator is selected.)

**CAUTION**

The frequency accuracy for Generate is ±5%. Please make sure that final evaluation is performed using a resonator or oscillator module of the frequency used for the actual target board that is mounted on-board.
(2) Selecting the direction of external trigger cable

For External trigger cable, select whether EXT pins 16–31 are directed for input or output. EXT pins 0–15 are fixed for input.
Select this option from the following:

- EXT 0–31 INPUT (default)
- EXT 0–15 INPUT, EXT 16–31 directed for OUTPUT

(3) Selecting a trigger input level

For Trigger input level, select CMOS level or TTL level. Select this option from the following:

- EXT 0–31 chosen to be CMOS (default)
- EXT 0–15 chosen to be TTL, EXT 16–31 chosen to be CMOS

(4) Selecting a switching function

The code coverage, data coverage and realtime profile functions cannot be used at the same time. Select one function from them.
Initially, code coverage is selected.
The setting of this option can be changed even after startup.
When the code coverage function is selected, measurements are performed at the coverage level selected in Code coverage mode.

(5) Selecting a code coverage mode

Select a code coverage mode.
C0: Instruction coverage rate
C0 + C1: Instruction coverage rate + Branch coverage rate
You can measure up to 2 Mbytes when using the C0 level coverage, and up to 1 Mbytes when using the C0 + C1 level coverage
The initial value is C0 coverage.
The setting of this option is reflected at only startup.
This option is available only when the Code coverage is selected in Switching function.
If you use the code coverage function, select the mode in this option at startup.

(6) Debugging the program using the CPU Rewrite Mode

Select whether you want to debug the program using the CPU Rewrite Mode.

(7) Masking the terminal RESET

Select whether you want the input signal to the RESET pin of the target system to be masked.

(8) Stopping all timer counts while the user program is halted

Select whether you want to stop all timer counts while the user program is halted.

CAUTION

The option “Stops all timer counts, while the user program has halted.” is inactive (grayed out) with M16C/64 Group, M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x Series MCUs.
5.1.4 Setting Up Flash ROM Overwrite

On the Internal flash memory overwrite page of the Configuration properties dialog box, set up the overwriting of flash ROM blocks, block by block.

Figure 5.3 Configuration properties dialog box (Internal flash memory overwrite page)

Block-by-block settings matched to the selected target MCU are automatically displayed in the list. The blocks selected by placing a check mark in the respective check boxes are overwritten (merged), without being erased, when a program is downloaded.
5.1.5 Setting the Warning of Exceptional Events

On the Exception Warning page of the Configuration properties dialog box, set whether or not to display warnings of exceptional events in the Status window and status bar balloon.

The ‘Violation of access protection’, ‘Read from uninitialized memory’ and ‘Stack access violation’ checkboxes are initially selected.

When a load module including OS has been downloaded, the ‘Task stack access violation’ checkbox is also initially selected. Other items are not selected.

If you deselect a checkbox, this item will be shown as ‘-’ in the Status window.
5.1.6 Showing Progress in Boot-up Processing

You can confirm the progress of boot-up processing by checking the Connecting dialog box. The Connecting dialog box continues displaying progress information from when boot-up processing starts till when it ends. While the Device setting and the Configuration properties dialog boxes are displayed, you cannot manipulate this dialog box.

![Connecting dialog box](image)

Figure 5.5 Connecting dialog box

(1) Showing the history of processing
The history display area on the left-hand side of the dialog box shows the history of completed processing. The contents shown here are recorded in a trouble report. To check the content of a trouble report, select Technical Support -> Create Bug Report from the Help menu.

(2) Showing the pin states
The pin states are displayed after the completion of the emulator’s startup process. If the contents set in the Device setting dialog box and the pin states shown here do not match, a warning message is displayed in the history display area.

(3) Showing the clocks
The clocks are displayed after the completion of the emulator’s startup process. Only the actually operating clocks are displayed here.
(4) Showing progress with progress bars

The upper progress bar shows the progress of the entire boot-up processing. The lower progress bar shows the progress of each individual processing. The content of the currently executed processing is displayed below the bar.

(5) Aborting a connection

Clicking the Cancel button aborts boot-up processing.
5.2 Downloading a Program

5.2.1 Downloading a Program
Download the load module to be debugged.

To download a program, choose Download from the Debug menu and select your desired load module from the ensuing list, or right-click a load module in Download modules of the Workspace window and then choose Download from the pop-up or pop-up menu.

CAUTION
Before a program can be downloaded, you must have it registered as a load module in the High-performance Embedded Workshop. For details on how to register, refer to “4.8 Setting Up the Debug”.

5.2.2 Showing the Source Code
Follow the procedure described below to show the source code.

- Double-click a source file in the Workspace window.
- Right-click in the source file and choose Open from the pop-up menu.

![Editor window](image)

Figure 5.6 Editor window

Shown at left edge of this window are the line information consisting of the following:
(1) Line column
Shows the line numbers corresponding to lines in the source file.

(2) Source Address column
When a program is downloaded, this column shows the addresses corresponding to lines in the current source file. This function will prove convenient when you determine where you want the PC value or breakpoint to be set.

(3) Event column
This column shows the following:

Table 5.2 Event column list

<table>
<thead>
<tr>
<th></th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Hardware breakpoint]</td>
<td>Hardware breakpoint is set</td>
</tr>
<tr>
<td>![Trace point (fetch condition)]</td>
<td>Trace point (fetch condition) is set</td>
</tr>
</tbody>
</table>

A hardware breakpoint can be inserted by double-clicking in the event column. Trace points are displayed when fetch conditions are set.

[*] after the title on the title bar of the dialog boxes of Hardware break, Trace conditions or Performance Analysis Conditions shows that some setting is under editing. If you are doing some editing work, you cannot change the settings from the event column of the Editor window.

(4) Code Coverage column
Shows C0 code coverage information graphically.

(5) S/W Breakpoints column
This column shows the following:

Table 5.3 Software breakpoint column list

<table>
<thead>
<tr>
<th></th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Bookmark]</td>
<td>Bookmark is set</td>
</tr>
<tr>
<td>![Software break]</td>
<td>Software break is set</td>
</tr>
<tr>
<td>![PC position]</td>
<td>PC position</td>
</tr>
</tbody>
</table>
5.2.3 Turning columns in all source files off

1. Right-click in the Editor window and choose Define Column Format from the pop-up menu.

2. The Global Editor Column States dialog box will be displayed.

Figure 5.7 Global Editor Column States dialog box

3. Deselect the check box of the column you want to turn off. Click the OK button, and the new column settings you have set will take effect.

5.2.4 Turning columns in one source file off

1. Right-click in the Editor window and choose Columns from the pop-up menu.

2. Cascaded menu items will be displayed. The currently enabled columns have a check mark attached to the left of the respective names.

Figure 5.8 Pop-up menu window

3. Clicking a column name lets you enable or disable the column alternately.
5.2.5 Showing Assembly Language Code

While a source file is open, click the right mouse button in the Editor window and choose View Disassembly from the pop-up menu. The Disassembly window will be displayed.

The display start address in the Disassembly window is the one that corresponds to the cursor position in the Editor window.

You also can use the Disassembly View button in the Editor window to display disassembled codes.

If no source files exist, one of the following methods may be used to display disassembled codes:

- Click the Disassembly toolbar button 🔄.
- Choose Disassembly from the View menu.
- Use the “Ctrl + D” accelerator.

In this case, the Disassembly window opens at the current PC position.

Mixed mode display where all source lines are displayed beginning with that address is also supported as an option. To display disassembled codes in mixed mode, click the Show in Mixed Mode button.

![Disassembly window](image)

Figure 5.9 Disassembly window

Shown at left edge of this window are the line information consisting of the following:

1. Event column

This column shows the following:

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hardware breakpoint" /></td>
<td>Hardware breakpoint is set.</td>
</tr>
<tr>
<td><img src="image" alt="Trace point" /></td>
<td>Trace point (fetch condition) is set.</td>
</tr>
</tbody>
</table>

A hardware breakpoint can be inserted by double-clicking in the event column.

Trace points are displayed when fetch conditions are set.
(2) S/W Breakpoints - ASM column

This column shows the following:

Table 5.5 Software breakpoint – ASM column list

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>●</td>
<td>Software break is set.</td>
</tr>
<tr>
<td>▶</td>
<td>PC position</td>
</tr>
</tbody>
</table>

(3) Disassembly Address column

Shows disassembly addresses. Double-clicking here brings up an Address Specification dialog box. In this dialog box, enter the address from which you want a disassembly display to start.

(4) Obj code column

Shows object codes.

(5) Label

Shows a label. This column is unusable unless any module is downloaded.

5.2.6 Correcting Assembly Language Codes

Double-click an instruction you want to correct in the Disassembly window or choose Edit from the pop-up menu, and a dialog box labeled “Assemble” will be displayed. Use this dialog box to correct assembly language.

![Assembler dialog box](Image)

Figure 5.10 Assembler dialog box

The dialog box shows the address, instruction code and mnemonic of a selected instruction. Enter a new instruction (or edit the old instruction) in the Mnemonic edit box. When done, hit the Enter key. The memory content will be overwritten with the new instruction code, and the pointer is moved to the next instruction. Clicking the OK button overwrites the memory content with the new instruction code and closes the dialog box.

CAUTION

Assembly language codes are displayed from the current memory content. When you correct memory contents, new assembly language codes are displayed in the Disassembly window and the Assembler dialog box. However, the source file being displayed in the Editor window remains unchanged. The same applies when the source file includes assembler language.
5.3 Displaying Memory Contents in Real Time

5.3.1 Displaying Memory Contents in Real Time
To monitor memory contents while the user program is running, use the RAM Monitor window.
The RAM monitor function permits the memory content and access status in an allocated monitor area to be recorded and inspected in real time without obstructing execution of the user program.
The RAM Monitor window shows access statuses (read, write, non-initialized or uninspected) in different colors.

(1) Allocating a RAM monitor area

A 16-Kbyte RAM monitor area is provided.
This RAM monitor area can be allocated to selected contiguous addresses or divided 32 blocks in 512-byte units.
With initial settings, a maximum 16 Kbytes of area from the beginning address of the internal RAM is allocated as a RAM monitor area.

(2) Monitor display

The access statuses are displayed in different background colors depending on access attributes, as listed below. (The background colors are customizable.)
The read and write accesses show the last accesses made.
Error detection can be displayed by choosing Show Error Detection from the pop-up menu. In this case, the read and write accesses are not displayed.

Table 5.6 Access attribute and background color

<table>
<thead>
<tr>
<th>Access attribute</th>
<th>Background color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Read access</td>
<td>Green</td>
</tr>
<tr>
<td>2 Write access</td>
<td>Red</td>
</tr>
<tr>
<td>3 When errors detected</td>
<td>Non-initialized memory (an area not written to has been read) Yellow</td>
</tr>
<tr>
<td>4 Uninspected memory (an initialized area has not been read) Sky blue</td>
<td></td>
</tr>
<tr>
<td>5 No access</td>
<td>White</td>
</tr>
</tbody>
</table>

CAUTION
The contents shown in the RAM Monitor window are the data acquired from bus accesses. Therefore, changes made by accessing memory via other than the user program, as when memory is rewritten directly from external I/O, are not reflected in the displayed memory content.
(3) Detecting reading from non-initialized areas

If a memory area that has not been written to is read, the emulator detects “reading from a non-initialized area” and outputs an error. To view errors of this type, choose Error Detection Display from the pop-up menu. Non-initialized memory areas are shown in yellow. This error detection can be an exceptional event used as a condition of a hardware breakpoint or trace point (also refer to “Detecting exceptional events”).

(4) Detecting uninspected areas

If an initialized memory area has not been read, the emulator detects “an uninspected area” and outputs an error. To view errors of this type, choose Error Detection Display from the pop-up menu. Uninspected memory areas are shown in sky blue.

5.3.2 Setting RAM Monitor Update Intervals

Choose Update Interval Setting from the pop-up menu of the RAM Monitor window. The Update Interval Setting dialog box shown below will appear.

![Update Interval Setting dialog box](image)

Figure 5.11 Update Interval Setting dialog box

The Update Interval can be specified separately for each window. The initial value is 100 ms.

5.3.3 Clearing RAM Monitor Access History

Choose Access Data Clear from the pop-up menu of the RAM Monitor window. The history of all accesses made to the RAM monitor area will be cleared.

CAUTION

If this function is executed while the user program is running, the user program’s realtime capability may be lost because a memory dump occurs.

5.3.4 Clearing RAM Monitor Error Detection Data

Choose Error Detection Data Clear from the pop-up menu of the RAM Monitor window. The detected data of all uninitialized memory and unreferred memory of the RAM monitor area will be cleared.
5.4  Showing the Current Status

5.4.1  Showing the Emulator Status

To know the current status of the emulator, display the Status window.

To open the Status window, choose CPU -> Status from the View menu, or click the View Status toolbar button [ ].

This window does not update the displayed status during program execution.

The Status window has the following four sheets.

Table 5.7 sheet list of status window

<table>
<thead>
<tr>
<th>Sheet name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Shows information relating to memory resources.</td>
</tr>
<tr>
<td>Platform</td>
<td>Shows information relating to the emulator and debugging.</td>
</tr>
<tr>
<td>Events</td>
<td>Shows information relating to events.</td>
</tr>
<tr>
<td>Target</td>
<td>Shows information relating to the target MCU.</td>
</tr>
</tbody>
</table>
5.4.2 Showing the Emulator Status in the Status Bar

The status of the emulator can be displayed in the status bar.

By right clicking on the status bar, the items are shown. Check the items you want to show in the status bar.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>PC value</td>
</tr>
<tr>
<td></td>
<td>During execution: PC value</td>
</tr>
<tr>
<td></td>
<td>During Break: Normal</td>
</tr>
<tr>
<td>Task ID</td>
<td>Task ID, task entry label</td>
</tr>
<tr>
<td>BreakCondition</td>
<td>Break factors of the user program</td>
</tr>
<tr>
<td>ExecutionTime</td>
<td>Result of time measurement</td>
</tr>
<tr>
<td>Exception</td>
<td>Status of the exceptional event</td>
</tr>
</tbody>
</table>

(1) When more than one break factors occur.

When you click on the status bar area where the break factor is shown, a balloon is shown.
You can check the break factors being occurred in the balloon.

(2) When an exceptional event occurs.

When an exceptional event occurs, a warning is displayed in a status bar balloon.
The exceptional event that is not checked on the Exception Warning page of the Configuration Properties dialog box is not shown.
5.5 Periodically Reading Out and Showing the Emulator Status

5.5.1 Periodically Reading Out and Showing the Emulator Information
To know the changing emulator information whether the user program is running or remains idle, use the Extended Monitor window.

The extended monitor function only monitors the signals output from the user system or MCU, and does not affect execution of the user program.

To open the Extended Monitor window, choose CPU -> Extended Monitor from the View menu, or click the Extended Monitor toolbar button.

The displayed items are updated at an interval of about 1,000 ms during user program execution or about 5,000 ms during a break.

CAUTION
(1) “CPU Clock” can be measured only when a user program is being executed.
(2) The display contents of the status differ depending on products

---

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User System Connection</td>
<td>DISCONNECT (Disconnected: CNN0, CNN1, CNN2)</td>
</tr>
<tr>
<td>User System Power Source</td>
<td>DISCONNECT (Vcc1:0.7 V, Vcc2:0.5 V)</td>
</tr>
<tr>
<td>User System RESET#</td>
<td>High</td>
</tr>
<tr>
<td>User System NMI#</td>
<td>High</td>
</tr>
<tr>
<td>User System CNVss</td>
<td>-</td>
</tr>
<tr>
<td>User System HCED#</td>
<td>High</td>
</tr>
<tr>
<td>User System DOT#</td>
<td>High</td>
</tr>
<tr>
<td>User System BYTE</td>
<td>-</td>
</tr>
<tr>
<td>CPU Clock</td>
<td>-</td>
</tr>
<tr>
<td>Main Clock (IIN)</td>
<td>Emulator 20.0 MHz</td>
</tr>
<tr>
<td>Sub Clock (XCN1)</td>
<td>Emulator 33.0 kHz</td>
</tr>
<tr>
<td>000000h Read Status</td>
<td>-</td>
</tr>
</tbody>
</table>

Figure 5.16 Extended Monitor window
5.5.2 Selecting the Items to Be Displayed
Choose Properties from the pop-up menu of the Extended Monitor window, and the Extended Monitor Configuration dialog box will be displayed.

![Extended Monitor Configuration dialog box](image)

Figure 5.17 Extended Monitor Configuration dialog box

This dialog box permits you to set each item you want to be displayed in the Extended Monitor window.
5.6 Using Software Breakpoints

5.6.1 Using Software Breakpoints
A software break causes the user program to stop running by rewriting the instruction code at a specified address with a BRK instruction to generate a BRK interrupt. In that sense, this is a pre-execution break function.
4096 breakpoints can be set.
If multiple software breakpoints are set, the program breaks at any one of those breakpoints reached.

(1) When stopped at a software breakpoint
When the program you have created is run and the address you have set as a software breakpoint is reached, a message “Software Break” is displayed on the Debug sheet of the Output window, with the program made to stop there. At this time, the Editor or the Disassembly window is updated, and the position at which the program has stopped is marked with an arrow [ ] in the S/W Breakpoints column.

CAUTION
When a break occurs, the program stops immediately before executing the line or instruction at which a software breakpoint is set. If Go or Step is selected after the program has stopped at that software breakpoint, the program restarts from the line marked with an arrow.
5.6.2 Adding/Removing Software Breakpoints

Follow one of the following methods to add or remove software breakpoints.

- From the Editor or the Disassembly window
- From the Breakpoints dialog box (only removing)
- From the command line

(1) From the Editor or the Disassembly window

1. Check to see that the Editor or the Disassembly window that is currently open includes the position at which you want to set a software breakpoint.

2. In the S/W Breakpoints column, double-click the line where you want the program to stop.

![Editor window](image)

Figure 5.18 Editor window

Or you use the method described below to set a breakpoint. Select Toggle Breakpoint from the pop-up menu or press the F9 key on the keyboard.

3. When a software breakpoint is set, a red circle [●] is displayed at the corresponding position in the S/W Breakpoints column of the Editor or the Disassembly window.

![Editor window](image)

Figure 5.19 Editor window

Double-clicking one more time removes the breakpoint.
5.6.3 Enabling/Disabling Software Breakpoints

Follow one of the following methods to enable or disable software breakpoints.

- From the Editor or the Disassembly window
- From the Breakpoints dialog box
- From the command line

1. From the Editor or the Disassembly window

   1. Place the cursor at the line where a software breakpoint exists and then select Enable/Disable Breakpoint from the pop-up menu. Or press the Ctrl and F9 keys together.

   ![Figure 5.20 Editor window and pop-up menu](image)

   2. The software breakpoint is enabled or disabled alternately.

   ![Figure 5.21 Editor window](image)
(2) From the Breakpoints dialog box

1. Select Source Breakpoints from the Edit menu to bring up the Breakpoints dialog box. In this dialog box, you can alternately enable or disable a currently set breakpoint, as well as remove it.

Figure 5.22 Breakpoints dialog box
5.7 Using Events

5.7.1 Using Events
An event refers to a combination of phenomena that occur during program execution.
The E100 emulator permits you to use the event you have set as a condition of the break, trace or performance function.
Events can be set at up to 16 points at the same time.
These 16 points can be located at any desired positions.
The events you have created can be registered for reuse at a later time.

(1) Types of events
There are following types of events.

Table 5.9 Event types list

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instruction fetch</td>
<td>An event is detected when an instruction at the specified address is executed by CPU. An event is detected not in the cycles prefetched by an instruction queue but in the cycles executed by the CPU.</td>
</tr>
<tr>
<td>Data access</td>
<td>An event is detected when a specified address or specified address range is accessed under a specified condition.</td>
</tr>
<tr>
<td>Interrupt</td>
<td>Detection is made of an interrupt generation and interrupt termination.</td>
</tr>
<tr>
<td>Trigger input</td>
<td>An event is detected when the signal fed in from external trigger signal input cable is in a specified state.</td>
</tr>
</tbody>
</table>

(2) Event combination
One of the following combinatorial conditions can be specified using two or more events in combination.

Table 5.10 Event combinations list

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Condition is met when any one of the specified events occurs.</td>
</tr>
<tr>
<td>AND (Accumulation)</td>
<td>Condition is met when all of the specified events occur irrespective of the time axis.</td>
</tr>
<tr>
<td>AND (Simultaneous)</td>
<td>Condition is met when all of the specified events occur at the same time.</td>
</tr>
<tr>
<td>Subroutine</td>
<td>Condition is met when a specified event occurs within a specified address range.</td>
</tr>
<tr>
<td>Sequential</td>
<td>Condition is met when a specified event occurs in a specified order.</td>
</tr>
<tr>
<td>State transitions</td>
<td>Condition is met when an event occurs under the condition specified in a state transition diagram.</td>
</tr>
</tbody>
</table>
5.7.2 Adding Events

Follow one of the following methods to add events.

- Create a new event
- Add by dragging and dropping from another window
- Add from the command line

(1) Creating a new event

[When creating an event from any setup dialog box]

1. Click the Add button or choose a line where you want to input and double-click.

![Hardware Break dialog box](image)

Figure 5.23 Hardware Break dialog box

2. The Event dialog box shown below will be displayed. In this dialog box, set detail event conditions and then click the OK button.

![Event dialog box](image)

Figure 5.24 Event dialog box
3. An event will be added at the specified position.

![Figure 5.25 Hardware Break dialog box](image)

**Figure 5.25 Hardware Break dialog box**

4. If events exceed 16 points when you created an event, an error is displayed. If you created an event exceeding 16 points, the event you have added has no effect.

[When adding an event from the Registered Events dialog box]

1. Click the Add button in the Registered Events dialog box.

![Figure 5.26 Registered Events dialog box](image)

**Figure 5.26 Registered Events dialog box**
2. The Event dialog box shown below will be displayed. In this dialog box, set detail event conditions. Enter a comment if any necessary. Then click the OK button.

![Event dialog box](image)

Figure 5.27 Event dialog box

3. An event will be added to the list of registered events.

![Registered Events dialog box](image)

Figure 5.28 Registered Events dialog box
(2) Adding an event from the event column of the Editor window

[When adding a hardware breakpoint]

1. Select the HW Break Point from the pop-up menu displayed by double-clicking or right clicking anywhere in the event column of the Editor window.

You can set a hardware breakpoint based on a fetch to that address as a condition. => Instruction fetch condition

2. If there is room for event counts, the event you have added from the Editor window is added to the other events as an OR condition. If there is no room, an error message is displayed.

CAUTION
If you are doing some editing work in the Hardware Break dialog box, you cannot set hardware breaks from the event column of the Editor window.
[When adding a trace point]

1. Select the Trace Point from the pop-up menu displayed by double-clicking or right clicking anywhere in the event column of the Editor window.
   You can set a trace point based on a fetch to that address as a condition. => Instruction fetch condition

   Double-click the instruction fetch event in the Event column of the Editor window to delete it.

CAUTION
No trace points can be set from the event column of the Editor window in the following cases.
- While editing the contents in the Trace conditions dialog box
- When selecting the Fill until stop or Fill until full of the trace mode

(3) Adding events by dragging and dropping

[When dragging and dropping the variable and function names in the Editor window]

1. Dragging and dropping a variable name into the Event column, you can set an event based on an access to that variable as a condition. => Data access condition
   At this time, the size of the variable is automatically set to be a condition of a data access event.
   Only global or static variables of 1 or 2 bytes in size can be registered as an event. Static variables in functions cannot be registered as an event.

2. Dragging and dropping a function name into the Event column, you can set an event based on an instruction fetch to the start address of that function as a condition.

![Figure 5.31 Editor window and Hardware Break dialog box](image)

[When dragging and dropping the address range in the Memory window]

Select memory content in the Memory window and drag and drop it into the Event column. That way, you can set a data access event based on the address range of the selected memory content as a condition. => Data access condition

[When dragging and dropping the label in the Label window]

You can set an event based on a fetch to that label as a condition. => Instruction fetch condition
5.7.3 Removing Events

Follow one of the following methods to remove events.

[When deleting an event from any setting dialog box]

1. To remove one point, select a line you want to remove in the event setting area and then click the Delete button (You can use the keys Ctrl + Del instead of clicking the Delete button).
   The selected event will be removed from the event setting area.

   ![Hardware Break dialog box](image1)

   Figure 5.32 Hardware Break dialog box

2. To remove multiple events, hold down the Shift or the Ctrl key while you select lines you want to remove in the event setting area and then click the Delete button (You can use the keys Ctrl + Del instead of clicking the Delete button).
   The selected events will be removed from the event setting area.

   ![Hardware Break dialog box](image2)

   Figure 5.33 Hardware Break dialog box
[When deleting an event from the Registered Events dialog box]

To remove one point, select a line you want to remove in the Registered Events dialog box and then click the Delete button (You can use the keys Ctrl + Del instead of clicking the Delete button).

The selected event will be removed from the list of registered events.

To delete all events, click the Delete All button.

![Registered Events dialog box]

Figure 5.34 Registered Events dialog box
5.7.4 Registering Events

“Registering an event” refers to placing an event into the list of registered events. A registered event can be reused at a later time. Follow one of the following methods to register an event. Up to 256 events can be registered.

(1) Registering events

[When creating an event from the Event dialog box]

1. Display the Comments page of the Event dialog box and select the “Add this event to the list” check box. Then click the OK button.

![Event dialog box](image1)

Figure 5.35 Event dialog box

2. An event is added at the specified position while at the same time registered in the Registered Events.

![Hardware Break dialog box and Registered Events dialog box](image2)

Figure 5.36 Hardware Break dialog box and Registered Events dialog box
[When registering an event by dragging and dropping]

The event you have created can be registered in the Registered Events by dragging and dropping it into the list.

![Hardware Break dialog box and Registered Events dialog box](image)

Figure 5.37 Hardware Break dialog box and Registered Events dialog box

[When registering an event from the Registered Events dialog box]

Click the Add button to create an event. The events you create here are added to the Registered Events.

![Registered Events dialog box](image)

Figure 5.38 Registered Events dialog box

(2) Attaching comments

Attach a comment to the registered event as necessary. Check the Registered Events dialog box to know the registered contents and comments.
5.7.5 Entering Events Each Time or Reusing Events

There are following two methods to set events in any function concerned.
One method is to create events in the respective setting dialog boxes each time.
The other method is to choose one condition you want to use from the registered event list and drag and drop it into the condition area in which you want to set the event.
The former method is referred to here as entering events each time, and the latter as reusing events.

[Entering events each time]

This is the condition used only once. The event you created is used “without ever being registered.”
After the event is used (i.e., changed or removed), its setting becomes nonexistent.
The events you create by only double-clicking in the Event column of the Editor window are the one that is entered each time.

[Reusing events]

Any event registered in the Registered Events dialog box can be reused by dragging and dropping it into the condition setting area of any function concerned.

Figure 5.39 Schematic of event reuse

(1) Dragging and dropping into multiple functions

One event in the Registered Events can be dragged and dropped into multiple functions.
If the content of an event is altered after being dragged and dropped, the alteration you made is not reflected on the registered event list side.

(2) Registering duplicates in the registered event list

Even the events that have the same contents set can be registered in the list overlapping one another.
5.7.6 Applying Events

To enable the setting of an event after you have created it, click the Apply button. The content of what you have set has no effect until you click the Apply button.

[*] after the title on the title bar of the dialog boxes of Hardware break, Trace conditions or Performance Analysis Conditions shows that some setting is under editing. If you are doing some editing work, you cannot change the settings from the event column of the Editor window or the command line.

![Hardware Break Window](image)

Figure 5.40 Applying the setting
5.8 Setting Hardware Break Conditions

5.8.1 Setting Hardware Break Conditions
A hardware break causes the user program to stop running a specified number of cycles after a set event or phenomenon is detected (i.e., a hardware breakpoint is encountered). Up to 16 events can be specified as hardware breakpoint conditions.

5.8.2 Setting Hardware Breakpoints

(1) Setting Hardware Breakpoints

For hardware breakpoints, you can set an OR condition, other condition (AND (Accumulation), AND (Simultaneous), subroutine, sequential or state transition) and detection of exceptional events.

The OR condition, other condition and the detection of exceptional events can be set all at the same time, or only one at a time.

![Outline of the hardware break](image)

Figure 5.41 Outline of the hardware break
(2) Setting OR conditions

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.
To disable the OR condition, deselect the check box to the left of “OR Condition.”
If you add an event by double-clicking in the Editor window while the OR condition is disabled, the OR condition is automatically enabled.
If you reenable the OR condition when it is disabled, the previously set event is restored with its OR condition check box selected.
However, if a maximum of 16 events is exceeded when you have reenabled for an event, the event is restored with its OR condition check box unselected (disabled).

![Hardware Break dialog box](image)

Figure 5.42 Hardware Break dialog box

<table>
<thead>
<tr>
<th>OR condition and combination setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OR condition:</strong></td>
</tr>
<tr>
<td>Event in use: 0</td>
</tr>
<tr>
<td><strong>Other conditions:</strong></td>
</tr>
<tr>
<td>AND(Accumulator)</td>
</tr>
<tr>
<td><strong>Exception:</strong></td>
</tr>
<tr>
<td>Exceptional events</td>
</tr>
</tbody>
</table>

Break Point (BP)

Total: 0  Event:  
Delay(cycle): 0

Table 5.11 OR condition

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR condition</td>
<td>Breakpoint is encountered when any one of the set events occurs.</td>
</tr>
</tbody>
</table>
(3) Setting other conditions

You can select one of five choices available: AND (Accumulation), AND (Simultaneous), Subroutine, Sequential and State Transition. To set any condition, select the check box to the left of “Other Conditions.” By default, other conditions are disabled (the check box to the left of “Other Conditions” is unselected).

Table 5.12 Other conditions

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  AND (Accumulation)</td>
<td>Breakpoint is encountered when all of the set events occur irrespective of the time axis.</td>
</tr>
<tr>
<td>2  AND (Simultaneous)</td>
<td>Breakpoint is encountered when all of the set events occur at the same time.</td>
</tr>
<tr>
<td>3  Subroutine</td>
<td>Breakpoint is encountered when a specified event occurs within a specified address range (Subroutine, function).</td>
</tr>
<tr>
<td>4  Sequential</td>
<td>6 steps, (forward direction) + reset point</td>
</tr>
<tr>
<td></td>
<td>Breakpoint is encountered when a set event occurs in a specified order.</td>
</tr>
<tr>
<td>5  State transitions</td>
<td>3 steps, 9 paths + reset point</td>
</tr>
<tr>
<td></td>
<td>Breakpoint is encountered when a set event occurs in a specified order.</td>
</tr>
</tbody>
</table>

The events shown in the list of each condition can be deleted by the keys Ctrl + Del.

CAUTION

When a time-out condition is set in State transitions (Hardware break point) dialog box, the time to make transition from a set state to another then back to the original set state must be 10 µs or more. Transition time of less than 10 µs will result in an incorrect timeout detection.
(4) Detection of exceptional events

Specify whether you want detection of following exceptional events to be used as a breakpoint.

- Violation of access protection
- Read from uninitialized memory
- Stack access violation
- Performance overflow
- Realtime profile overflow
- Trace memory overflow
- Task stack access violation
- OS dispatch

(5) Specifying a delay value

The program breaks a specified number of cycles after a breakpoint is encountered. A breakpoint delay value can be set in the range from 0 to 65,535 bus cycles (default = 0).

5.8.3 Saving/Loading the Set Contents of Hardware Breaks

(1) Saving hardware break settings

Click the Save button of the Hardware Break dialog box. The Save dialog box will be displayed.
Specify a file name to which you want break settings to be saved. The file name extension is .hev. If omitted, the extension .hev is automatically attached.

(2) Loading the set contents of hardware breaks

Click the Load button of the Hardware Break dialog box. The Load dialog box will be displayed. Specify the file name you want to load.
When you load a file, the hardware break settings you had before you have loaded the file are discarded and the hardware breaks are reset with the loaded settings.
Click the Apply button of the Hardware Break dialog box to confirm the hardware break settings you have loaded.
5.9 Looking at Trace Information

5.9.1 Looking at Trace Information
A trace is the function to acquire bus information every cycle and store it in trace memory during user program execution. Using a trace you can track the flow of application execution or examine the points at which problems occurred.

The E100 emulator allows you to acquire up to 4M bus cycles.

When program execution stops (for an exception break, forced halt or breakpoint), the contents stored in trace memory at the time the program has stopped are displayed as the trace result even when no trace points are encountered yet.

5.9.2 Acquiring Trace Information
The E100 emulator operates in such a way that when no trace information acquisition conditions are set, it by default traces all bus cycles to get trace information unconditionally. (Trace mode = Fill until stop)

In free mode, at the same time the user program starts running the emulator starts tracing bus cycles to get trace information, and when the user program stops the emulator stops tracing.

The acquired trace information is displayed in the Trace window.

Figure 5.44 Trace window
The following items of information are displayed. (This applies for bus display.)

Table 5.13 Display items

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle</td>
<td>Cycle numbers stored in trace memory. The last cycle acquired is numbered 0, and the older cycles are assigned smaller numbers −1, −2, etc. sequentially retracing the past. If a delay count is set, the cycle in which a trace stop condition is met is numbered 0 and the cycles that were executed until the condition is met (cycles during a delay period) are assigned larger numbers +1, +2, etc. sequentially toward the last cycle acquired.</td>
</tr>
<tr>
<td>Label</td>
<td>Labels corresponding to addresses (displayed only when labels are set).</td>
</tr>
<tr>
<td>Address</td>
<td>Addresses of the address bus.</td>
</tr>
<tr>
<td>Data</td>
<td>Data of the data bus. Displayed in hexadecimal.</td>
</tr>
<tr>
<td>BUS</td>
<td>Shows the external data bus width, indicated as “8b” when the bus is 8 bits wide or “16b” when 16 bits wide. For M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D, only 16 bits wide is used.</td>
</tr>
<tr>
<td>BHE</td>
<td>Shows the state (0 or 1) of BHE (Byte High Enable) signal. When this signal is ‘0,’ it means that an odd address is being accessed.</td>
</tr>
<tr>
<td>BIU</td>
<td>Shows the state between the BIU (Bus Interface Unit) and the memory and I/O.</td>
</tr>
<tr>
<td></td>
<td>- No change</td>
</tr>
<tr>
<td></td>
<td>DMA Data access such as DMA, etc. requested from other than the CPU</td>
</tr>
<tr>
<td></td>
<td>INT INTACK sequence start</td>
</tr>
<tr>
<td></td>
<td>IB Instruction code read (in bytes) requested from the CPU</td>
</tr>
<tr>
<td></td>
<td>DB Data access (in bytes) requested from the CPU</td>
</tr>
<tr>
<td></td>
<td>IW Instruction code read (in words) requested from the CPU</td>
</tr>
<tr>
<td></td>
<td>DW Data access (in words) requested from the CPU</td>
</tr>
<tr>
<td>R/W</td>
<td>Shows the data bus state, indicated as “R” when in a read state, “W” when in a write state or “–” when no accesses made.</td>
</tr>
<tr>
<td>RWT</td>
<td>The signal indicating the valid position of bus cycle. When valid, this signal is ‘0.’ The Address, Data and BIU lines are valid when this signal is ‘0.’</td>
</tr>
<tr>
<td>CPU</td>
<td>Shows the state between the CPU and the BIU (Bus Interface Unit).</td>
</tr>
<tr>
<td></td>
<td>- No change</td>
</tr>
<tr>
<td></td>
<td>CB Op-code read (in bytes)</td>
</tr>
<tr>
<td></td>
<td>RB Operand read (in bytes)</td>
</tr>
<tr>
<td></td>
<td>QC Instruction queue buffer clear</td>
</tr>
<tr>
<td></td>
<td>CW Op-code read (in words)</td>
</tr>
<tr>
<td></td>
<td>RW Operand read (in words)</td>
</tr>
<tr>
<td>QN</td>
<td>Shows the number of bytes stored in the instruction queue buffer. Displayed in the range from 0 to 4. [CAUTION] When stopping the user program by using software break, QN (the number of bytes stored in the instruction queue buffer) from the next cycle after an occurrence of software break is not displayed correctly.</td>
</tr>
<tr>
<td>BUSACC</td>
<td>When memory access is performed by a debugger operation during user program execution, shows “0” while the emulator is occupying the MCU bus. [CAUTION] Execution of the user program is temporarily stopped during such access to memory.</td>
</tr>
<tr>
<td>Debug</td>
<td>When memory access is performed by a debugger operation during user program execution, shows “0” while the emulator is occupying the MCU bus. [CAUTION] Execution of the user program is temporarily stopped during such access to memory.</td>
</tr>
<tr>
<td>EV</td>
<td>The event No. when a set event occurred. To show EV column, you need to select the EV number on the Option page of the Trace conditions dialog box displayed from the menu of the Trace window.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>TID</td>
<td>Task ID (when RTOS is used). Example display: A task ID (task entry label) is displayed like 1 (_Task1). To show Task ID column, you need to select the Task ID on the Option page of the Trace conditions dialog box displayed from the menu of the Trace window.</td>
</tr>
<tr>
<td>EXT</td>
<td>Shows the signal fed in from the external trigger cable, indicated as “1” when the signal is high or “0” when the signal is low. To show EXT column, you need to select the External trigger on the Option page of the Trace conditions dialog box displayed from the menu of the Trace window.</td>
</tr>
<tr>
<td>ELC</td>
<td>Shows the module number of the linked module destination in event link. [CAUTION] “-” is displayed with M16C/64 Group, M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x Series MCUs.</td>
</tr>
<tr>
<td>ELCOVLAP</td>
<td>Shows if there is an overlap in event link. [CAUTION] “-” is displayed with M16C/64 Group, M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x Series MCUs.</td>
</tr>
<tr>
<td>TimeStamp</td>
<td>Shows an elapsed time since the target program started. Each time the user program starts running, the timestamp starts counting from 0. [CAUTION] When the counter overflows, the time is not displayed correctly.</td>
</tr>
</tbody>
</table>

The unnecessary columns in the Trace window can be hidden. To hide a column, right-click in the header column and select the column you want to hide from the pop-up menu.

### 5.9.3 Setting Trace Information Acquisition Conditions

The trace buffer is limited in size, so that when the buffer is filled, the old trace data is overwritten with new data sequentially beginning with the oldest.

Setting trace information acquisition conditions, you can acquire only the useful trace information, making effective use of the trace buffer.

To set trace information acquisition conditions, use the Trace conditions dialog box that is displayed when you choose Acquisition from the pop-up menu of the Trace window.

1. **Setting trace modes**

   First, select a trace mode.

   ![Trace conditions dialog box](image)

   Figure 5.45 Trace conditions dialog box

2. **Setting trace points**

   If you selected Fill around TP, Repeat fill until stop or Repeat fill until full for the trace mode, set a trace point.
For trace points, you can set event based on conditions and exceptional events.
For Fill around TP, furthermore, you can set a delay value.
(3) Setting Capture/Do not Capture

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture/Do not Capture conditions in the Record condition group box.

![Record condition group box](image)

Figure 5.46 Record condition group box

You can choose to extract only the necessary portions of trace information specified by events or delete the unnecessary portions.

(4) Recording step execution

If the selected trace mode is Fill until stop, you can record step execution. To record step execution, select the Step execution is recorded check box in the Record condition group box.

![Recording step execution](image)

Figure 5.47 Recording step execution

The recordable modes of step execution are Step In, Step Over and Step Out.

(5) Setting trace acquisition methods

Use the Options page of the Trace conditions dialog box to set the acquisition method associated with the entire trace. By default, External Trigger is selected for trace acquisition.
5.9.4  Setting Trace Modes

(1) Setting trace modes

Following five trace modes are available.

Table 5.14 Trace modes

<table>
<thead>
<tr>
<th>Stop mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Fill until stop</td>
<td>Trace acquisition continues until the program stops running.</td>
</tr>
<tr>
<td>2 Fill until full</td>
<td>Trace acquisition stops when the trace memory is filled.</td>
</tr>
<tr>
<td>3 Fill around TP</td>
<td>Trace acquisition stops a specified number of cycles after a trace point is encountered. A delay value can be specified in a range of up to the maximum value of trace capacity.</td>
</tr>
<tr>
<td>4 Repeat fill until stop</td>
<td>Each time a trace point is encountered, acquisition is made for a total of 512 cycles* before and after that point, and acquisition continues that way until the program stops running.</td>
</tr>
<tr>
<td>5 Repeat fill until full</td>
<td>Each time a trace point is encountered, acquisition is made for a total of 512 cycles* before and after that point, and acquisition continues that way until the trace memory is filled.</td>
</tr>
</tbody>
</table>

**CAUTION**

Recording is made in units of total 512 cycles, consisting of 1 cycle at the line where a trace point is met and 255 cycles before that point and 256 cycles after that point.

![Diagram of trace modes](image)

Figure 5.48 Differences between the trace modes

Specifiable conditions vary depending on trace mode, as summarized in the table below.
1. Fill until stop

The trace memory can hold up to 4M bus cycles. When the buffer is filled, the oldest data of the acquired trace information is overwritten with new data. That way, the emulator continues acquiring trace information.

Table 5.15 Specifiable conditions: Fill until stop

<table>
<thead>
<tr>
<th>Trace point setting</th>
<th>Delay specification</th>
<th>Capture/Do not Capture condition setting</th>
<th>Step execution recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>Possible</td>
<td>Possible</td>
</tr>
</tbody>
</table>

2. Fill until full

When the trace memory of the emulator main unit overflows during trace acquisition, the emulator stops acquiring trace information.

Table 5.16 Specifiable conditions: Fill until full

<table>
<thead>
<tr>
<th>Trace point setting</th>
<th>Delay specification</th>
<th>Capture/Do not Capture condition setting</th>
<th>Step execution recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>Possible</td>
<td>-</td>
</tr>
</tbody>
</table>

3. Fill around TP

Trace acquisition is halted a specified number of cycles delayed after a trace point is encountered. In this mode, the user program continues running and only trace acquisition is halted. Sophisticated conditions can be set using a maximum of 16 event points. A delay value can be chosen to be 0, 1M, 2M, 3M or 4M cycles.

Table 5.17 Specifiable conditions: Fill around TP

<table>
<thead>
<tr>
<th>Trace point setting</th>
<th>Delay specification</th>
<th>Capture/Do not Capture condition setting</th>
<th>Step execution recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible</td>
<td>Possible</td>
<td>Possible</td>
<td>-</td>
</tr>
</tbody>
</table>

4. Repeat fill until stop

Each time a trace point is encountered, a total of 512 cycles before and after that point are acquired, and acquisition continues that way. Acquisition continues until it is halted by a break or forced stop. The positions where trace points are encountered can be checked in the Trace window.

Table 5.18 Specifiable conditions: Repeat fill until stop

<table>
<thead>
<tr>
<th>Trace point setting</th>
<th>Delay specification</th>
<th>Capture/Do not Capture condition setting</th>
<th>Step execution recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
5. Repeat fill until full

Each time a trace point is encountered, a total of 512 cycles before and after that point are acquired, and acquisition continues that way. When the trace memory overflows, acquisition is halted. The positions where trace points are encountered can be checked in the Trace window.

Table 5.19 Specifiable conditions: Repeat fill until full

<table>
<thead>
<tr>
<th>Trace point setting</th>
<th>Delay specification</th>
<th>Capture/Do not Capture condition setting</th>
<th>Step execution recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

CAUTION

If trace points are encountered in consecutive cycles in the repeat fill until stop or repeat fill until full mode, only one first cycle is highlighted in yellow as a trace point.

5.9.5 Setting Trace Points

(1) Setting trace points

For trace points, you can set an OR condition, other condition (AND (Accumulation), AND (Simultaneous), subroutine, sequential or state transition) and detection of exceptional events.

The OR condition, other condition and the detection of exceptional events can be set all at the same time, or only one at a time.

![Diagram of trace point settings](image)

Figure 5.49 Outline of the trace point
(2) OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled. If you reenable the OR condition when it is disabled, the previously set event is restored with its OR condition check box selected. However, if a maximum of 16 points is exceeded when you have reenabled for an event, the event is restored with its OR condition check box unselected (disabled).

![Figure 5.50 Trace conditions dialog box](image)

Table 5.20 OR condition

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR condition</td>
<td>Trace point is encountered when any one of the set events occurs.</td>
</tr>
</tbody>
</table>
(3) Other conditions

You can select one of five choices available: AND (Accumulation), AND (Simultaneous), Subroutine, Sequential and State Transition. To set any condition, select the check box to the left of “Other Conditions.”

By default, other conditions are disabled (the check box to the left of “Other Conditions” is unselected).

![Figure 5.51 Trace conditions dialog box](image)

Table 5.21 Other conditions

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  AND (Accumulation)</td>
<td>Trace point is encountered when all of the set events occur irrespective of the time axis.</td>
</tr>
<tr>
<td>2  AND (Simultaneous)</td>
<td>Trace point is encountered when all of the set events occur at the same time.</td>
</tr>
<tr>
<td>3  Subroutine</td>
<td>Trace point is encountered when a specified event occurs within a specified address range (subroutine or function).</td>
</tr>
<tr>
<td>4  Sequential</td>
<td>6 steps (forward direction) + reset point</td>
</tr>
<tr>
<td></td>
<td>Trace point is encountered when a specified event occurs in a specified order.</td>
</tr>
<tr>
<td>5  State transitions</td>
<td>3 steps, 9 paths + reset point</td>
</tr>
<tr>
<td></td>
<td>Trace point is encountered when a set event occurs in a specified order.</td>
</tr>
</tbody>
</table>

CAUTION

When a time-out condition is set in State transitions (Trace) dialog box, the time to make transition from a set state to another then back to the original set state must be 10 µs or more. Transition time of less than 10 µs will result in an incorrect timeout detection.
(4) Detection of exceptional events

Specify whether you want detection of following exceptional events to be used as a trace point.

- Violation of access protection
- Read from uninitialized memory
- Stack access violation
- Performance overflow
- Realtime profile overflow
- Task stack access violation
- OS dispatch

(5) Specifying a delay value

The program breaks a specified number of cycles delayed after a trace point is encountered. A trace-point delay value can be selected from 0M, 1M, 2M, 3M or 4M bus cycles (default: 0M). Select your desired delay value in the delay value setting column.

Figure 5.52 Trace conditions dialog box
5.9.6 Setting Capture/Do not Capture Conditions
If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture/Do not Capture conditions. You can choose to extract only the necessary portions of trace information specified by events or delete the unnecessary portions.

(1) Capture/Do not Capture conditions
There are following types of conditions.

Table 5.22 Capture/Do not Capture conditions

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extraction</td>
<td></td>
</tr>
<tr>
<td>Between two events</td>
<td>Cycles extracted begin when a start event occurs and end with the next to last end event occurs (the cycle where an end event occurs is not extracted).</td>
</tr>
<tr>
<td>Duration of an event</td>
<td>Only cycles where a specified event occurred are extracted.</td>
</tr>
<tr>
<td>Duration of an event occurring in a subroutine</td>
<td>Only cycles where a specified event occurred in a specified address range (subroutine or function) are extracted.</td>
</tr>
<tr>
<td>Instruction accessing specific data</td>
<td>Instructions that accessed specified data are detected.</td>
</tr>
<tr>
<td>Deletion</td>
<td></td>
</tr>
<tr>
<td>Between two events</td>
<td>Cycles extracted begin when a start event occurs and end with the next to last end event occurs (the cycle where an end event occurs is not extracted).</td>
</tr>
<tr>
<td>Duration of an event</td>
<td>Only cycles where a specified event occurred are deleted.</td>
</tr>
<tr>
<td>Duration of an event occurring in a subroutine</td>
<td>Only cycles where a specified event occurred in a specified address range (subroutine or function) are deleted.</td>
</tr>
</tbody>
</table>

Select the conditions you want to set from the list box that is displayed when you select Extract or Delete in the Record condition group box of the Trace conditions dialog box.

![Record condition group box](Figure 5.53 Record condition group box)

Then click the Detail button. A page in which you can set events will be displayed.
CAUTION
When you specify extraction or deletion conditions, you cannot select DIS (disassemble display) and SRC (source display) from Display Modes in the Trace window.
When you use a data access event for extraction or deletion, be sure to specify the MCU bus for the access type.

Figure 5.54 Event dialog box
5.9.7 Selecting the Content of Trace Acquisition

Select the content of trace information you want to be captured into trace memory. Use the Options page of the Trace conditions dialog box to make this selection.

Select which signal you want to be acquired from three choices available: Event Number, Task ID or External trigger. By default, the Event number is selected.

**CAUTION**
If you want a history of trace execution to be displayed in trace acquisitions carried out by running a realtime OS program, be sure to select Task ID.
5.9.8 Showing Trace Results

To check trace results, look at the Trace window. Trace results can be shown in one of the following display modes. These display modes can be switched using Display Modes on the pop-up menu of the Trace window.

There are five trace result display modes: Bus Display, Disassembled Display, Source Display and Mixed Display.

(1) Bus Display Mode

In the pop-up menu, select Display Modes -> BUS. Bus information on each cycle traced are displayed. (Default display mode)

(2) Disassembled Display Mode

From the pop-up menu, choose Display Modes -> DIS. This display mode allows you to inspect the machine language instructions executed.

Figure 5.56 Trace window

Figure 5.57 Trace window
(3) Source Display Mode
From the pop-up menu, choose Display Modes -> SRC. This display mode allows you to inspect the source program’s execution path.

The execution path can be verified by stepping through the source within trace data forward or backward from the current trace cycle.

Figure 5.58 Source Display screen

(4) Mixed Display Mode
This display mode provides a mixed display of bus, disassemble or source display.

After choosing Display Modes -> BUS from the pop-up menu, select Display Modes -> DIS. That way, you can produce a bus and disassemble mixed display.

In the same way, you can produce a bus and source, a disassemble and source or a bus, disassemble and source mixed display.

To revert to a bus only display after viewing a bus and disassemble mixed display, choose Display Modes -> DIS from the pop-up menu again.

Figure 5.59 Trace window
5.9.9 Filtering Trace Information

Use the filter function to extract only the necessary records from the acquired trace information. The filter function filters the trace information in software that was acquired by hardware.

Unlike the “Capture/Do not Capture conditions” where you set acquisition conditions before getting trace information, this function permits you to change filter settings for the acquired trace information any number of times.

Therefore, the necessary information can be extracted easily, with data analysis significantly facilitated.

The filter function does not affect the trace memory, so that its content remains intact.

The filter can be used when the selected trace mode is Fill until stop, Fill until full or Fill around TP and the selected display mode is Bus or Disassembled.

(1) Auto-filter function

To use the filter function, choose Auto Filter from the pop-up menu of the Trace window. When Auto Filter is turned on, each column of the Trace window is marked with an auto-filter arrow [ ].

Click any arrow [ ] and select the necessary condition from the ensuing drop-down list. That way, you can easily filter the records to get those that meet the condition. Selecting Option in the drop-down list brings up the Option dialog box. In this dialog box, you can set detail conditions.

Some columns such as Address and Data have only Option provided in the drop-down list because they do not have other inherent items. Selecting All returns you to a non-filter state.

![Trace window](image)

Figure 5.60 Trace window

If after filtering records in bus display mode you switch to disassemble-only or source-only display, Auto Filter is deselected. Similarly, when after filtering records in disassembled display mode you switch to bus-only or source-only display, Auto Filter is deselected.
If there are multiple items you can specify in the Option dialog box, these items can be used as an OR condition with which to filter.

![Option dialog box](image)

**Figure 5.61 Option dialog box**

### 5.9.10 Searching for Trace Records

You can search the acquired trace information for a specific trace record. To search for trace records, use the Find dialog box. To open it, choose Find -> Find from the pop-up menu of the Trace window or click the Find button in the toolbar.

![Find dialog box](image)

**Figure 5.62 Find dialog box**
Select the conditions you want to search for in the Combination column and select the check boxes. In the Find Item column, you can select the items that correspond to the selected conditions. If you checked more than one condition in the combination column, set items for each condition. The items you have set are searched for as multiple AND conditions. The conditions you have set are shown in the Find Setting Contents.

After setting search conditions, click the Find Previous or the Find Next button to start a search. Trace records are searched in forward or searched in reverse from the line you have clicked in the Trace window (the line highlighted in blue). When a matching trace record is found by a search, the relevant line in the Trace window is highlighted. If no matching trace records are found, a message dialog box is displayed. When an instance of the trace record was successfully found, choose Find Previous or Find Next from the pop-up menu. The next instance of the trace record will be searched for.

(1) Search history
The conditions once searched are left as a history in the history column while the High-performance Embedded Workshop remains active. The next time you perform a search, choose the line you want to search from this history and click the Add button. That way, you can search trace information with that condition again.

The search history contains a history of up to 10 last searches performed.

(2) OR search
You can perform a search using two or more search conditions as OR conditions. To set OR conditions, begin by setting the first condition (shown on the first line in the search content setting column) and then click the New button.

Then enter the second condition. At this time, the second condition is added to the second line in the search content setting column. In this case, the conditions on the first and second lines in the search content setting column can be used as OR conditions for a search performed.

Up to 16 conditions (16 lines) can be set.

CAUTION
The conditions set on one and the same line in the search content setting column comprise AND conditions.

5.9.11 Saving Trace Information to Files
To save trace information to a file, choose File -> Save from the pop-up menu or click the Save button in the toolbar. The trace information displayed in the Trace window is saved in binary or text format.

(1) Saving in binary format
To save trace information in binary format, choose “Trace Data File: Memory Image (*.rtt)” in the Save As Type list box of the dialog box that is displayed when you choose File -> Save from the pop-up menu.

When saved in binary format, all cycles are saved. This type of file can be loaded into the Trace window.

(2) Saving in text format
To save trace information in text format, choose “Text Files: Save Only (*.txt)” in the Save As Type list box of the dialog box that is displayed when you choose File -> Save from the pop-up menu.

When saved in text format, a range of cycles to be saved can be specified. This type of file can only be saved and cannot be loaded into the Trace window.
5.9.12 Loading Trace Information from Files

To load trace information from a file, choose File -> Load from the pop-up menu or click the Load button in the toolbar. Specify a trace information file saved in binary format. The current trace result is overwritten.

Before loading a file saved in binary format, switch to the trace mode in which mode you saved trace information. Do this switching in the Trace conditions dialog box that is displayed when you choose Acquisition from the pop-up menu of the Trace window.

If the current trace mode differs from the one in which mode you saved trace information, an error results. Trace information files saved in text format cannot be loaded into the Trace window.

5.9.13 Temporarily Stopping Trace Information Acquisition

To temporarily stop acquiring trace information during user program execution, choose Trace -> Stop from the pop-up menu of the Trace window or click the Stop button in the toolbar.

Trace acquisition will be aborted, with the trace display updated. Use this function when you only want to stop acquiring trace information and check the trace information without stopping program execution.

5.9.14 Restarting Trace Information Acquisition

If after temporarily stopping acquisition of trace information during user program execution you want to start acquiring trace information again, choose Trace -> Restart from the pop-up menu of the Trace window or click the Restart button in the toolbar.

5.9.15 Switching Timestamp Display

The timestamp displayed in the Trace window can be switched to absolute time, differential time or relative time. In the initial state, the timestamp is displayed in absolute time.

(1) Absolute time

From the pop-up menu, choose Time -> Absolute Time or click the Absolute Time button in the toolbar. The timestamp will be displayed by an absolute time since program execution started.

(2) Differential time

From the pop-up menu, choose Time -> Differences or click the Differences button in the toolbar. The timestamp will be displayed by a differential time from the preceding cycle.

(3) Relative time

From the pop-up menu, choose Time -> Relative Time or click the Relative Time button in the toolbar. The timestamp will be displayed by a relative time from a specified cycle.
5.9.16 Showing the History of Function Execution

To show the history of function execution from the acquired trace information, choose Function Execution History -> Function Execution History from the pop-up menu or click the Function Execution History button in the toolbar.

An upper pane of the window will be displayed. (Initially, this window is blank.)

When you choose Analyze Execution History from the pop-up menu or click the Analyze Execution History button in the toolbar, the emulator starts analyzing the execution history from the end of the trace result and shows the result in a tree structure.

![Trace window](image)

Figure 5.63 Trace window

The lower pane of the window shows the trace result beginning with the cycle in which the function selected in the upper pane was called.

The lower pane of the window can show trace results in disassemble, source or mixed mode.

CAUTION

If trace extraction or deletion conditions are specified, the function execution history cannot be displayed.

If repeat (free) or repeat (full) mode is specified, the function execution history cannot be displayed.
5.9.17 Showing the History of Task Execution

The history of task execution can only be displayed when you are debugging a realtime OS program. Furthermore, to show the history of task execution, you need to select Task ID on the Options page of the Trace conditions dialog box that is displayed when you choose Acquisition from the pop-up menu of the Trace window.

To show the history of function execution from the acquired trace information, choose Show Function Execution History from the pop-up menu click the Show Function Execution History button in the toolbar.

An upper pane of the window will be displayed. (Initially, this window is blank.) When you choose Analyze Execution History from the pop-up menu that is displayed when you right-click in the upper pane or click the Analyze Execution History button in the toolbar, the emulator shows the history of task execution.

When showing the history of task execution, note that the functions called from within tasks are not displayed in a tree structure. Only the order in which the functions were executed is displayed.

![Figure 5.64 Trace window](image)

The lower pane of the window shows the trace result beginning with the cycle in which the task selected in the upper pane was called.

The lower pane of the window can show trace results in disassemble, source or mixed mode.

**CAUTION**

If trace extraction or deletion conditions are specified, the task execution history cannot be displayed.

If repeat (free) or repeat (full) mode is specified, the task execution history cannot be displayed.
5.10 Measuring Performance

5.10.1 Measuring Performance

The performance function measures a maximum, minimum, average and total execution time and a pass count in each of up to eight specified sections of the user program and then shows a time ratio relative to the total execution time (Go–Break) numerically as percentage and graphically.

Since the performance function uses the emulator’s performance measurement circuit to measure the execution time, it does not obstruct the execution of the user program.

Performance measurement conditions cannot be manipulated during program execution.

5.10.2 Showing the Result of Performance Measurement

Measurement results are displayed in the Performance Analysis window.

To open the Performance Analysis window, choose Performance → Performance Analysis from the View menu or click the Performance Analysis toolbar button.

![Figure 5.65 Performance Analysis window](image)

The Performance Analysis window shows a ratio of execution time conforming to the conditions you set in the immediately preceding program execution numerically as percentage and graphically.

The unnecessary columns in this window can be hidden.

To hide any column, right-click in the header column and select the column you want to hide from the pop-up menu.

To redisplay any hidden column, select that column from the pop-up menu again.
The contents displayed in this window are listed below.

Table 5.23 Columns and contents

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Numbers assigned to 1–8 measurement sections set in the Performance Analysis Conditions dialog box. Click Settings on the pop-up menu to open the Performance Analysis Conditions dialog box.</td>
</tr>
<tr>
<td>Condition</td>
<td>Indicated as Enable when measurement conditions are set in the Performance Analysis Conditions dialog box. Otherwise, indicated as Disable.</td>
</tr>
<tr>
<td>Run time (h:m:s.ms.us.ns)</td>
<td>Cumulative execution time. It shows a cumulative time of measured execution time.</td>
</tr>
<tr>
<td>Count</td>
<td>Shows the number of times measured.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Shows a ratio of cumulative execution time relative to Go–Break execution time. [Ratio calculation formula] ( \frac{\text{Cumulative execution time}}{\text{Go–Break cumulative execution time}} \times 100 )</td>
</tr>
<tr>
<td>Max (h:m:s.ms.us.ns)</td>
<td>Maximum execution time per measurement performed</td>
</tr>
<tr>
<td>Min (h:m:s.ms.us.ns)</td>
<td>Minimum execution time per measurement performed</td>
</tr>
<tr>
<td>Average (h:m:s.ms.us.ns)</td>
<td>Average execution time per measurement performed</td>
</tr>
</tbody>
</table>

5.10.3 Setting Performance Measurement Conditions

In the Performance window, select a line of the section No. in which you want to set conditions and choose Set from the pop-up menu. The Performance Analysis Conditions dialog box will be displayed.

![Performance Analysis Conditions dialog box](image)

Figure 5.66 Performance Analysis Conditions dialog box
(1) Setting measurement conditions

A measurement condition can be selected from the following four modes. Select one measurement condition for one section. Use events to set a section. Event counts are fixed to 1. Even when an event count is set to other than 1, it is handled as 1.

Table 5.24 Measurement condition modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Disabled]</td>
<td>Not measured.</td>
</tr>
<tr>
<td>[Between two events]</td>
<td>Measurement is taken of time from when a start event occurs to when an end event occurs. Specifically, measurement is taken of an execution time and execution count in the range set by a start event and an end event. The measurement of time starts when a start event occurs and is aborted when an end event occurs. The execution count is incremented by one each time a start event and an end event occur in pairs within the set range. Start event: One or multiple events can be set. End event: One or multiple events can be set.</td>
</tr>
<tr>
<td>[Event cycle counting]</td>
<td>Measurement is taken of periods in which an event occurs. Namely, measurement is taken of an event occurrence period and execution count. The time from when an event occurs to when the next event occurs is measured as one instance of measurement. The execution count is incremented by one each time an event occurs. Event: Only one event point can be set.</td>
</tr>
</tbody>
</table>

Figure 5.67 Between two events

Measurement is taken of time from when a start event occurs to when an end event occurs. Specifically, measurement is taken of an execution time and execution count in the range set by a start event and an end event. The measurement of time starts when a start event occurs and is aborted when an end event occurs. The execution count is incremented by one each time a start event and an end event occur in pairs within the set range.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

Figure 5.68 Event cycle counting

Measurement is taken of periods in which an event occurs. Namely, measurement is taken of an event occurrence period and execution count. The time from when an event occurs to when the next event occurs is measured as one instance of measurement. The execution count is incremented by one each time an event occurs.

Event: Only one event point can be set.
Table 5.25 Measurement condition modes (Continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>T (Timing)</th>
<th>Description</th>
<th>Comm</th>
<th>Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>EV04</td>
<td></td>
<td>[Address] $start</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>EV05</td>
<td></td>
<td>[Address] $end</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Figure 5.69 Interrupt-disabled range between two events

Measurement is taken of an interrupt disabled section from when a start event occurs to when an end event occurs. Specifically, measurement is taken of an interrupt disabled time and an interrupt disabled count within the range set by a start event and an end event. The measurement of time starts at the same time an interrupt is disabled and is aborted at the same time the interrupt is reenabled. The count is incremented by one each time an interrupt is disabled.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

[CAUTION]
To measure an execution time of a function (maximum, minimum or average execution time of a function), use Between two events.
Set a fetch to the beginning address of the function as a start event and a fetch to the exit of the function (where return statement is written) as an end event. If there are more than one exit, set fetch conditions as an end event for each exit.

(2) Selecting the measurement interval
This setting is applied in common to all of 8 sections. The measurement interval can be selected from the following options: 10 ns (default), 20 ns, 40 ns, 80 ns, 160 ns, 1.6 µs
The maximum measurement time varies with the measurement interval you set.

5.10.4 Starting Performance Measurement
When the user program is run, performance measurement is automatically started according to the performance measurement conditions set.
When the user program is halted, the measurement result is displayed in the Performance Analysis window.
When the user program is rerun without changing measurement conditions after being halted, the measured time in this instance is added to the previously measured value.
To perform a measurement over again, clear the measurement result before running the program.
5.10.5 Clearing Performance Measurement Conditions
Select the measurement condition you want to clear in the Performance Analysis window and then choose Set from the pop-up menu to display the Performance Analysis Conditions dialog box. In the Performance Analysis Conditions dialog box, disable the condition you want to clear.

Figure 5.70 Performance Analysis Conditions dialog box

5.10.6 Clearing the Performance Measurement Result
Select the section you want to clear in the Performance Analysis window and then choose Clear Data from the pop-up menu. The measurement result of the selected section will be cleared. To clear all measurement results, choose Clear All Data from the pop-up menu.

5.10.7 About the Maximum Measurement Time of Performance
(1) Maximum measurement time
The timer used for performance measurement is comprised of a 40-bit counter. The maximum measurement time varies with the measurement interval selected. To select the measurement interval, use the Measurement Unit list box of the Performance Analysis Conditions dialog box. The measurable maximum times are listed in the table below.

Table 5.26 Measurable maximum time

<table>
<thead>
<tr>
<th>No.</th>
<th>Resolution</th>
<th>Measurable maximum time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10ns</td>
<td>Approx. 3 hours, 03 minutes, 15 seconds</td>
</tr>
<tr>
<td>2</td>
<td>20ns</td>
<td>Approx. 6 hours, 06 minutes, 30 seconds</td>
</tr>
<tr>
<td>3</td>
<td>40ns</td>
<td>Approx. 12 hours, 13 minutes, 00 seconds</td>
</tr>
<tr>
<td>4</td>
<td>80ns</td>
<td>Approx. 24 hours, 26 minutes, 00 seconds</td>
</tr>
<tr>
<td>5</td>
<td>160ns</td>
<td>Approx. 48 hours, 52 minutes, 01 seconds</td>
</tr>
<tr>
<td>6</td>
<td>1.6μs</td>
<td>Approx. 488 hours, 40 minutes, 18 seconds</td>
</tr>
</tbody>
</table>

CAUTION
Note that performance measurement produces an error equal to ±1 resolution (when resolution = 20 ns, ±20 ns).

(2) Maximum measurement count
Execution counts are measured using a 32-bit counter. Measurement can be taken up to a count of 4,294,967,295.
5.11 Acquiring Code Coverage

5.11.1 Acquiring Code Coverage
Code coverage is the function to indicate the ‘digestion’ degree of test, i.e., “to what degree tests have been carried out on software code (pass).”

Instruction execution information is displayed at C/C++ and assembly-language levels.

This function allows the emulator to acquire instruction execution information from a program without causing it to break. Therefore, the realtime operation of the user program will not be affected.

The coverage result is updated upon a break.

The E100 emulator supports C0 (instruction) coverage and C1 (branch) coverage.

Table 5.27 Code coverage definition

<table>
<thead>
<tr>
<th>C0: Instruction coverage</th>
<th>All statements within the code are executed at least once.</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1: Branch coverage</td>
<td>All branches within the code are executed at least once.</td>
</tr>
</tbody>
</table>

The E100 emulator comes with up to a 2-Byte code coverage memory when using the C0 + C1 level coverage, and up to a 1-Byte code coverage memory when using the C1 level coverage.

With initial settings, the code coverage memory is allocated automatically to addresses in the ROM and RAM areas in this order.

5.11.2 Opening the Code Coverage Window

Choose Code -> Code Coverage from the View menu or click the Code Coverage toolbar button.

The Code Coverage window is initially empty.

Figure 5.71 Code Coverage window
(1) Measurement method

The Code Coverage window consists of two sheets.

Table 5.28 Sheets of the Code Coverage window

<table>
<thead>
<tr>
<th>Sheet name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Range sheet</td>
<td>Measurement is performed on any address range.</td>
</tr>
<tr>
<td>Source sheet</td>
<td>Measurement is performed on a specified source file</td>
</tr>
</tbody>
</table>

The respective sheets permit multiple ranges to be registered.
Up to two instances of the Code Coverage window can be opened at the same time.

5.11.3 Allocating Code Coverage Memory (Hardware Resource)

(1) Memory allocation

Before code coverage can be measured, code coverage memory must be allocated to the addresses at which to be measured. Coverage data can be obtained from only the address range that has had memory allocated.

To allocate code coverage memory, use the Coverage Memory Allocation dialog box.

To open it, choose Hardware Settings from the pop-up menu of the Code Coverage window.

![Allocation of Code Coverage Memory dialog box](image)

When using the C0 level coverage and C1 level coverage, you can specify any of 1–8 blocks (maximum 2 Mbytes) each beginning with the 256-Kbyte boundary and any of 1–8 blocks (maximum 1 Mbyte) each beginning with the 128-Kbyte boundary as a code coverage measurement area respectively.

Contiguous blocks or noncontiguous blocks, either one, can be set.

With initial settings, the coverage memory is allocated to addresses in the ROM and RAM areas.
Figure 5.73 Schematic of coverage memory allocation

(2) Changing memory allocation

If coverage memory allocation is changed, the coverage data acquired from the addresses before being changed is retrieved from coverage memory into a coverage-only buffer.

Figure 5.74 Schematic of coverage memory allocation change

The data accumulated in a coverage-only buffer is retained until the user clears it. However, data is not updated for the areas that have no coverage memory allocated.

The coverage information shown in the Code Coverage window includes the content of the coverage-only buffer.
5.11.4 Code Coverage in an Address Range

The Address Range sheet shows the code coverage information (C0 coverage and C1 coverage) acquired by the emulator from a user-specified address range.

Multiple address ranges can be registered.

An address range exceeding 2 Mbytes or even an area that has no coverage memory allocated can be specified. However, the coverage information on areas that have no coverage memory allocated is not updated.

Areas where coverage information is not updated are displayed in gray.

An example display is shown below.

![Figure 5.75 Code Coverage window (address specification)](image)

The Code Coverage window is vertically divided into two by the splitter.

The upper pane shows the address ranges to be measured, C0 coverage and C1 coverage.

Table 5.29 Contents shown in the upper pane of the Code Coverage window

<table>
<thead>
<tr>
<th>[Address Range]</th>
<th>Address range in which coverage is measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>[C0 Coverage]</td>
<td>C0 coverage in percentage and graph</td>
</tr>
<tr>
<td>[C1 Coverage]</td>
<td>C1 coverage in percentage and graph</td>
</tr>
</tbody>
</table>

The lower pane shows detailed information of the address range selected in the upper pane (assembly-language level).

Table 5.30 Contents shown in the lower pane of the Code Coverage window

| [Executed] | 1: The instruction was executed  
0: The instruction was not executed |
|------------|---------------------------------|
| [Pass]     | Condition for execution of a conditional branch instruction  
T: The condition was satisfied.  
F: The condition was not satisfied.  
T/F: The condition was satisfied in one case and not satisfied in another. |
| [Address]  | Instruction address             |
| [Assembler] | Disassembled program           |
| [Source]   | C/C++ or assembler source program |
The acquired coverage information is accumulated in memory until the user clears it.
When you double click Assembler code shown in the Address Range sheet, the corresponding source code is shown in the Editor window.
Be sure that source code is not displayed in the cases listed below.
- A source file that corresponds the assembler line does not exist.
- A source line that corresponds the assembler line does not exist.
- Where no debug information is included, such as where the assembler line is a library.

5.11.5 Adding Address Ranges
Follow the procedure described below to add address ranges.

(1) From the Address Range sheet of the Code Coverage window

1. Right-click in the upper pane of the Address Range sheet and choose Add Range from the pop-up menu.

![Code Coverage window](image1)

Figure 5.76 Code Coverage window

2. In the Add Address Range dialog box that is displayed, enter an address range.

![Add Address Range dialog box](image2)

Figure 5.77 Add Address Range dialog box
3. The address range you have added will be displayed in the upper pane of the Code Coverage window.

![Code Coverage window](image)

Figure 5.78 Code Coverage window

### 5.11.6 Changing Address Ranges

Follow the procedure described below to change address ranges.

1. From the Address Range sheet of the Code Coverage window

   (1) Select an address range you want to change in the Address Range sheet and while holding it selected, choose Edit Range from the pop-up menu.

   ![Code Coverage window](image)

   Figure 5.79 Code Coverage window

   2. In the Edit Address Range dialog box that is displayed, change the address range.

   ![Edit Address Range dialog box](image)

   Figure 5.80 Edit Address Range dialog box
3. The address range you have changed will be displayed in the upper pane of the Code Coverage window.

![Code Coverage window](image)

Figure 5.81 Code Coverage window

5.11.7 Removing Address Ranges

Follow the procedure described below to remove address ranges.

1. From the Address Range sheet of the Code Coverage window

(1) Select an address range you want to remove in the Address Range sheet and while holding it selected, choose Delete Range from the pop-up menu.

![Code Coverage window](image)

Figure 5.82 Code Coverage window
2. A dialog box asking for your confirmation will be displayed. Choose to save or not save coverage data. To save, specify a file name and then click the OK button. If you do not save, simply click the OK button.

![Delete Address Range dialog box](image)

Figure 5.83 Delete Address Range dialog box

3. The address range you have selected will be removed.

![Code Coverage window](image)

Figure 5.84 Code Coverage window
5.11.8 Code Coverage in a Source File

The Source sheet shows the code coverage information (C0 coverage and C1 coverage) acquired by the emulator from a user-specified source file. Multiple source files can be registered. A source file exceeding 2 Mbytes in size or even a file that includes an area that has no coverage memory allocated can be specified. However, the coverage information on areas that have no coverage memory allocated is not updated. Address lines where coverage information is not updated are displayed in gray.

An example display is shown below.

![Figure 5.85 Code Coverage window (source file specification)](image)

The Code Coverage window is vertically divided into two by the splitter. The upper pane shows the address ranges to be measured (file and function names), C0 coverage and C1 coverage.

Table 5.31 Contents shown in the upper pane of the Code Coverage window

<table>
<thead>
<tr>
<th>[File]</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Function]</td>
<td>Function name</td>
</tr>
<tr>
<td>[C0 Coverage]</td>
<td>C0 coverage in percentage and graph</td>
</tr>
<tr>
<td>[C1 Coverage]</td>
<td>C1 coverage in percentage and graph</td>
</tr>
</tbody>
</table>

The lower pane shows detailed information of the address range selected in the upper pane (assembly-language level).

Table 5.32 Contents shown in the lower pane of the Code Coverage window

| [Executed] | 1: Instructions was executed. 0: Instructions was not executed. |
| [Pass] | Condition for execution of a conditional branch instruction T: The condition was satisfied. F: The condition was not satisfied. T/F: The condition was satisfied in one case and not satisfied in another. |
| [Address] | Instruction address |
| [Assembler] | Disassembled program |
| [Source] | C/C++ or assembler source program |

The acquired coverage information is accumulated in memory until the user clears it.
5.11.9 Adding Source Files

Follow the procedure described below to add source files.

1. From the Source sheet of the Code Coverage window:
   - Right-click in the upper pane of the Source sheet and choose Add Range from the pop-up menu.
   - In the Add Source Files dialog box that is displayed, enter a file name.
   - The source file you have added and the function names included in it will be displayed in the upper pane of the Code Coverage window.

2. In the Add Source Files dialog box that is displayed, enter a file name.

3. The source file you have added and the function names included in it will be displayed in the upper pane of the Code Coverage window.
5.11.10 Removing Source Files
Delete source files by the following methods.

(1) From the Source sheet of the Code Coverage window

1. Select a function you want to remove in the upper pane of the Source sheet and while holding it selected, choose Delete Range from the pop-up menu.

![Code Coverage window](image)

Figure 5.89 Code Coverage window
2. A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, specify a file name and then click the OK button. If you do not save, simply click the OK button.

![Delete Source File dialog box](image)

Figure 5.90 Delete Source File dialog box
3. All functions included in the selected source file will be removed.

![Code Coverage window](image)

Figure 5.91 Code Coverage window

### 5.11.11 Showing Percentages and Graphs

After the program has stopped, right-click in the upper pane of the Code Coverage window and choose Percentage from the pop-up menu. The emulator will start calculating C0 (instruction) coverage and C1 (branch) coverage for each address range. When the calculation is completed, coverage information is displayed in the upper pane as percentages and graphs.

![Code Coverage window with percentages](image)

Figure 5.92 Code Coverage window
5.11.12 Using the Sort Function
Clicking on a header column in the upper pane of the Code Coverage window allows the coverage data to be sorted.

(1) Clicking on the File column
The data can be sorted by the file name. Lines in the same file are sorted by function name.
Example:

<table>
<thead>
<tr>
<th>File</th>
<th>Function</th>
<th>C0 Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>file1.cpp</td>
<td>func1</td>
<td>40% ■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func2</td>
<td>10% ■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func3</td>
<td>80% ■■■■■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func4</td>
<td>70% ■■■■■■■■</td>
</tr>
<tr>
<td>file2.cpp</td>
<td>func1</td>
<td>20% ■</td>
</tr>
<tr>
<td>file2.cpp</td>
<td>func2</td>
<td>60% ■■■■■■■■</td>
</tr>
<tr>
<td>file2.cpp</td>
<td>func3</td>
<td>90% ■■■■■■■■■</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func1</td>
<td>0%</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func2</td>
<td>30% ■■■</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func3</td>
<td>10% ■</td>
</tr>
</tbody>
</table>

(2) Clicking on the C0 Coverage column
The data can be sorted by coverage rate. First clicking on the column sorts the values in decreasing order. Clicking on the column again sorts the values in ascending order.
Example:

<table>
<thead>
<tr>
<th>File</th>
<th>Function</th>
<th>C0 Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>file2.cpp</td>
<td>func3</td>
<td>90% ■■■■■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func3</td>
<td>80% ■■■■■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func4</td>
<td>70% ■■■■■■■■</td>
</tr>
<tr>
<td>file2.cpp</td>
<td>func2</td>
<td>60% ■■■■■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func1</td>
<td>40% ■■■■■■■■</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func2</td>
<td>30% ■■■■■■■■</td>
</tr>
<tr>
<td>file2.cpp</td>
<td>func1</td>
<td>20% ■■■■■■■■</td>
</tr>
<tr>
<td>file1.cpp</td>
<td>func2</td>
<td>10% ■■■■■■■■</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func3</td>
<td>10% ■■■■■■■■</td>
</tr>
<tr>
<td>file3.cpp</td>
<td>func1</td>
<td>0%</td>
</tr>
</tbody>
</table>
(3) Clicking on the C0 Coverage and the File columns in this order

The data for each file is sorted by the coverage rate in descending order.

Example:

<table>
<thead>
<tr>
<th>File</th>
<th>Function</th>
<th>C0 Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>file1.cpp func3</td>
<td>80% ■■■■■■■■</td>
<td></td>
</tr>
<tr>
<td>file1.cpp func4</td>
<td>70% ■■■■■■■</td>
<td></td>
</tr>
<tr>
<td>file1.cpp func1</td>
<td>40% ■■■■</td>
<td></td>
</tr>
<tr>
<td>file1.cpp func2</td>
<td>10% ■</td>
<td></td>
</tr>
<tr>
<td>file2.cpp func3</td>
<td>90% ■■■■■■■■■</td>
<td></td>
</tr>
<tr>
<td>file2.cpp func2</td>
<td>60% ■■■■■■</td>
<td></td>
</tr>
<tr>
<td>file2.cpp func1</td>
<td>20% ■■</td>
<td></td>
</tr>
<tr>
<td>file3.cpp func2</td>
<td>30% ■■■</td>
<td></td>
</tr>
<tr>
<td>file3.cpp func3</td>
<td>10% ■</td>
<td></td>
</tr>
<tr>
<td>file3.cpp func1</td>
<td>0%</td>
<td></td>
</tr>
</tbody>
</table>

5.11.13 Searching for Unexecuted Lines

Search for unexecuted lines in a selected address range or function. When you click the Find button in the toolbar, the Find dialog box shown below appears.

![Find dialog box](image)

Figure 5.93 Find dialog box

Following three search options are available.

<table>
<thead>
<tr>
<th>Search options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexecuted Line</td>
<td>Instructions not executed yet</td>
</tr>
<tr>
<td>Branch (T)</td>
<td>Branch instructions only tested as TRUE.</td>
</tr>
<tr>
<td>Branch (F)</td>
<td>Branch instructions only tested as FALSE.</td>
</tr>
</tbody>
</table>

Clicking the Find Next button starts a search.
When a matching instruction is found, the line of that instruction is highlighted.
When no matching instructions are found, a message is displayed.
5.11.14 Clearing Code Coverage Information

(1) Clearing the code coverage information of the specified range

Selecting Clear Coverage Range from the pop-up menu opens the Clear Address Range dialog box.

![Clear Address Range dialog box](image)

Enter the start and end addresses of the range to be cleared. Clicking the OK button clears the coverage information of the selected range.

(2) Clearing all the code coverage information

Selecting Clear the Entire Coverage from the pop-up menu clears all the code coverage information.

5.11.15 Updating Coverage Information

Selecting Refresh from the pop-up menu updates the content of the Code Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when the program breaks. To view the latest information, therefore, you need to update manually.

5.11.16 Preventing Update of Coverage Information

Selecting Lock Refresh from the pop-up menu prevents update of the Code Coverage window while the user program execution is stopped.
5.11.17 Saving the Code Coverage Information to a File
You can save the code coverage information of the currently selected sheet to a file.
Selecting Save Data from the pop-up menu opens the Save Coverage Data dialog box.

![Save Coverage Data dialog box](image1)

Figure 5.95 Save Coverage Data dialog box

Enter a file name in which you want the information to be saved.
If the file extension is omitted, "cov" will automatically be added as the file extension.
If you specify an existing file name, the file is overwritten.

5.11.18 Loading Code Coverage Information from a File
You can load a code coverage information file.
Selecting Load Data from the pop-up menu opens the Load Coverage Data dialog box.

![Load Coverage Data dialog box](image2)

Figure 5.96 Load Coverage Data dialog box
Clicking on the Add button opens the Add Coverage Files dialog box shown below.

![Add Coverage Files dialog box](image)

**Figure 5.97 Add Coverage Files dialog box**

Use this dialog box to specify a coverage information file you want to load. You can also specify a load mode and offset for each file you load.

The only file extension available is “.cov”. An error message will appear if any other file extension is entered.

The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are listed. If necessary, use the Up or Down button to change the order.

**CAUTION**

If the coverage information file you are loading is of a source file type, you cannot specify an offset.

### 5.11.19 Coverage Information File Load Modes

Coverage information file load modes are schematically shown below.

1. When “Overwrite” has been selected

![Schematic of the overwrite mode](image)

**Figure 5.98 Schematic of the overwrite mode**
(2) When “Merge” has been selected

![Diagram showing the merge process]

1. Existing data is read.
2. The data of the coverage file is merged with the existing data.
3. The merged data is written to the coverage memory.

Figure 5.99 Schematic of the merge mode

(3) Application example of merge mode

![Diagram showing the merge application example]

[Procedure]

(1) Open the Load Coverage Data dialog box.
   To begin with, select the “Clear coverage RAM before loading” check box.

(2) Add a coverage file for test A in the merge mode.

(3) Add a coverage file for test B in the merge mode.

(4) Add a coverage file for test C in the merge mode.

(5) Click the OK button.

You have now finished merging three files.

By calculating percentages in the Code Coverage window, you can view the coverage (in percentage) of those tests as a whole. Furthermore, the merged data can be saved to a file, so that you can manage those data as a single file.
5.11.20 Displaying Code Coverage Information in the Editor Window

When the Editor window is open in the source mode, the results of coverage are displayed in its Code Coverage column. Part of the Code Coverage column that corresponds to a source line where an instruction has been executed is highlighted. If the user changes any setting regarding the coverage information in the Code Coverage window, the content of the corresponding Code Coverage column will also be updated.

![Code Coverage Results](image)

Figure 5.101 Example of code coverage results
5.12 Acquiring Data Coverage

5.12.1 Acquiring Data Coverage
The E100 emulator has code coverage, data coverage and realtime profile functions usable exclusively to each other.
To use the data coverage function, choose Data Coverage in the Exclusive Functions section on the System page of the Configuration Properties dialog box.

Data coverage is the function to indicate “what kinds of accesses have been made” to the data area.
This function allows the emulator to acquire access information per byte without causing a program to break. Therefore, the realtime operation of the user program will not be affected.
The coverage result is updated upon a break.

The E100 emulator comes with 512 Kbytes of data coverage memory.
With initial settings, the data coverage memory is automatically assigned at addresses in the ROM and RAM areas in this order.

5.12.2 Opening the Data Coverage Window

Choose Code -> Data Coverage from the View menu or click the Data Coverage toolbar button.

The Data Coverage window is initially empty.

![Data Coverage Window]

Figure 5.102 Data Coverage window
(1) Measurement method

The Data Coverage window consists of three sheets.

<table>
<thead>
<tr>
<th>Sheet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Range</td>
<td>Measurement is performed on any address range.</td>
</tr>
<tr>
<td>Section</td>
<td>Measurement is performed on a specified section.</td>
</tr>
<tr>
<td>Task Stack</td>
<td>Measurement is made of all task stack areas.</td>
</tr>
</tbody>
</table>

The respective sheets permit multiple ranges to be registered.

The Task Stack sheet supports only automatic registration.

Up to three instances of the Data Coverage window can be opened at the same time.

5.12.3 Allocating Data Coverage Memory (Hardware Resource)

(1) Memory allocation

Before data coverage can be measured, data coverage memory must be assigned to the target address range. Coverage data can be obtained from only the address range that has had memory allocated.

To allocate data coverage memory, use the Allocation of Data Coverage Memory dialog box. To open this dialog box, select [Hardware Settings…] from the pop-up menu of the Data Coverage window.

You can specify any of blocks 1 to 8 (up to 512 Kbytes) each beginning with a 64-Kbyte boundary as data coverage measurement areas.

Either contiguous blocks or non-contiguous blocks can be assigned.

With initial settings, the coverage memory is automatically assigned at addresses in the ROM and RAM areas.
(2) Changing memory allocation

If coverage memory allocation is changed, the coverage data acquired from the addresses before being changed is retrieved from coverage memory into a coverage-only buffer.

The acquired coverage information is accumulated in the coverage buffer until the user clears it. However, the coverage information on areas that have no coverage memory allocated is not updated.

The coverage information shown in the Data Coverage window includes the content of the coverage-only buffer.
5.12.4 Data Coverage in an Address Range

The E100 emulator shows the access information it acquired from a user-specified address range.

![Data Coverage](image)

Figure 5.106 Data Coverage window (address specification)

The Data Coverage window is vertically divided into two by the splitter. The upper pane shows the address ranges to be measured and access rates.

Table 5.35 Contents in the upper pane of the Data Coverage window

<table>
<thead>
<tr>
<th>Range</th>
<th>Access Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>000500 - 0006A2</td>
<td>U$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>Label</th>
<th>Area</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>000500</td>
<td>RAM</td>
<td>e7</td>
<td>f8 1b 03</td>
</tr>
<tr>
<td>000504</td>
<td>RAM</td>
<td>dc</td>
<td>6f ac 24</td>
</tr>
<tr>
<td>000508</td>
<td>RAM</td>
<td>23</td>
<td>d8 bd 6e</td>
</tr>
<tr>
<td>00050C</td>
<td>RAM</td>
<td>c7</td>
<td>b9 d1 02</td>
</tr>
<tr>
<td>000510</td>
<td>RAM</td>
<td>99</td>
<td>b7 d0 30</td>
</tr>
</tbody>
</table>

The lower pane shows detailed information of the address range selected in the upper pane.

Table 5.36 Contents shown in the lower pane of the Data Coverage window

<table>
<thead>
<tr>
<th>Address</th>
<th>Address value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Label]</td>
<td>Label name</td>
</tr>
<tr>
<td>[Area]</td>
<td>Memory area (FlashROM, RAM, SFR)</td>
</tr>
<tr>
<td></td>
<td>This column is blank when the area is unused.</td>
</tr>
<tr>
<td>[Data]</td>
<td>Memory data</td>
</tr>
<tr>
<td></td>
<td>The accessed data has its background displayed in purple.</td>
</tr>
</tbody>
</table>

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage information of those addresses is retained, the coverage information will not be updated by program execution. The acquired coverage information is accumulated in memory until the user clears it.
5.12.5 Adding Address Ranges

Follow the procedure described below to add address ranges.

(1) From the Address Range sheet of the Data Coverage window

1. Right-click in the upper pane of the Address Range sheet and choose Add Range from the pop-up menu.

![Data Coverage window](image)

Figure 5.107 Data Coverage window

2. In the Add Address Ranges dialog box that is displayed, enter an address range.

![Add Address Range dialog box](image)

Figure 5.108 Add Address Range dialog box

3. The address range you have added will be displayed in the upper pane of the Data Coverage window.

![Data Coverage window](image)

Figure 5.109 Data Coverage window
5.12.6 Changing Address Ranges

Follow the procedure described below to change address ranges.

(1) From the Address Range sheet of the Data Coverage window

1. Select an address range you want to change in the Address Range sheet and while holding it selected, choose **Edit Range** from the pop-up menu.

![Data Coverage window](image1)

Figure 5.110 Data Coverage window

2. In the **Edit Address Range** dialog box that is displayed, change the address range.

![Edit Address Range dialog box](image2)

Figure 5.111 Edit Address Range dialog box

3. The address range you have changed will be displayed in the upper pane of the Data Coverage window.

![Data Coverage window](image3)

Figure 5.112 Data Coverage window
5.12.7 Removing Address Ranges

Follow the procedure described below to remove address ranges.

1. From the Address Range sheet of the Data Coverage window

   (1) Select an address range you want to remove in the Address Range sheet and while holding it selected, choose Delete Range from the pop-up menu.

   Figure 5.113 Data Coverage window

   (2) A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, click the Yes button. If you do not save, click the No button.

   Figure 5.114 Confirmation of Edit Address Range dialog box

   (3) The address range you have selected will be removed.

   Figure 5.115 Data Coverage window
5.12.8  Data Coverage in a Section

The E100 emulator shows the access information it acquired from a user-specified section.

![Data Coverage window](image)

**Figure 5.116 Data Coverage window (section name specification)**

The Data Coverage window is vertically divided into two by the splitter. The upper pane shows the address ranges (section names) to be measured and access rates.

**Table 5.37 Contents in the upper pane of the Data Coverage window**

<table>
<thead>
<tr>
<th>[Section]</th>
<th>Address range (section) in which coverage is measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Access Rate]</td>
<td>Access rate in percentage and graph</td>
</tr>
</tbody>
</table>

The lower pane shows detailed information of the address range selected in the upper pane.

**Table 5.38 Contents shown in the lower pane of the Data Coverage window**

<table>
<thead>
<tr>
<th>[Address]</th>
<th>Address value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Label]</td>
<td>Label name</td>
</tr>
</tbody>
</table>
| [Area] | Memory area (FlashROM, RAM, SFR)  
This column is blank when the area is unused. |
| [Data] | Memory data  
The accessed data has its background displayed in purple. |

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage information of those addresses is retained, the coverage information will not be updated by program execution. The acquired coverage information is accumulated in memory until the user clears it.
5.12.9 Adding Sections
Follow the procedure described below to add sections.

(1) From the Section sheet of the Data Coverage window

1. Right-click in the upper pane of the Section sheet and choose Add Range from the pop-up menu.

2. In the Add A Section dialog box that is displayed, enter a section name.

3. The address range (section name) you have added will be displayed in the upper pane of the Data Coverage window.
5.12.10 Removing Sections

Follow the procedure described below to remove sections.

1. Select a section name you want to remove in the Section sheet and while holding it selected, choose Delete Range from the pop-up menu.

2. A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, click the Yes button and specify a file name. If you do not save, click the No button.

3. The section name you have selected will be removed.
5.12.11 Data Coverage in a Task Stack

The Task Stack sheet shows the access information acquired from a task stack. Task stacks are automatically registered.

You cannot add, remove or change any task.

If tasks are changed pursuant to alterations of the user program, for example, the window is automatically updated.

![Data Coverage window](image)

The Data Coverage window is vertically divided into two by the splitter. The upper pane shows the automatically registered task stacks and access rates.

Table 5.39 Contents shown in the upper pane of the Data Coverage window

<table>
<thead>
<tr>
<th>Task</th>
<th>Access Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>000E0C - 000E5F (TaskID=11, Entry=_task011)</td>
<td>0%</td>
</tr>
<tr>
<td>000A24 - 000A87 (TaskID=1, Entry=_main)</td>
<td>40%</td>
</tr>
<tr>
<td>001000 - 001053 (TaskID=16, Entry=_task016)</td>
<td>0%</td>
</tr>
<tr>
<td>000F0C - 000FFF (TaskID=15, Entry=_task015)</td>
<td>0%</td>
</tr>
<tr>
<td>000AEC - 000B4F (TaskID=3, Entry=_task003)</td>
<td>0%</td>
</tr>
</tbody>
</table>

The lower pane shows detailed information of the task stack selected in the upper pane.

Table 5.40 Contents shown in the lower pane of the Data Coverage window

<table>
<thead>
<tr>
<th>Address</th>
<th>Label</th>
<th>Area</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>000A40</td>
<td></td>
<td>RAM</td>
<td>00</td>
</tr>
<tr>
<td>000A44</td>
<td></td>
<td>RAM</td>
<td>00</td>
</tr>
<tr>
<td>000A48</td>
<td></td>
<td>RAM</td>
<td>00</td>
</tr>
<tr>
<td>000A4C</td>
<td></td>
<td>RAM</td>
<td>a8</td>
</tr>
</tbody>
</table>

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage information of those addresses is retained, the coverage information will not be updated by program execution.

The acquired coverage information is accumulated in memory until the user clears it.
5.12.12 Clearing Data Coverage Information

(1) Clearing the data coverage information of the specified range

Selecting Clear Coverage Range from the pop-up menu on the Address Range or Section sheet opens the Clear Coverage Range dialog box.

![Clear Coverage Range dialog box](image)

Figure 5.124 Clear Coverage Range dialog box

Enter the start and end addresses of the range to be cleared. Clicking the OK button clears the coverage information of the selected range.

(2) Clearing all data coverage information

Selecting Clear the Entire Coverage from the pop-up menu clears all the data coverage information.

5.12.13 Updating Coverage Information

Selecting Refresh from the pop-up menu updates the content of the Data Coverage window. If Lock Refresh has been selected, the information is not automatically updated when the program breaks. To view the latest information, therefore, you need to update manually.

5.12.14 Preventing Update of Coverage Information

Selecting Lock Refresh from the pop-up menu prevents update of the Data Coverage window while the user program execution is stopped.
5.12.15 Saving the Data Coverage Information to a File
You can save the data coverage information of the currently selected sheet to a file.
Selecting Save Data from the pop-up menu opens the Save Data dialog box.

![Save Data dialog box](image)

Figure 5.125 Save Data dialog box

Enter a file name in which you want the information to be saved. If a file extension is omitted, ".cdv" will automatically be added as the file extension. If you specify an existing file name, the file is overwritten.

5.12.16 Loading Data Coverage Information from a File
You can load a data coverage information file.
Selecting Load Data from the pop-up menu opens the Load Coverage Data dialog box.

![Load Coverage Data dialog box](image)

Figure 5.126 Load Coverage Data dialog box
Clicking on the Add button opens the Add coverage data file dialog box shown below.

![Add coverage data file dialog box](image)

Figure 5.127 Add coverage data file dialog box

Use this dialog box to specify a coverage information file you want to load. You can also specify a load mode and offset for each file you load.

The only file extension available is ".cdv". An error message will appear if any other file extension is entered.

The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are listed. If necessary, use the Up or Down button to change the order.
5.13 Viewing Realtime Profile Information

5.13.1 Viewing Realtime Profile Information
The E100 emulator has code coverage, data coverage and realtime profile functions usable exclusively to each other.
To use the realtime profiling function, choose Realtime Profile in the Switching function section on the System page of the Configuration properties dialog box.
Realtime profiling is the function to measure execution performance within an area allocated to addresses in the profile range, one function or one task at a time. It will help you find the locations and causes of performance degradation in an application program.
Measurements are carried out without obstructing user program execution.
The measurement results are updated when the program breaks.

(1) Function profile
Execution performance is measured one function at a time.
The Realtime profile window shows function names, the start addresses of functions, function sizes, counts and the cumulative execution time, execution rate and average execution time of functions.
The function profile of the E100 emulator does not include the execution time of subroutines in its cumulative display of function execution time.

CAUTION
The function profile is subject to the following limitations:

(a) About the areas to be measured
The E100 emulator can acquire profile information on all functions in areas up to 8 blocks, each in 128 KB units.
Each block you set can be comprised of a contiguous or noncontiguous address area.
No functions can be set that are outside the range of block addresses. In that case, the functions or tasks are displayed in gray.

(b) Limit to the number of functions
Measurement can be taken of up to $8K - 1 (= 8,191)$ functions.
If the number of functions measured exceeds $8K - 1 (= 8,191)$, the extra functions are excluded from the subject of measurement. In that case, those functions are displayed in gray. (Function names, address and function sizes are displayed in gray.)

(c) In-line expansion
The functions that are expanded in-line for optimization by the compiler are not displayed in the Realtime Profile window.

(d) Recursive functions
Although the execution time of recursive functions can be measured correctly, they are executed only once.
(c) Relationship between Go execution start address and break address within a measurement range and the measurable range

![Diagram of function execution and break addresses]

Figure 5.128 Measurable range

Measurable range when the program breaks at the location of a black dot [●]: Execution time and execution count of functions h and k
Measurable range when the program breaks at the location of a red dot [●]: Execution time and execution count of functions h and k
Measurable range when the program breaks at the location of a blue dot [●]: Execution time and execution count of functions h and k

For the function g, the execution time and count in its executed portion can be measured.

Thus, the above is the relationship between break addresses and the measurable range.
Even after the program returned to a high-order function, execution counts of the function from which program execution started cannot be measured.

(f) Function measurement
To measure functions accurately, you need to be in a function to be measured for 100 ns or more after entering the function. Otherwise, the execution time and count may not be measured properly.

(g) Debug information option
To get execution time and execution count of functions, you need to specify a source file that includes the functions for measurement or an option that outputs debug information to the library during compiling. When not specifying the Debug information option, you cannot measure execution time and execution counts of the function.

(h) Maximum execution time and minimum execution time
With the realtime profile, you cannot measure the maximum and minimum execution time of a function. To measure the maximum and minimum execution time of a function, use the Performance Analysis window.
(2) Task profile

Execution performance is measured one task at a time.
The Realtime profile window shows task IDs, counts and the cumulative execution time, execution rate and average execution time of tasks.

5.13.2 Setting Realtime Profile Measurement Modes

Choose Set Ranges from the pop-up menu that is displayed when you right-click in the present window.
The Realtime Profile Setting dialog box will be displayed. In the Profile Mode list box of this dialog box, you can select “Function profile” or “Task profile.”
When profile modes are changed, all measurement results are cleared.

5.13.3 Measuring Function Profiles

You can measure execution performance one function at a time.

Figure 5.129 Realtime Profile window (function profile)

The following shows detailed information in each column.

<table>
<thead>
<tr>
<th>Block</th>
<th>Block number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Function name</td>
</tr>
<tr>
<td>Address</td>
<td>Start address of function</td>
</tr>
<tr>
<td>Size</td>
<td>Function size</td>
</tr>
<tr>
<td>Count</td>
<td>Number of times a function is called</td>
</tr>
<tr>
<td>Time</td>
<td>Cumulative time of function execution</td>
</tr>
<tr>
<td></td>
<td>The timestamp is displayed in the form shown below.</td>
</tr>
<tr>
<td></td>
<td>Hours:minutes:seconds.milliseconds.microseconds.nanoseconds</td>
</tr>
<tr>
<td>Statistic</td>
<td>Ratio of function time to Go-Break execution time</td>
</tr>
<tr>
<td>Average</td>
<td>Average execution time per measurement performed</td>
</tr>
</tbody>
</table>

If located outside the profile memory allocated area, address lines are displayed in gray.
The acquired profile measurement results are accumulated in memory until the user clears them.
5.13.4 Setting Function Profile Measurement Ranges
Choose Set Ranges from the pop-up menu that is displayed when you right-click in the present window. The Realtime Profile Setting dialog box will be displayed. In this dialog box, set a profile measurement range.

![Realtime Profile Setting dialog box](image)

Figure 5.130 Realtime Profile Setting dialog box

(1) Memory allocation
Before function profiles can be measured, profile memory must be allocated to the addresses at which to be measured. Profile data can be obtained from only the address range that has had memory allocated. You can specify any of blocks 1 to 8 (up to 1 Mbyte) each beginning with a 128-Kbyte boundary as profile measurement areas. Either contiguous or non-contiguous blocks can be assigned. With initial settings, the profile memory is automatically assigned at addresses in the ROM and RAM areas.

(2) Automatic function detection
When profile memory is assigned at addresses, the E100 emulator automatically detects functions included that address range and registers those functions in the window.
5.13.5 Saving Function Profile Measurement Ranges
You can save the current task mode and function profile measurement range (memory allocation state).
Click the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.
Enter a file name in which you want function profile measurement ranges to be saved.
If the file extension is omitted, “.rpf” will automatically be added as the file extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.6 Loading Function Profile Measurement Ranges
You can load a function profile measurement range.
Click the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

![Open dialog box](image)

Enter a file name you want to load.
The only file extension available is “.rpf”. An error message will appear if any other file extension is entered.
When a file load is complete, the list in the Realtime Profile Setting dialog box is updated.
If task profile information is included in the loaded file, modes in the Realtime Profile Setting dialog box are switched to task mode.
5.13.7 Measuring Task Profiles

You can measure execution performance one task at a time.

![Realtime Profile dialog box (task profile)](image)

The following shows detailed information in each column.

<table>
<thead>
<tr>
<th>Block</th>
<th>Task ID</th>
<th>Count</th>
<th>Time</th>
<th>Statistic</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not-Main/Idle</td>
<td>1</td>
<td>00:00:00.577.565.090</td>
<td>16%</td>
<td>00:00:00.577.565.090</td>
</tr>
<tr>
<td>1</td>
<td>_main</td>
<td>1</td>
<td>00:00:00.084.801.850</td>
<td>2%</td>
<td>00:00:00.084.801.850</td>
</tr>
<tr>
<td>2</td>
<td>_task1</td>
<td>20</td>
<td>00:00:00.300.480.000</td>
<td>20%</td>
<td>00:00:00.300.507.060</td>
</tr>
<tr>
<td>3</td>
<td>_task2</td>
<td>25</td>
<td>00:00:00.341.265.350</td>
<td>15%</td>
<td>00:00:00.021.650.610</td>
</tr>
</tbody>
</table>

Disabled tasks are displayed in gray.

The acquired profile measurement results are accumulated in memory until the user clears them.
5.13.8 Setting Task Profile Measurement Ranges

Choose Set Range from the pop-up menu that is displayed when you right-click in the present window. The Realtime Profile Setting dialog box will be displayed. In this dialog box, set a profile measurement range.

[Task mode]

Figure 5.133 Realtime Profile Setting dialog box

(1) Automatic task detection

If you have downloaded a load module that has the OS included in it, the E100 emulator automatically detects a task list.

(2) Selecting tasks

Select the check box of a task ID you want to measure. (By default, all check boxes are selected.) The selected tasks will automatically be assigned block numbers (1–8).

CAUTION

If measurement blocks are lacking, block numbers become blank, so that no more task IDs can be registered. In that case, deselect the check boxes of unnecessary task IDs.
5.13.9 Saving Task Profile Measurement Tasks
You can save the current task mode and measurement tasks (task IDs and enabled/disabled states).
Click the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.
Enter a file name in which you want task profile measurement tasks to be saved.
If the file extension is omitted, “.rpf” will automatically be added as the file extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.10 Loading Task Profile Measurement Tasks
You can load task profile measurement tasks.
Click the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

Figure 5.134 Open dialog box

Enter a file name you want to load.
The only file extension available is “.rpf”. An error message will appear if any other file extension is entered.
When a file load is complete, the list (task list) in the Realtime Profile Setting dialog box is updated.

If any loaded task IDs are nonexistent, although they are displayed once in the list (task list) in the Realtime Profile Setting dialog box, it is only the existing task IDs that are registered as measurement tasks when you click the OK button.
Reopening the Realtime Profile Setting dialog box, you can check the currently registered measurement tasks.

If function profile information is included in the loaded file, modes in the Realtime Profile Setting dialog box are switched to function mode.
5.13.11 Clearing Realtime Profile Measurement Results
Choose Clear from the pop-up menu of the Realtime Profile window, and all measurement results will be cleared.
Unless you choose to Clear, measurement results are accumulated in memory.

5.13.12 Saving Realtime Profile Measurement Results
You can save the current realtime profile measurement results in text format.
Choose Save To File from the pop-up menu of the Realtime Profile window, and the Save As dialog box will be displayed.

Enter a file name in which you want the measurement results to be saved.
If the file extension is omitted, “.txt” will automatically be added as the file extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.13 Setting the Measurement Interval
Choose Properties from the pop-up menu that is displayed when you right-click in the present window.
The Properties dialog box will be displayed.

![Properties dialog box]

Figure 5.135  Properties dialog box

The measurement interval can be selected from the following options:
10 ns, 20 ns, 40 ns, 80 ns, 160 ns, 1.6 µs

CAUTION
When the currently set measurement interval is changed, the measurement results hitherto accumulated are cleared.
5.13.14 Maximum Measurement Time of the Realtime Profile

(1) Maximum measurement time

The timer used for performance measurement is comprised of a 40-bit counter. The maximum measurement time varies with the measurement interval selected.

To select a measurement interval, specify it in the Measurement interval drop-down list of the Properties dialog box. The measurable maximum times are listed below.

Table 5.43 Maximum measurement time

<table>
<thead>
<tr>
<th>No.</th>
<th>Resolution</th>
<th>Maximum measurement time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10ns</td>
<td>Approx. 3 hours, 03 minutes, 15 seconds</td>
</tr>
<tr>
<td>2</td>
<td>20ns</td>
<td>Approx. 6 hours, 06 minutes, 30 seconds</td>
</tr>
<tr>
<td>3</td>
<td>40ns</td>
<td>Approx. 12 hours, 13 minutes, 00 seconds</td>
</tr>
<tr>
<td>4</td>
<td>80ns</td>
<td>Approx. 24 hours, 26 minutes, 00 seconds</td>
</tr>
<tr>
<td>5</td>
<td>160ns</td>
<td>Approx. 48 hours, 52 minutes, 01 seconds</td>
</tr>
<tr>
<td>6</td>
<td>1.6us</td>
<td>Approx. 488 hours, 40 minutes, 18 seconds</td>
</tr>
</tbody>
</table>

**CAUTION**

Note that performance measurement produces an error of ± “2 resolution + 100 ns” (when resolution = 20 ns, ±140 ns) whenever entering functions. If the resolution is 20 ns and you enter functions 10 times, ±1400 ns error occurs.

(2) Maximum measurement count

Execution counts of the realtime profile are measured using a 16-bit counter. Measurement can be taken of up to a count of 65,535.
5.14 Detecting Exceptional Events

5.14.1 Detecting Exceptional Events
The E100 emulator permits you to detect various exceptional events that have occurred during user program execution. Exceptional events include an abnormal behavior of the user program, as well as an overflow of the measurement counter of any function involved, etc. Detection of a specified exceptional event can be set as a condition of a breakpoint or trace point.

(1) Exceptional events
The E100 emulator detects the exceptional events listed below.

- Violation of access protection: An error is detected when an access other than a specified access attribute was attempted.
- Read from uninitialized memory: An error is detected when uninitialized area (not write accessed) was accessed for read.
- Stack access violation: An error is detected when the value of the stack register is beyond a boundary of the stack area.
- Performance overflow: An error is detected when the time measurement counter for a section has overflowed.
- Realtime profile overflow: An error is detected when the maximum measurable time or maximum measurable number of passes is exceeded during profile measurement of a function (or a task).
- Trace memory overflow: An error is detected when the trace memory has overflowed.
- Task stack access violation: An error is detected when one task attempts writing to the task stack of another task.
- OS dispatch: An error is detected if a task dispatch has occurred.

5.14.2 Detecting an Access Protect Violation
Violations of access protection such as writing to a ROM area or access to an unused area (for reading, writing, or execution of an instruction) can be detected as an error.

(1) Access attributes
Following attributes can be specified in word units for any area.

Read/Write: Accessible for both read/write
Read Only: Accessible for read only
Write Only: Accessible for write only
Disable: Access prohibited
Disable (OS): Any access except from OS is prohibited (this attribute is automatically assigned when a program including an OS is downloaded).

(2) Protected areas
Any area in the entire memory space may be access protected.
At emulator startup, the whole area is by default assigned a Read/Write access attribute.
(3) Methods for setting protection
There are following two methods of specification:
- Automatic setting by section information in a download module
- Specifying the access attribute of any area individually

(4) Detection method
An access protect violation is detected by the emulator’s internal resources (blocks 1–16).
The blocks are automatically allocated by the emulator’s exclusive algorithm.

CAUTION
Since the emulator’s internal resources are limited, not all blocks can be access protected. In that case, reduce the amount of
used blocks by “removing blocks” before setting protection again.

<table>
<thead>
<tr>
<th>Access attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write access</td>
</tr>
<tr>
<td>- &gt;</td>
</tr>
<tr>
<td>Read access</td>
</tr>
<tr>
<td>- &gt;</td>
</tr>
<tr>
<td>Read access</td>
</tr>
<tr>
<td>- &gt;</td>
</tr>
<tr>
<td>Write access</td>
</tr>
</tbody>
</table>

Figure 5.136 Patterns for detecting violation

(5) Actions taken when an access protect violation is detected
The following actions can be set:
- Display a warning
Selecting the Access Protect Violation check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.
- Make the detection of an access protect violation a condition of a hardware breakpoint
- Make the detection of an access protect violation a condition of a trace point
5.14.3 Setting an Access Protected Area

Follow the procedure described below to set an access protected area.

(1) From the Hardware Break dialog box

1. Select the Exception check box on the Hardware Break sheet and then click the Detail button.

![Figure 5.137 Hardware Break dialog box](image1)

2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection check box.

![Figure 5.138 Hardware Break dialog box](image2)
3. The Violation of access protection dialog box shown below will be displayed.

To have the access attributes automatically set according to the section information in a download module when a program is downloaded, select the check box labeled “Automatically set address areas at downloading.”

![Violation of access protection dialog box](image)

Figure 5.139 Violation of access protection dialog box

4. Click the Update button, and the access attributes will be updated according to the section information in a download module.

5. To add an access attribute manually, click the Add button. The Access protection condition dialog box shown below will appear. Specify any address range and access attribute.

![Access protection condition dialog box](image)

Figure 5.140 Access protection condition dialog box
6. The protected area you have added will be displayed in the Address Areas list of the Violation of access protection dialog box.

![Violation of access protection dialog box](image)

**Figure 5.141 Violation of access protection dialog box**

(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception check box and then click the Detail button.

![Trace conditions dialog box](image)

**Figure 5.142 Trace conditions dialog box**
2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection check box.

![Trace conditions dialog box](image)

Figure 5.143 Trace conditions dialog box

3. The Violation of access protection dialog box will be displayed. The rest is the same as you opened it from the Hardware Break dialog box.
5.14.4 Detecting Initialization-Omitted

This is the function to determine the case where an access for read is performed before being write accessed when both histories of read access and write access do not exist to be “initialization omitted” and output an error.

In the emulator, the blocks 0-31 (maximum 16 Kbytes) can be specified as a detection area of the initialization-omitted.

(1) Detection method

An initialization-omitted is detected by the RAM monitor function.

Allocate a RAM monitor area to a given address range and enable error detection in that area.

Detection circuit

| Both histories of read access and write access do not exist | → | <Compare> | Whether accessed for read before being write accessed | → | Detected |

Figure 5.144 Outline of the initialization omitted

(2) Actions taken when an initialization-omitted is detected

The following actions can be set:

- Display a warning

Selecting the Read from uninitialized memory check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.

Color display in the RAM Monitor window

- Set the detection of an initialization-omitted as a condition of a hardware breakpoint
- Set the detection of an initialization-omitted as a condition of a trace point
5.14.5 Detecting Stack Access Violation

Setting the size of the stack too small in software development raises the possibility of a program going out of control or malfunctioning. The E100 emulator actively detects abnormal access by the stack pointer.

(1) Setting a stack range

By selecting a stack section it is possible to automatically set a stack range, or you can enter any address range you want.

(2) Initial settings at startup

At startup, stack sections are automatically set. However, because address information is nonexistent, those stack sections do not work until a program is downloaded.

(3) Detection method

The emulator monitors the values of USP and ISP and detects if the value points to a location outside the stack areas.

The emulator will detect the error if the value of the stack pointer is beyond the stack areas on
1. generation of an interrupt or return from an interrupt handler;
2. calling of a function or return from a function; or
3. the stack pointer pointing to a location outside reserved stack areas.

CAUTION
Detection does not cover cases of corruption of data within a stack area.

(4) Actions taken when a stack access violation is detected

The following actions can be set:
- Display a warning

Selecting the Stack Access Violation check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.
- Set the detection of a stack access violation as a condition of a hardware breakpoint
- Set the detection of a stack access violation as a condition of a trace point
5.14.6 Detecting a Performance Overflow
A time in performance measurement coming to exceed the maximum value can be detected as an error.
Timeout case in a performance measurement is referred to as a performance overflow.

(1) Actions taken when a performance overflow is detected
The following actions can be set:
- Display a warning
  A warning is displayed in the Performance window.
The result display line of a program section in which a timeout phenomenon occurred is marked with a string “overflow.”
Selecting the Performance Overflow check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.
- Set the detection of a performance overflow as a condition of a hardware breakpoint
- Set the detection of a performance overflow as a condition of a trace point

5.14.7 Detecting a Realtime Profile Overflow
A time or number of passes in realtime profile measurement coming to exceed the maximum value can be detected as an error.
Timeout and count-out (count expired) cases in a realtime profile are collectively referred to as a realtime profile overflow.

(1) Actions taken when a realtime profile overflow is detected
The following actions can be set:
- Display a warning
  A warning is displayed in the Realtime Profile window.
The function or result display line of a task in which a timeout or count-out phenomenon occurred is marked with a string “overflow.”
Selecting the Realtime Profile Overflow check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.
- Set the detection of a realtime profile overflow as a condition of a hardware breakpoint
- Set the detection of a realtime profile overflow as a condition of a trace point
5.14.8 Detecting a Trace Memory Overflow
Overflows of the trace memory (4 M cycles) can be detected as errors.

(1) Actions taken when a trace memory overflow is detected

The following actions can be set:

- Display a warning

Selecting the Trace memory overflow check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a trace memory overflow as a condition of a hardware breakpoint

5.14.9 Detecting a Task Stack Access Violation
This facility is only available when a load module that includes an OS has been downloaded. The emulator detects an error when one task attempts writing to the task stack for another task.

(1) Initial settings at startup

At startup, the check box labeled “Automatically set address areas at downloading” is selected (flagged by a check mark). However, because address information is nonexistent, the function does not work until a program is downloaded.

(2) Actions taken when a task stack access violation is detected

The following actions can be set:

- Display a warning

Selecting the Task stack access violation check box on the Exception Warning page of the Configuration Properties dialog box, you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a task stack access violation as a condition of a hardware breakpoint
- Set the detection of a task stack access violation as a condition of a trace point
5.14.10 Setting a Task Stack Area
Follow the procedure described below to set a task stack area.

(1) From the Hardware Break dialog box

1. Select the Exception check box on the Hardware Break sheet and then click the Detail button.

![Hardware Break dialog box](image1)

Figure 5.146 Hardware Break dialog box

2. The Exception page shown below will appear. Click the Detail button to the right of the Task stack access violation check box.

![Hardware Break dialog box](image2)

Figure 5.147 Hardware Break dialog box
3. The Violation of task stack access dialog box shown below will be displayed. To have the task stack ranges automatically set when a program is downloaded, select the check box labeled “Automatically set address areas at downloading.”

![Violation of task stack access dialog box](image)

Figure 5.148 Violation of task stack access dialog box

4. Click the Update button, and the task stack ranges will be automatically set.

5. To add a task stack range manually, click the Add button. The Task stack access condition dialog box shown below will appear. Specify any task ID and the address range of a task stack.

![Task stack access condition dialog box](image)

Figure 5.149 Task stack access condition dialog box

6. The task stack ranges you have added will be displayed in the Address Areas list of the Violation of task stack access dialog box.
(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception check box and then click the Detail button.

Figure 5.150 Trace conditions dialog box
2. The Exception page shown below will appear. Click the Detail button to the right of the Task stack access violation check box.

![Trace conditions dialog box](image)

Figure 5.151 Trace conditions dialog box

3. The Violation of task stack access dialog box will be displayed. The rest is the same as you opened it from the Hardware Break dialog box.

5.14.11 Detecting an OS Dispatch
This facility is only available when a load module that includes an OS has been downloaded. The emulator detects the generation of task dispatch as an error.

(1) Actions taken when an OS dispatch is detected

The following actions can be set:

- Display a warning

Selecting the OS dispatch check box on the Exception Warning page of the Configuration properties dialog box, you can display a warning in the Status window and in a status bar balloon.

- Set the detection of an OS dispatch as a condition of a hardware breakpoint
- Set the detection of an OS dispatch as a condition of a trace point
5.15 Using the Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and immediately after halting program execution. This function is used to control the user system in synchronization with execution and halting of the user program.

5.15.1 Opening the Start/Stop Function Setting Dialog Box

The routine executed immediately before starting and immediately after halting the user program execution is specified in the [Start/Stop function setting] dialog box.

To open the Start/Stop function setting dialog box, choose Setup -> Emulator -> Start/Stop function setting… from the menu.

![Start/Stop function setting dialog box](image)

Figure 5.152 Start/Stop function setting dialog box

5.15.2 Specifying the Work Address

Use this command to specify the address of a work area (stack area) for use by a routine to run before the user program execution is started or after user program execution is stopped.

CAUTION

The specified address must be in the RAM area and not used by the user program.

5.15.3 Specifying the Routine to be executed

It is possible to specify the respective routines immediately before starting and immediately after halting the user program execution.

When The specified routine is executed immediately before execution of the user’s program check box is selected, the routine specified in the Starting address combo box, which is below this check box, is executed immediately before starting user program execution.

When The specified routine is executed immediately after the stop of the user’s program check box is selected, the routine specified in Starting address combo box, which is below this check box, is executed immediately after halting user program execution.
5.15.4 Limitations of the Start/Stop Function

The Start/Stop function is subject to the following limitations.
- While the Start/Stop function is in use, do not use the debug functions listed below.
  (a) Memory setting and download into the program area of a specified routine
  (b) Breakpoint setting in the program area of a specified routine
- While a specified routine is executed, the 4-byte value pointed to by the interrupt stack is used under control on the emulator side.
- The general-purpose registers and flags used in a specified routine are subject to the following limitations.

<table>
<thead>
<tr>
<th>Register/flag Name</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISP register</td>
<td>When a specified routine has ended, the value of this register must be restored to one that it had when the specified routine started.</td>
</tr>
<tr>
<td>U flag</td>
<td>When a specified routine has ended, the value of this flag must always be set to 0.</td>
</tr>
<tr>
<td>I flag</td>
<td>Interrupts are disabled while a specified routine is executed.</td>
</tr>
</tbody>
</table>

- When a specified routine is executed, the debug functions listed below have no effect.
  (a) Trace function
  (b) Break-related functions
  (c) RAM monitor function
- When a specified routine is executed, non-maskable interrupts are always disabled.
- The table below shows which state the MCU will be in when the user program starts running after a specified routine is executed.

<table>
<thead>
<tr>
<th>MCU Resource</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCU general-purpose registers</td>
<td>These registers are in the state in which they were when the user program last stopped or the MCU registers that were set in the register window by the user. The register contents changed after a specified routine is executed are not reflected.</td>
</tr>
<tr>
<td>Memory in MCU space</td>
<td>Memory accesses attempted after a specified routine is executed are reflected.</td>
</tr>
<tr>
<td>MCU peripheral functions</td>
<td>Operation of the MCU peripheral functions performed after a specified routine is executed are continued.</td>
</tr>
</tbody>
</table>

5.15.5 Limitations to the Statements written in a Specified Routine

The statements written in a specified routine are subject to the limitations described below.
- If a stack needs to be used in a specified routine, always be sure to use the user stack.
- To terminate the processing of a specified routine, write a return subroutine instruction.
- Make sure that one session of processing performed by a specified routine is terminated within 10 ms. If, for example, the clock is turned off and kept inactive within a specified routine, then the emulator may become unable to control program execution.
- The values stored in the registers at the time a specified routine starts running are indeterminate. Be sure that the register values are initialized within a specified routine.
5.16 Using the Trigger Output Function

The trigger output function allows output of signals through an external trigger cable. Trigger pin numbers 31 to 16 can be used for output. Note, however, that operation of a trigger pin depends on its pin number. Table 5.46 lists the trigger pin numbers and how they operate.

<table>
<thead>
<tr>
<th>No.</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>31 to 24</td>
<td>These pins constantly output a signal; either high or low can be selected.</td>
</tr>
<tr>
<td>23</td>
<td>A high-level signal is output when a breakpoint is encountered.</td>
</tr>
<tr>
<td>22</td>
<td>A high-level signal is output when a trace point is encountered.</td>
</tr>
<tr>
<td>21</td>
<td>A high-level signal is output when specific trace data is extracted or discarded.</td>
</tr>
<tr>
<td>20 to 16</td>
<td>An event can be specified for each of the signals and a high-level signal is output when that event occurs.</td>
</tr>
</tbody>
</table>

Output is at the power voltage level of the target system. If the MCU in use has two power supplies, the level on VCC1 will be applicable.

5.16.1 Using the External Trigger Cable for Output

You can specify input and output through the external trigger cable on the System page of the Configuration properties dialog box. Select the ‘EXT 0-15 INPUT EXT16-31 OUTPUT’ radio button for ‘External trigger cable’.

![Configuration properties dialog box](image)
5.16.2 Opening the Trigger Output Conditions Dialog Box

Choose [Event -> Trigger Output Conditions] from the View menu, or click on the ‘Trigger Output Conditions’ toolbar button 

![Trigger Output Conditions dialog box](image)

Figure 5.154 Trigger Output Conditions dialog box

Note that you cannot open the Trigger Output Conditions dialog box in either of the following cases.
- ‘EXT 0-31 INPUT’ has been selected on the System page of the Configuration properties dialog box.
- An external trigger cable is not connected.
5.16.3 Manual Setting for Output through Trigger Pins 31 to 24

Make the manual settings for output through trigger pins 31 to 24 on the Manual output page.

![Trigger Output Conditions dialog box](image)

Figure 5.155 Trigger Output Conditions dialog box (Manual output page)

(1) Display of output states: ‘Output contents’

‘Output contents’ indicates the current signal levels on trigger pins 31 to 24.

- H: High
- L: Low

(2) ‘Output setting’

‘Output setting’ indicates the levels of signals to be output through trigger pins 31 to 24. Clicking on one of these buttons changes the state of the corresponding pin in the following order.

![Output setting diagram](image)

L: Low
H: High
−: The previous setting is retained.

When the Trigger Output Conditions dialog box is opened, the states of all signals in the ‘Output setting’ section are always indicated as ‘−’, whether the previous setting was L or H.

(3) Starting output of signals

Click on the ‘Output’ button to validate the settings and start output of signals.
(4) Saving output patterns

- You can save the settings on trigger pins 31 to 24 and reflect a saved setting as the ‘Output setting’. This simplifies operations.
- After making settings for an ‘Output setting’, click on the ‘Add pattern’ button. The new setting will be added as the last line in the ‘Output pattern’ list.
- Up to 256 patterns can be added.
- Double-clicking on a line in the ‘Output pattern’ list reflects the information on the line as the ‘Output setting’.
- The order of the lines (patterns) can be changed by dragging and dropping.
- To delete a pattern, select the line and click on the ‘Delete’ button.

5.16.4 Setting for Output through Trigger Pins 20 to 16

The Event output page allows manual setting for output through trigger pins 20 to 16.

Figure 5.156 Trigger Output Conditions dialog box (Event output page)

(1) Default setting

‘Default setting’ indicates the trigger output conditions on pins 23 to 21. These pins are always enabled. Signals are output through these pins when the respective conditions are satisfied. Table 5.47 gives details on how the conditions control output.

<table>
<thead>
<tr>
<th>No.</th>
<th>Condition</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>A breakpoint is encountered</td>
<td>Continued output of a high-level signal is started.</td>
</tr>
<tr>
<td>22</td>
<td>A trace point is encountered</td>
<td>A high-level signal is output only during cycles in which the trace-point condition is satisfied.</td>
</tr>
<tr>
<td>21</td>
<td>Specific trace data is extracted or deleted</td>
<td>A high-level signal is output only in cycles where trace data is being extracted or discarded.</td>
</tr>
</tbody>
</table>
(2) Trigger output event

You can specify an event for trigger pins 20 to 16. A high-level signal will only be output while the event is occurring.

CAUTION
The actual trigger output follows event detection after some delay. The number of cycles of delay varies with the product. The delay for trigger output in the R0E535M00MCU00 is 8 cycles.

5.16.5 Events
For details on the setting of events, see section “5.7 Using Events” (page 107).
6. Troubleshooting (Action in Case of an Error)

6.1 Flowchart for Remediation of Trouble

Figure 6.1 shows the flowchart for remediation of trouble arising between activation of the power supply to the emulator system and the emulator debugger starting up. Go through the checks with the user system disconnected. For the latest FAQs, visit the Renesas Tools Homepage.

https://www.renesas.com/tools

![Flowchart for Remediation of Trouble](image-url)

Figure 6.1 Flowchart for remediation of trouble
6.2 Error in Self-checking
When an error occurs in self-checking, check the following items.

(1) Re-check the connection between the E100 emulator main unit and the MCU unit.
(2) Download the proper firmware again.
(3) Check the error log from self-checking by the debugger software, and refer to the instructions given therein (see Figure 6.2).

```
“Error occurred during the self-check test.”
dialog is displayed.

Click on the OK button.

Check the log in the self-check dialog box.

Refer to any instructions in the log.
```

Figure 6.2 Flowchart for checking of an error in self-checking

Notes on the Self-checking:
- Disconnect the MCU unit from a converter board and the user system before you start self-checking.
- If the results of self-checking are not normal (excluding status errors of the target system), the product may have been damaged. Contact your local distributor.
6.3 Errors Reported in Booting-up of the Emulator

(1) States of the LEDs on the E100 are incorrect

Table 6.1 Points to check for errors indicated by incorrect states of the LEDs on the E100

<table>
<thead>
<tr>
<th>Error</th>
<th>Connection to the user system</th>
<th>Point to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFE LED remains lit.</td>
<td>-</td>
<td>Check that the USB cable is connected. See &quot;2.4 Connecting the Host Machine&quot; (page 29).</td>
</tr>
<tr>
<td>SAFE LED does not light up.</td>
<td>-</td>
<td>Re-check the connection between the E100 and the MCU unit. See &quot;2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit (page 28)&quot;.</td>
</tr>
<tr>
<td>Target Status POWER LED does not light up.</td>
<td>Connected</td>
<td>Check that power (Vcc) is being correctly supplied to the user system and that the user system is properly grounded (GND).</td>
</tr>
<tr>
<td>Target Status RESET LED does not go out.</td>
<td>Connected</td>
<td>(1) Check that the reset pin of the user system is being pulled up. (2) When using the emulator without the user system, check to see if the converter board is disconnected from the emulator.</td>
</tr>
</tbody>
</table>
(2) Configuration Properties Dialog Box Does Not Appear in Booting-up of the Emulator Debugger

Table 6.2 Points to check for errors in booting-up of the emulator debugger (1)

<table>
<thead>
<tr>
<th>Error</th>
<th>Point to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication initialize error</td>
<td>Check all emulator debugger settings and the connection of the interface cable.</td>
</tr>
<tr>
<td>A communication error.</td>
<td>See “4. Preparing to Debug” (page 71).</td>
</tr>
</tbody>
</table>

(3) Error Occurs in the Connecting Dialog Box

Table 6.3 Points to check for errors in booting-up of the emulator debugger (2)

<table>
<thead>
<tr>
<th>Error</th>
<th>Point to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCU board is not connected.</td>
<td>Re-check the connection between the E100 and the MCU unit.</td>
</tr>
<tr>
<td></td>
<td>See “2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit” (page 28).</td>
</tr>
<tr>
<td>The system configuration of the E100 emulator is not corresponding to the content of the E100.ENV file.</td>
<td>The combination between the emulator software and the MCU unit is not correct. Refer to the release notes of the emulator software, and confirm the combination between the emulator software and the MCU unit.</td>
</tr>
<tr>
<td>A timeout error. The MCU is in the reset state. Is system reset issued?</td>
<td>Check the oscillation of the oscillator module mounted on the MCU unit, and confirm that the oscillator module is properly mounted.</td>
</tr>
<tr>
<td>A timeout error. The MCU's internal clock is halted. Is system reset issued?</td>
<td></td>
</tr>
<tr>
<td>A timeout error. No clock signal is supplied to the MCU. Is system reset issued?</td>
<td></td>
</tr>
<tr>
<td>A timeout error. The power supply to the MCU is off. Is system reset issued?</td>
<td>Check that power is being correctly supplied to the user system and that the user system is properly grounded.</td>
</tr>
</tbody>
</table>

(4) Errors Occur in booting-up of the emulator debugger

Table 6.4 Points to check for errors in booting-up of the emulator debugger (3)

<table>
<thead>
<tr>
<th>Error</th>
<th>Point to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>A timeout error.</td>
<td>(1) Check that the NQPACK etc. mounted on the user system is soldered properly.</td>
</tr>
<tr>
<td></td>
<td>(2) Check that the connector is installed properly to the user system.</td>
</tr>
</tbody>
</table>
6.4 How to Request Support

After checking the items in "6. Troubleshooting (Action in Case of an Error)", contact us from the following URL.

https://www.renesas.com/contact

For a prompt response, please fill in the following information:

(1) Operating environment
   - Operating voltage: ______ [V]
   - Operating frequency: ______ [MHz]
   - User-system: Connected/Disconnected
   - Clock supply to the MCU: Internal oscillator/External oscillator

(2) Condition
   - The emulator debugger starts up/does not start up
   - The error is detected/not detected in the self-checking
   - Frequency of errors: always/frequency ( )

(3) Details of request for support
7. Hardware Specifications

This chapter describes specifications of the MCU unit.

7.1 Target MCU Specifications

Table 7.1 lists the specifications of target MCUs which can be debugged with the MCU unit.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable MCU</td>
<td>M16C/50 Series M16C/5M, M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups MCUs with 284KB ROM or less</td>
</tr>
<tr>
<td>Evaluation MCU</td>
<td>R5E35MAENFG-EVA</td>
</tr>
<tr>
<td></td>
<td>ROM size: 8KB+16KB+4KB+256KB</td>
</tr>
<tr>
<td></td>
<td>RAM size: 20KB</td>
</tr>
<tr>
<td>Applicable MCU mode</td>
<td>Single-chip mode</td>
</tr>
<tr>
<td>Maximum ROM/RAM capacity</td>
<td>1. Internal flash ROM: 284KB</td>
</tr>
<tr>
<td></td>
<td>0E000h--0FFFFh: Data flash</td>
</tr>
<tr>
<td></td>
<td>10000h--13FFFh: Program 1 ROM</td>
</tr>
<tr>
<td></td>
<td>14000h--14FFFFh: $E^2$dataFlash</td>
</tr>
<tr>
<td></td>
<td>C0000h--FFFFFh: Program 2 ROM</td>
</tr>
<tr>
<td></td>
<td>2. Internal RAM: 20KB</td>
</tr>
<tr>
<td></td>
<td>00400h--053FFh</td>
</tr>
<tr>
<td>Power supply voltage</td>
<td>Vcc: 2.7 to 5.5V</td>
</tr>
<tr>
<td>Operating voltage/frequency</td>
<td>Power supply voltage: 2.7 to 5.5V, 25MHz (with PLL)</td>
</tr>
<tr>
<td></td>
<td>3.0 to 5.5V, 32MHz (with PLL)</td>
</tr>
</tbody>
</table>
7. Differences between the Actual MCU and Emulator

Differences between the actual MCU and emulator are shown below. When debugging the MCU using the MCU unit, be careful about the following precautions.

**Note on Differences between the Actual MCU and Emulator:**

- Operations of the emulator system differ from those of actual MCUs as listed below.
  1. Reset condition
     - Set the time for starting up (0.2 Vcc to 0.8 Vcc) 1 μs or less.
  2. Initial values of internal resource data of an MCU at power-on
  3. Interrupt stack pointer (ISP) after a reset is released
  4. Capacities of the internal memories (ROM and RAM)
     - The evaluation MCU of this product has RAM of 20 KB (00400h--053FFh) and flash ROM of 8 KB (0E000h--0FFFFh), 16 KB (10000h--13FFFh), 4 KB (14000h--14FFFh) and 256 KB (C0000h--FFFFFh).
     - The ROM and RAM capacities may become larger than those of the target MCU specified on the Device page of the Device setting dialog box.
  5. Oscillator circuit
     - In the oscillator circuit where an oscillator is connected between pins XIN and XOUT, oscillation does not occur because a converter board is used between the evaluation MCU and the user system. It is the same for pins XCIN and XCOUT.
  6. A/D conversion
     - The characteristics of the A/D converter differ from those of actual MCU because there are a converter board and other devices between the evaluation MCU and the user system.
  7. 40 MHz on-chip oscillator
     - The 40 MHz on-chip oscillator of the evaluation MCU of this product is always active. Therefore, the on/off control for the 40 MHz on-chip oscillator start bit is disabled.

**Note on RESET# Input:**

- A low input to pin RESET# from the user system is accepted only when a user program is being executed (only while the RUN status LED on the E100 upper panel is lit).

**Notes on Maskable Interrupts:**

- Even if a user program is not being executed (including when run-time debugging is being performed), the evaluation MCU executes a debug control program. Therefore, timers and other components do not stop running. If a maskable interrupt is requested when the user program is not being executed (including when run-time debugging is being performed), the maskable interrupt request cannot be accepted, because the emulator disables interrupts. The interrupt request is accepted immediately after the user program execution is started.
- Take note that when the user program is not being executed (including when run-time debugging is being performed), a peripheral I/O interruption is not accepted.

**Note on DMA Transfer:**

- With this product, the user program is stopped with a loop program to a specific address. Therefore, if a DMA request is generated by a timer or other source while the user program is stopped, DMA transfer is executed. However, make note of the fact that DMA transfer while the program is stopped may not be performed correctly. Also note that the below registers have been changed to generate DMA transfer as explained here even when the user program is stopped.
  1. DMA0 transfer count register TCR0
  2. DMA1 transfer count register TCR1
  3. DMA2 transfer count register TCR2
  4. DMA3 transfer count register TCR3

**Note on Final Evaluation:**

- Be sure to evaluate your system with an evaluation MCU. Before starting mask production, evaluate your system and make final confirmation with a CS (Commercial Sample) version MCU.
7.3 Connection Diagram
7.3.1 Connection Diagram for the R0E535M00MCU00

Figure 7.1 shows a partial circuit diagram of the connections of the R0E535M00MCU00. This diagram mainly shows the circuitry to be connected to the user system. Other circuitry, such as that for the emulator’s control system, has been omitted. Table 7.2 shows IC electric characteristics of this product for reference purpose.

![Connection Diagram](image)

Figure 7.1 Connection diagram for R0E535M00MCU00

Table 7.2 Electrical characteristics of the 74HC4066

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Item</th>
<th>Condition</th>
<th>Standard values</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>RON</td>
<td>ON resistor</td>
<td>4.5V</td>
<td>-</td>
<td>96</td>
</tr>
<tr>
<td>ΔRON</td>
<td>ON resistor difference</td>
<td>4.5V</td>
<td>-</td>
<td>10</td>
</tr>
<tr>
<td>IOFF</td>
<td>Leak current (Off)</td>
<td>12.0V</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>IIZ</td>
<td>Leak current (On, output: open)</td>
<td>12.0V</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
7.4 External Dimensions

7.4.1 External Dimensions of the E100 Emulator

Figure 7.2 shows external dimensions of the E100 emulator.

Figure 7.2 External dimensions of the E100 emulator
7.4.2 External Dimensions of the Converter Board R0E0100TNPFK00

Figure 7.3 shows external dimensions and a sample foot pattern of the converter board R0E0100TNPFK00 for a 100-pin 0.5mm pitch LQFP.

![Diagram of R0E0100TNPFK00 Converter Board](image)

Figure 7.3 External dimensions and a sample foot pattern of the R0E0100TNPFK00
7.4.3 External Dimensions of the Converter Board R0E535M00CFK30

Figure 7.4 shows external dimensions and a sample foot pattern of the converter board R0E535M00CFK30 for an 80-pin 0.5mm pitch LQFP.

![External Dimensions Diagram](image)

Figure 7.4 External dimensions and a sample foot pattern of the R0E535M00CFK30
7.4.4 External Dimensions of the Converter Board R0E535M00CFK40

Figure 7.5 shows external dimensions and a sample foot pattern of the converter board R0E535M00CFK40 for a 64-pin 0.5mm pitch LQFP.

Figure 7.5 External dimensions and a sample foot pattern of the R0E535M00CFK40
7.5 Notes on Using the MCU Unit

Notes on using the MCU unit are listed below. When you debug an MCU using the MCU unit, be careful about the following precautions.

---

**Note on the Version of the Emulator Debugger:**
- Be sure to use this product with the following emulator software:
  - M16C R8C E100 Emulator Software V.1.02 Release 00 or later

**Notes on Downloading Firmware:**
- Before using this product for the first time, it is necessary to download the dedicated firmware (emulator’s control software installed in the flash memory in the E100). If you need to download at debugger startup, a message will appear. Download the firmware following the message.
- Do not shut off the power while downloading the firmware. If this happens, the product will not start up properly. If the power is shut off unexpectedly, re-download the firmware.
- Disconnect the MCU unit from the user system before you start downloading the firmware.

**Notes on Self-checking:**
- If self-checking does not result normally (excluding user system errors), the product may be damaged. Then contact your local distributor.
- Disconnect the MCU unit from the user system before you start self-checking.

**Note on Quitting the Emulator Debugger:**
- To restart the emulator debugger, always shut off the emulator power supply and then turn on it again.

**Note on the Power-on Reset Function:**
- The power-on reset function cannot be used.

**Note on the Voltage Detector:**
- The voltage detector cannot be used.

**Note on I/O Port P8_5:**
- When using the emulator, the I/O port P8_5 is an N-channel open-drain output port.
  a) M16C/5L, M16C/56, M16C/5LD and M16C/56D Groups (I/O port: CMOS output)
     - When using the I/O port P8_5 as an output port, an external pull-up resistor of the VCC level is needed on the user system (Min: 1 kΩ).
  b) M16C/5M Group (I/O port: N-channel open-drain output)
     - No limitations apply to the I/O port P8_5 because the function of the port in the evaluation MCU is the same as that in the actual MCU.

**Note on Multi-master I²C-Bus Interface:**
- The M16C/5LD and M16C/56D group MCUs have limitations on the functions of the multi-master I²C-bus interface which do not apply when using this MCU unit. Refer to the hardware manual of the MCU.
Note on Display of MCU Status:
- "Status" you can view in the Connecting dialog box of the emulator debugger shows pin levels of the user system. Make sure that proper pin levels are selected according to the mode you use.

Note on the Register Used Exclusively by the Emulator:
- Do not access the registers D000h--D03Fh and D050h--D05Fh that are used exclusively by the emulator from the user program.

Note on Downloading:
- During CAN communication (when SLPM bit is 0), you cannot download any data to the flash area (0E000h to 13FFFh, C0000h to FFFFFh). Download the data after a reset.

Note on Memory Access:
- During CAN communication (when SLPM bit is 0), you cannot make settings for the flash area (0E000h to 13FFFh, C0000h to FFFFFh) from the Memory window and Command Line window.

Notes on the E²dataFlash Area (14000h to 14FFFh):
- If you attempt to view the flash area from the Memory window and Command Line window while the user program is running, the value “FFh” is shown, which is different from the actual value.
- The E²dataFlash area cannot be set as a RAM monitor area in the RAM Monitor window.
- Do not halt the program when erasing or writing to the E²dataFlash area. Otherwise, the write sequence to the E²dataFlash will be suspended and therefore the operation to the E²dataFlash may not be processed properly as expected after that.
- During a program halt, the values of E²dataFlash status register 0, E²dataFlash status register 1 and E²dataFlash instruction register are undefined.

Note on Clock Supply to the MCU:
- A clock supplied to the evaluation MCU is selected by the Emulator tab in the Init dialog box of the emulator debugger.
  1. When "Emulator" is selected:
     A clock generated by the oscillator circuit board on the MCU unit is supplied. It is continually supplied regardless of the status of the user system clock and that of the user program execution.
  2. When "User" is selected:
     A clock generated by the oscillator in the user system is supplied. It depends on the status of the oscillation (on/off) of the user system.
  3. When "Generate" is selected:
     A clock generated by the dedicated circuit in the E100 is supplied. It is continually supplied regardless of the status of the user system clock and that of the user program execution.

Note on Stop and Wait Modes:
- Do not single step an instruction shifting to stop or wait mode. It may cause communication errors.

Note on the Watchdog Function:
- If the reset circuit of the user system has a watchdog timer, disable it when using the emulator.
Note on Protect Register:

- The protect is not canceled when bit 2 of protect register PRCR (PRC2), which enables writing into the port P9 direction register and the SI/Oi control register, is changed with the below procedure.
  1. Step execution of an instruction setting PRC2 to "1"
  2. Setting a break point between an instruction setting PRC2 to "1" and a point where the port P9 direction register or the SI/Oi control register is set
  3. Setting PRC2 to "1" by the Memory window or Command Line window

Note on Access Prohibited Area:

- You cannot use internally reserved areas. Write signals to the areas will be ignored, and values read will be undefined.

Note on Breaks:

- The following break functions are available in the emulator debugger.
  1. **Software break**
     - This is a debugging function which generates a BRK interruption by changing an instruction at a specified address to a BRK instruction (00h) to break a program immediately before the system executes an instruction at a specified address. The instruction at the preset address will not be executed.
  2. **Hardware break**
     - This is a debugging function which breaks a program by setting the detection of an execution of an instruction at a specified address as a break event. The program will break after the instruction at the specified address is executed.
  3. **Exceptional event**
     - This is a debugging function which stops a program by an abnormal operation of the user program or overflow of each function’s measurement counter, etc.

Note on Software Breaks:

- The BRK instruction can be used for the emulator only. You cannot use it in a user program. As BRK instruction interrupt vector is used by the emulator system, the read data is different from expected value.

Notes on Power Supply to the User System:

- Vcc pin is connected to the user system to observe the voltage. Therefore, the power is not supplied to the user system from the emulator.
- Design your system so that the user system is powered separately.
- The voltage of the user system should be as follows.
  \[2.7 \text{ V} \leq \text{Vcc} \leq 5.5 \text{ V}\]

Notes on Internal Flash ROM of the MCU:

- Because the number of write/erase cycles of the internal flash ROM of the MCU is limited, it must be replaced at the end of its service-life.
- If the following errors occur frequently when downloading a program, replace the MCU board.
  1. An error has occurred in erasing of the flash ROM in the target MCU.
  2. An error has occurred in programming of the flash ROM in the target MCU.
  3. An error has occurred in verification of the flash ROM in the target MCU.
Notes on Debugging in CPU Rewrite Mode:

- When you debug an M16C/50 Series MCU in CPU rewrite mode, do not change the block 0 area (FF000h--FFFFFh) of the flash memory. Otherwise, the emulator will be uncontrollable.
- In CPU rewrite mode and erase suspend mode, do not stop the program. And do not single step an instruction shifting to CPU rewrite mode or erase suspend mode. The emulator will be uncontrollable in CPU rewrite mode and erase suspend mode.
- To reference data after executing CPU rewrite, stop the program at other than a rewrite control program area and use the Memory window etc.
- As the following interrupt vectors are used by the emulator system, the read data is different from expected value.
  - Single-step (FFFFCh--FFFFFh)
- As the user boot function cannot be debugged, do not enter the user boot mode.

Note on Accessing Addresses 00000h and 00001h:

- With the M16C/50 Series MCUs, when a maskable interrupt is generated, the interrupt data (interrupt number and interrupt request level) stored in addresses 00000h and 00001h are read out. Also, the interrupt request bit is cleared when address 00000h or 00001h is read out. Consequently, when the address 00000h or 00001h readout instruction is executed or when address 00000h or 00001h is read out in the cause of a program runaway, a malfunction occurs in that the interrupt is not executed despite the interrupt request, because the request bit of the highest priority interrupt factor enabled is cleared.
  For this malfunction, when the reading out to address 00000h or 00001h is generated excluding the interrupt, an expansion monitor window will appear. At that time, check the user program. There is a possibility of wrong access.

Note on Low power consumption mode:

- When debugging in low power consumption mode, slow read mode, or the state that the flash memory is stopped, do not operate windows until the program stops at the breakpoint by setting the breakpoint at the line of the program which will be executed after each mode or state is cancelled.
8. Maintenance and Warranty

This chapter covers basic maintenance, warranty information, provisions for repair and the procedures for requesting a repair.

8.1 User Registration
When you purchase our product, be sure register as a user. For user registration, refer to “User Registration” (page 15) of this user’s manual.

8.2 Maintenance
(1) If dust or dirt collects on this product, wipe it off with a dry soft cloth.
   Do not use thinner or other solvents because these chemicals can cause the surface coating to separate.
(2) When you do not use this product for a long period, disconnect it from the power supply, host machine and user system.

8.3 Warranty
(1) This product comes with a one-year warranty after purchase.
   Should the product break down or be damaged while you’re using it under normal condition based on its user’s manual, it will be repaired or replaced free of cost.
(2) However, if the following failure or damage occurs to the product under warranty, the product will be repaired or replaced at cost.
   a) Failure or damage attributable to the misuse or abuse of the product or its use under other abnormal conditions.
   b) Failure or damage attributable to improper handling of the product after purchase, such as dropping of the product when it is transported or moved.
   c) Failure or damage to the product caused by other pieces of equipment connected to it.
   d) Failure or damage attributable to fire, earthquakes, thunderbolts, floods, or other natural disasters or abnormal voltages, etc.
   e) Failure or damage attributable to modifications, repairs, adjustments, or other acts made to the product by other than Renesas Electronics Corporation.
(3) Consumables (e.g., sockets and adapters) are not covered by the aforementioned repair.

In the above cases, contact your local distributor. If your product is being leased, consult the leasing company or the owner.
8.4 Repair Provisions

(1) Repairs not covered by warranty
Problems arising in products for which more than one year has elapsed since purchase are not covered by warranty.

(2) Replacement not covered by warranty
If your product's fault falls into any of the following categories, the fault will be corrected by replacing the entire product instead of repairing it, or you will be advised to purchase a new product, depending on the severity of the fault.
- Faulty or broken mechanical portions
- Flaws, separation, or rust in coated or plated portions
- Flaws or cracks in plastic portions
- Faults or breakage caused by improper use or unauthorized repair or modification
- Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply
- Cracks in the printed circuit board or burnt-down patterns
- A wide range of faults that make replacement less expensive than repair
- Faults that are not locatable or identifiable

(3) Expiration of the repair period
When a period of one year has elapsed after production of a given model ceased, repairing products of that model may become impossible.

(4) Carriage fees for sending your product to be repaired
Carriage fees for sending your product to us for repair are at your own expense.

8.5 How to Make Request for Repair
If your product is found faulty, fill in a Repair Request Sheet downloadable from the following URL. And email the sheet and send the product to your local distributor.

https://www.renesas.com/repair

⚠️ CAUTION

Note on Transporting the Product:
When sending your product for repair, use the packing box and cushion material supplied with this product when delivered to you and specify handling caution for it to be handled as precision equipment. If packing of your product is not complete, it may be damaged during transportation. When you pack your product in a bag, make sure to use conductive polyvinyl supplied with this product (usually a blue bag). When you use other bags, they may cause a trouble on your product because of static electricity.
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.01</td>
<td>Dec 01,15</td>
<td>21</td>
<td>Regulatory Compliance Notices changed</td>
</tr>
<tr>
<td>6.02</td>
<td>Sep.01.21</td>
<td>22</td>
<td>Regulatory Compliance Notices was changed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24</td>
<td>The specifications of the AC adapter were added.</td>
</tr>
</tbody>
</table>